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Adobe Illustrator: a very brief history

Adobe Illustrator was one of two revolutionary computer programs 
that were introduced in 1987 with the advent of the Mac II, the first 
real ”professional” desktop design computer. (The other program was 
PageMaker created by Aldus Corporation, later purchased by Adobe). 
The introduction of this computer and these two programs changed 
the disciplines of graphic design and publishing forever. 
Illustrator was the first commercial, professional VECTOR GRAPHICS 
program. It took the rectangles, ellipses, lines, outlines, and fills of MacDraw 
and other primitive ”drawing” programs and brought them to a new level 
of competence. It opened a whole new world of flexibility and control to 
commercial artists, designers, and illustrators. It also eventually removed 
a whole range of craftsmen and technicians from the collaborative process 
of design and publishing. The responsibilities and technical expertise of 
these professionals were now handed off  to art directors, designers, and 
illustrators, some of whom were completely unprepared for the change.

What is a VECTOR GRAPHICS program?

There are basically two types of graphics programs: VECTOR based and 
RASTER or BITMAP based. A RASTER IMAGE is just a technical name to 
describe an image based on a filled-in GRID, in this case, a computer 
screen or some imaginary workspace visible on a computer screen. 
This grid can be sub-divided down to its smallest unit — the PIXEL 
(geek-speak for picture element). RASTER or BITMAP program code 
fills these pixels with tones or colors, rather like an extremely complex 
etch-a-sketch. Very high quality print uses 350 DPI (or PPI—dots or 
pixels per linear inch), or higher. Consequently, the image file for a 
large poster printed at high quality can be very large, i.e. can take up a 
huge amount of space on a hard drive, sometimes as large as a gigabyte, 
maybe more. But the code behind this huge file is fairly simple and 
easy for a computer to process. It defines the grid’s smallest unit, its 
horizontal and vertical dimensions, and then specifies what tone or 
color goes in each grid unit. File size is determined by pixel density 
and the file’s set, “physical” area. When a RASTER file is enlarged, it 
becomes blurred and coarse or “pixelated.” When it is reduced in size, 
image data is lost forever.
In contrast, files created in VECTOR programs are relatively small. Since 
they use mathematical instructions and equations to describe the 
imagery created, they can demand enormous amounts of processing 
power. Because these mathematical constructions are not limited by 
the size of individual pixels, they are called RESOLUTION INDEPENDENT: 
no matter how large or small the final reproduction (or OUTPUT) of a 
VECTOR file may be, its curves remain smooth, its edges and corners 
sharp, and image data is never lost. There is still a raster grid that is 
brought in at the end to process the file for ”output,” although its 
smallest unit of this grid can be as tiny as one 3,000th of an inch or 
less. VECTOR file sizes, because they are based on the complexity of 
the “math” defining the image’s shapes, lines, and color treatments, 
tend to be significantly smaller that their RASTER counterparts. They 
can, if they are complex enough, demand a great deal of time for the 
computer to process and for the screen to “draw.” 
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Concerning Computers

Adobe Illustrator is the “industry standard” Vector “drawing” program. 
Although it is used daily by many who are not graphic arts professionals, 
it is definitely a “professional,” not a hobbyist program. As such, it is 
both expensive, quite complex, and demands a moderately powerful, 
fairly new, near high-end computer. 
Illustrator runs equally well on Macs or PC’s. The author uses both 
platforms, but much prefers the Macintosh, as do the majority of 
people in the graphic arts community. The platform is less important 
than the computer’s age, power, and screen quality. Older, less powerful 
computers will work, but be prepared to spend a fair amount of time 
waiting for operations to take place. Once you begin to really use 
Illustrator and its many more advanced features, however, you may 
find that an older computer will just grind to a halt and freeze.
If your computer is on the age or power borderline, the best thing you 
can do, short of buying a new, more powerful machine, is: (1) add the 
maximum amount of RAM (random access memory) that your particular 
model will accept, (2) upgrade your hard drive to the largest, fastest 
hard drive your computer can use (and you can afford) (3) upgrade 
your video card to the largest, fastest card your computer can use (and 
you can afford), (4) add a new, high-end monitor, if you can. 
These last two are particularly important and the reason is simple 
common sense. Illustrator is a GRAPHIC DESIGN and ILLUSTRATION 
program: it is all about seeing what you make and knowing that what 
you make and see on your computer screen will look the same when 
you put in front of the world in PRINT, on the WEB, as an ON-SCREEN 
PRESENTATION, or in VIDEO. Many inexpensive PC’s create their cost 
savings by economizing on certain features such as lots of RAM; 
big, fast hard drives; high-end video cards; first rate screens. The 
manufacturer’s reasons for this cost-cutting are also common sense: a 
computer used for word processing (writing), surfing the web, emailing, 
and consumer/hobbyist graphics just doesn’t need them. As a graphics 
professional, you do. As a graphic design or illustration student, you 
need to have as professional a rig as you can afford.

Also, buy and use a good, two-button mouse with a scroll wheel, even 
if you have a LAPTOP with a large TRACKPAD. It is nearly impossible to 
achieve the precision Illustrator requires using a trackpad; it certainly 
gets awkward when you are attempting to use KEYBOARD SHORT CUTS 
while using the PEN TOOL, for example.

Concerning Software

Adobe Illustrator is the “industry standard” VECTOR “DRAWING” 
PROGRAM for a reason: it is spectacularly powerful, remarkably 
stable, well-thought-out, elegantly (for the most part) designed. The 
engineers who dreamed it up and continue improving it are geniuses. 
The professionals who use it make creative statements, some of which 
change our culture’s visual environment lastingly for the good, (and, 
alas, for the bad). They all deserve to get paid for their work. If you are 
a practicing professional, you already know this. If you are a student, 
you need to hope that you will be paid for technical the skills you are 
learning and the creative abilities you are honing. So, as an investment 
in your profession, current or future, DON’T STEAL SOFTWARE.
That simply means DON’T “PIRATE” SOFTWARE, DON’T “BORROW” 
SOFTWARE, DON’T “SHARE” SOFTWARE. Just because it’s easy, just 
because it’s quick, just because it’s highly unlikely that you’ll get 
caught (there are no software police), just because “everybody’s doin’ 
it,” doesn’t change the fact that IT’S STEALING. 
If you are one of those people who believe that you are the only one who 
deserves to be paid, that everyone is on their own and must make their 
way as best they can, you will steal the software anyway. Or, maybe 
you’ll join the ranks of those who delude themselves and attempt to 
delude others with the noble excuse that they are digital revolutionaries 
freeing the masses from onerous governmental restraints like copyright 
laws, that they selflessly, “super ethical” martyrs for the greater good 
of the rest of us poor slobs mired in daily reality. 
That doesn’t change the fact that IT’S STEALING. And, to be frank, 
we neither need nor want you in our profession. Go find some other 
delusional activity or venue for your selfishness.

 Introduction: Background
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Concerning Creativity in the Graphic Arts

Creativity in the graphic arts is often not about how new, different, 
“cool,” or unusual you can be. In fact, creativity in the graphic arts is 
often not about what a great many people think of as creative at all. 
Sure, sometimes it is, and those times are sweet. More often, creativity 
in GRAPHIC DESIGN or ILLUSTRATION is about the disciplined search 
for a unique “solution” to a “visual communications” challenge within 
very strict limitations of budget, size, and process. 
This fact has guided the creation of the projects in this book. It 
needs to be stated and reiterated because many people come to the 
graphic arts because they are “creative” image makers, or they are 
“good at drawing,” or they are artists tired of working non-art jobs to 
support their painting. Graphic designers, “user-experience” designers, 
“paper sculptors,” type designers, digital and traditional photo-collage 
illustrators, and other practitioners of the many sub-specialties in 
the graphic arts all use a variety of that same, more personal visual 
creativity in their jobs. 
But the word job is critical here. Almost all graphic artists are hired, 
either on-staff or by the project, to help one set of people communicate 
certain ideas to another set of people. The projects can be as general 
and non-commercial as developing “signage systems” for the National 
Park Service or as commercial and specific as creating a calligraphic 
title for an individual, indy-label band’s CD. Each project has a client 
and an “audience.” Each client wants to communicate certain things to 
the audience. Each set of clients and audiences has certain expectations 
about what these communications should and need to look like. And, 
every project has a budget, both for money and for time. 
While all these concerns set limits, some more and some less constricting, 
on the graphic artist’s creativity, they also provide a starting point and 
strong direction. Neither can be ignored. An “identity” designer who, 
without permission or consultation, decided to change the client’s 
name on a logo for personal, creative reasons would be fired. An 
illustrator who produced a subtle, full color illustration on a project 
that stipulated a bold, black and white only image because it was more 
creative, would be unlikely to be allowed to complete the job, or paid.

When an exercise or project in this book states a set of limitations, 
abide by them. Don’t concern yourself with creativity in the large 
sense. Focus, instead, on how uniquely you can provide a solution 
to the challenge while remaining strictly within the set boundaries. 
And, don’t be surprised if you discover some deeper truths by working 
within those boundaries. It won’t happen all the time, but if you focus 
on the project, with its limitations, it will happen some of the time. 
Those times offer the intrinsic, creative rewards to the graphic artist. 
They are the times that those of us in the profession cherish and grow 
from creatively.
So, if a project in the book calls for BLACK and WHITE, don’t ad lib 
and use gray, no matter how good it looks. If an exercise calls for 
six or fewer shapes, don’t use eight. If you are to limit an exercise to 
horizontal or vertical bars only, don’t use both. If the project requires a 
non-internalized, representational self-portrait, don’t illustrate a frog 
or an albatross — unless of course your are actually the unlikely frog 
or albatross which (who?) is also a graphic artist.

Concerning using Computers

This book takes for granted that the reader or student, no matter how 
unfamiliar they may be with Adobe Illustrator, is familiar with the 
basics of using computers: turning on and shutting down; saving files; 
using menus and dialog boxes; using a mouse, trackball, or trackpad; 
creating and organizing folders for those saved files; organizing the 
“desktop;” going “on-line;” etc.
On the other hand, the book assumes that some readers will be totally 
ignorant of Illustrator and, therefore, begins at the absolute beginning 
— opening the program — and proceeds from there. More advanced 
students are encouraged to refresh their knowledge by reviewing the 
early chapters and really digging in to the early exercises.  

 Introduction: Creativity and Computers
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 The following Glossary makes no pretension to being 
complete, but it does list many terms that appear 
constantly in this book. cross-referenced glossary items 
marked in BURGUNDY.

Ancient Sage of Brooklyn: imaginary digital guru, the quoting 
of whom allows the author to lapse into the dialect of that 
esteemed Borough of the City of Noo Yawk, in order to 
dispense wisdom concerning Illustrator.

Anti-Aliased: on-screen “smoothing” of the RASTER image in PREVIEW 
mode; pixels of colors intermediate between the colors of the 
edges of OBJECTS, especially curved edges, are added to the 
“on-screen” image to avoid hard, “jagged” edges.

Art Board: the “virtual document” you will be working on, a 
rectangle on screen delineated by a thin, black outline of 
the proportions specified in the “New” DIALOG BOX. Its size is 
set to the units required by its OUTPUT type; inches or PICAS 
and/or POINTS for PRESS and PRINT, PIXELS for WEB and other 
forms electronic distribution. The ART BOARD exists in the 
center of the PASTE BOARD.

ASB: short for the Ancient Sage of Brooklyn.
Basic Workspace: the most compact and screen-space efficient 

WORKSPACE in Illustrator, but really only best for use with 
Laptops with small screens. In the Basic Workspace, the most 
often used PANELS are represented by small ICONS in the ICON 

DOCK in the upper right hand corner of the screen.
BMP: any
Button: an interactive element, usually an ICON, used to refine the 

commands o a menu or DIALOG BOX.
Check Box: a tiny ICON, usually a square that is TOGGLED on or off 

by CLICKING. Unlike a RADIO BUTTON, one, some, or all CHECK 

BOXES in a group can be SELECTED.
Click/Clicking: tapping one of the buttons on a computer mouse or 

one of the “click” bars or tabs on a scroll pad or track ball.
Clipboard: short term memory area designated for the single item 

most recently COPIED or CUT.

CMYK: the main printing industry standard color system, creating 
a fairly full range of colors by using tiny dots of 4 inks 
in a complex set of angled grids. The four inks are Cyan, 
Magenta, Yellow, and blacK. Black can also be called the 
“Key,” consequently the “K” instead of “B.”

Closed (Path): any Illustrator OBJECT, the boundary of which is 
continuous.

Color: specifically in Illustrator, a color created in either the RGB, 
CMYK, HSB, or “WEB-SAFE” color systems and used as a FILL or 
a STROKE.

Command: an instruction given to the program through a MENU or 
DIALOG BOX or other means of instruction.

Command Key: keyboard key or series of keys pressed to access a tool 
or to activate a menu command without “MOUSING” to the 
required TOOL BAR, PANEL, or MENU; a KEY BOARD SHORT-CUT.

Constrain: limit the action of a tool; usually the direction of its 
movement or increments of its rotation.

Contextual Menu: a menu that changes depending on the operational 
tool currently selected.

Control/Control Bar/Control Menu: long, narrow, horizontal 
CONTEXTUAL MENU that is placed, by default, at the top of the 
screen directly below the program menu. Accessed in the 
Windows Menu. If so desired, it can be placed at the bottom 
of the screen, allowed to float, or hidden. Sometimes called 
the Options Bar. 

Creation Tools: Illustrator’s “DRAWING” tools, the tools that allow 
you create OBJECTS; a group of six, all but the Paint Brush  
nested, the second group of tools from the top of the TOOL 
BAR. 

Default: the normal or usual form a “NESTED” TOOL, a PANEL, or MENU 
takes; the standard format for the program. 

Dialog Box: a smaller, floating “window” that opens in response to 
a command and that allows you to specify the activity of 
that command.

Dither/Dithering: specifically when used for 8 bit color systems 
(GIF, PNG8, or BMP) on the WEB; term used to describe a 
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 Introduction: Glossary continued

system of placing multiple dots of WEB-SAFE colors together 
to approximate a different color. DITHERING is still used when 
creating web images in 8 bit (256 color) color systems. 

Edit: manipulate, change, control, and refine OBJECTS.
Editing Tools: Illustrator’s OBJECT modification and manipulation 

tools; a group of four, all but one nested, the third group of 
tools from the top of the TOOL BAR. 

File Management Tools: inside 
Fill: the area inside any Illustrator OBJECT, whether formed by an open 

or closed path. Can be a COLOR, a GRADIENT, or a PATTERN.
Fly-out: tab or sub-menu, often small, that “flies out” from a CLICKED 

TOOL or ICON, offering more edit or control options. Usually 
disappears when the mouse is released.

Font: generically, and improperly so used (according to traditionalists), 
word for computer type faces, type face families, and 
typeface manipulation. Accurately so called, in traditional 
type setting, a FONT is a the full alphabet including Capitals, 
lower case, numerals, punctuation, and spacing for a single 
size and weight within a type face family. Common office 
language seems to favor he growing use of the non-traditional 
definition. See also TYPE.  

GIF: any
Gradient: any
Graphic Style: specific set of FILL, STROKE, TRANSPARENCY, and 

EFFECTS, either included with the program or created by the 
user. Can be saved and accessed as a LIBRARY. 

Graphic Style Panel: panel containing any group of FILL, STROKE, 
TRANSPARENCY, and EFFECTS “pre-sets,” either included 
with the program or created by the user. Can be saved or 
accessed as a LIBRARY. 

HSB: an alternate system for creating RGB color for computer monitor 
and video screen usage based on adjusting the Hue, 
Saturation, and Brightness of a color.

Icon: usually small, even tiny, image used to identify program tools, 
commands, and components.

Icon Dock: by DEFAULT, in Illustrator’s BASIC WORKSPACE, a grouped set 

of ICONS at the upper right of the screen that give access to 
the various PANELS in an extremely compact form.

Key Board Short-Cut: see COMMAND KEY.
Layer: a “virtual unit” containing an OBJECT in the “virtual stack” of 

OBJECTS  in a Illustrator image.
Layer Panel: floating, graphical menu that allows the user to edit, 

manage, and manipulate the LAYERS of an image. Can be 
accessed from the Windows Menu or the ICON DOCK.

Library: “database” of special Illustrator OBJECTS; specifically SWATCHES, 
SYMBOLS, GRAPHIC STYLES.

Lock: tiny ICON and the box immediately to the right of the EYEBALL 
at the far left of each level of the LAYERS PANEL. When this 
box is empty, the corresponding LAYER is unlocked and can 
be edited. Clicking this box places an ICON that looks like a 
tiny padlock in the box the visibility of the OBJECTS on that 
LAYER.

Menu: a set of control, manipulation, editing, and management 
options available in a computer program. 

“Mousing”: moving the computer mouse from one place on screen 
to another.

Nested Tool: one of a set of tools grouped together under one tool 
icon that appears by default. CLICKING and HOLDING the 
DEFAULT tool ICON causes the other tools in the group to 
appear on a FLY-OUT tab.

Object: any and all on screen images created with Illustrator’s image 
creation tools or type tools.

Open (Path): any Illustrator OBJECT, the boundary of which is not 
continuous, i.e. it has a beginning and an ending point that 
are nor connected.

Outline: the screen view showing only the POSTSCRIPT PATHS, not 
anti-aliased. 

Output: many different forms of presentation to the world outside the 
computer of the images created in code on the computer. 

Output Device: any device used to present computer generated 
imagery ; i.e. computer screen, image setter, printing press, 
web site, digital projector.
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 Introduction: Glossary continued

Panel: small, “floating” menus with various creation, control, editing, 
and management functions. Most are an ICON-driven. Panels 
were called Pallettes in previous versions of Illustrator.

Panel Workspace: .
Paste Board: all the “virtual” area surrounding the ART BOARD on 

the computer screen, whether visible in the current window 
or not. 

Pattern: any
Path: the boundary “line,” in the strict, geometric meaning, 

delineating the post-script code, of any Illustrator Object.
Picas: the traditional, larger unit of measurement in “English” and 

American printing. A PICA is almost exactly one sixth of an 
inch. A POSTSCRIPT PICA, while it can be varied, is usually 
exactly one sixth of an inch.

Pixel: “computerese” for “picture element,” the smallest unit on an 
output device’s (screen, image setter, printer) raster grid.

PNG 8, PNG 24: any
Preview: in Illustrator, the DEFAULT screen view showing all STROKES, 

FILLS, and EFFECTS, in ANTI-ALIASED form.
Points: the traditional, small unit of measurement in “English” and 

American printing. A POINT is exactly one twelvth of a PICA, 
whether traditional or POSTSCRIPT. A modern POSTSCRIPT POINT 

is exactly 1/72nd of an inch.
Pop-Up/Pop-Down: a SUB-MENU, usually on a DIALOG BOX, that 

“pops-up” (or down) when its ICON is CLICKED 
Post Script: the “page description” code language developed by 

Adobe Systems, Inc., that created the “desktop” revolution 
in graphic design and printing.

Press: a printing press or graphic arts  OUTPUT designed to be printed 
on a printing press.

Print: OUTPUT designed to be printed on a digital printer.
Radio Button: a tiny, usually round button, often in a series. If 

single, it toggles on or off when CLICKED. In a group, only 
one of the RADIO BUTTONS can be checked. CLICKING a 
different BUTTON in the group activates the most recently 
CLICKED BUTTON and de-activates the recently CLICKED 

BUTTON.
Raster: any rectilinear grid used by a computer controlled device to 

“output” — present to the world outside the computer — 
the imagery described by computer code.

RGB: the standard, “additive” (generated by light) color system used to 
describe the components of color on computer monitors and 
television. Familiar from rainbows as well as Isaac Newton’s 
demonstration with a prism. The way our eyes discern color. 
The letters stand for Red, Green, Blue.

Selection Tools: Illustrator’s OBJECT selection tools, the tools that 
allow you to “activate” OBJECTS so they can be EDITED; a 
group of four, the lower two rarely used, the first group of 
tools from the top of the TOOL BAR. 

Stroke: an “outline” of variable width and color (from none on) that 
follows an OBJECT’S PATH whether CLOSED or OPEN. Usually 
specified in POINTS or decimal fractions of an inch.

Styles:
Sub-menu: an edit or modification command item contained within 

an other menu item.
Swatches: specific groups or sets of COLORS, GRADIENTS, or PATTERNS, 

either included with the program or created by the user  and 
contained in the SWATCHES PANEL. Can be saved and accessed 
as a LIBRARY.

Symbols: specific sets of OBJECTS, ranging from simple to complex, 
either included with the program or created by the user. Can 
be saved and accessed as a LIBRARY.

Target: small circle at the right edge of each level of the LAYERS PANEL. 
CLICKING this tiny ICON SELECTS all the UNLOCKED OBJECTS on 
that LAYER level. When clicked, the tiny circle is surrounded 
by a double, rather than a single, line.

Toggle: any tool or menu item that alternates from one state back to 
the other. For example, the first item under the View Menu, 
in the DEFAULT Preview mode is OUTLINE. When this is CLICKED, 
the screen view switches from the current, DEFAULT PREVIEW 
mode to the OUTLINE mode. When this is done, the first item 
under the View Menu has now “toggled” to PREVIEW. 

 intro:x



making Illustrator work so you can work in Illustrator

 Introduction: Glossary continuedt

Tool Bar: the specific “floating” PANEL or PALETTE in Illustrator 
that holds Illustrator’s various CREATION, EDITING, and FILE 

MANAGEMENT TOOLS. By default, in the upper left hand 
corner.

Type:  the current, generic term lumping together type face families, 
type faces, and all other digital letter forms. Often used 
interchangeably, but inaccurately, with FONT. 

Type Workspace: one of three DEFAULT WORKSPACES. Optimized for 
working with TYPE and text

Web: short for the World Wide Web; the internet. Using the Rectangle 
and Ellipse Shape tools

WEB-SAFE: a series of 216 colors, developed in the early days of the 
web, which all browsers could show without “DITHERING.”

Workspace: the set up of the working screen in Illustrator. There are 
three DEFAULT versions — BASIC, PANEL, and TYPE — and it 
can be totally customized by the user.
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To CREATE your FIRST ILLUSTRATOR DOCUMENT

 1a) On the Macintosh; locate the Illustrator CS3 icon on your 
DESKTOP, or in your APPLICATIONS or PROGRAMS FOLDER, or in 
the DOCK.

Then, do one of the following: 
 a. Double Click the ICON [figure A] or
 b. Single Click the ICON to SELECT it and GO: FINDER > OPEN or  
  Single Click the ICON to SELECT it and TYPE: cmd / “o” 
 c. Single Click the ICON in the DOCK

 1b) On a Windows Computer:  
 a. locate the Illustrator CS2 or CS3 icon on your DESKTOP and   
  Double Click the ICON (figure A) or 
 b. locate the Illustrator CS2 or CS3 icon on the GO MENU,  
  or in the ALL PROGRAMS SUB MENU in the GO MENU  
  and Move your cursor to the ICON

After the program loads go the top left od the 
window to access the FILE MENU: GO File>New 
[figure  B] or hold down the command (Mac) 
or control (Windows) and type “n”. The NEW 
DOCUMENT DIALOG BOX [figure C] will appear on 
your screen. Name the file “my1st_illust_doc.” 
Ignore the NEW DOCUMENT PROFILE and SIZE 

DROP DOWNS [figure C - 1] and type “6 in” in the Width TEXT FIELD 
and “6 in” in the Height TEXT FIELD [figure C - 2]. This will create a 
document that is 6 inches square. It will appear on your screen as 
a square defined by a THIN BLACK LINE on all four sides. Note: if 
the UNITS DROP DOWN [figure D] is not already set to inches, CLICK 
on it and CHOOSE INCHES for your document’s units. Click the Color 
Mode Radio Button for CMYK Color. Then CLICK OK [figure E]. The New 
Document Dialog will close and the Illustrator Interface with your NEW 
DOCUMENT will appear on your monitor [figure F - next page].

BACKGROUND INFO: The size of the ART BOARD is usually the size 
of the page, either print or web, that you are working on. You can, 
however, make the ART BOARD much larger so that you can arrange 
a number of different pieces on it. This is a useful practice when you 
are making many small, separate objects. It is not a good idea when 
you are creating large or complicated pieces. Among other things, it 
can slow the computer’s graphics engine to a snail’s pace when you are 
scrolling around the ART BOARD to locate different objects. 
For the time being, ignore the NEW DOCUMENT PROFILE POP-DOWN. To 
access any of the pre-set ART BOARD CONFIGURATIONS (Letter is the 
default), use the SIZE POP-DOWN MENU [figure C]. To change the UNITS 
OF MEASUREMENT in the document, use the UNITS POP-DOWN MENU  
[figure C]. Production Note: In general, you should use the measurement system that your client has 

specified. Keeping all project measurements in the same system helps to avoid confusion and mistakes. Only 

when you are competent and comfortable with mentally converting systems on the fly should you mix them. 

For example, Using POINTS and/or PICAS allows you to divide an inch (72 POINTS, 6 PICAS) by thirds, sixths, 

and twelveths, which is nearly 

impossible using inches. If you 

are working in an unfamiliar 

measurement system, you 

can type  measurements into 

dialog boxes in the system 

you know and Illustrator will 

convert them to the document’s 

measurement system.

 Introduction: Opening Illustrator and Creating a New Document
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The Illustrator CS3 Basic Art Board, as it opens with a new “sample” 
document [figure F]. It is almost identical to the Illustrator CS2 Workspace 
and previous versions of Ilustrator with two very visible exceptions: 
the Tool Bar is a single, tall column and the “Default” Palettes have 
been replaced by a thin, single column called the “DOCK.”
These changes are not as drastic as they may seem. The old, two column 
Tool Bar is still available. Just Click on the tiny DOUBLE ARROWS at the 
very top left of the Tool Bar to toggle to the “legacy” (geek speak for a 

previous versions 
of an application) 
Tool Bar. Click 
these arrows again to toggle back to the new Tool Bar. Click on any 
of the “Dock” icons and a PANEL will appear for you to use. If you 
would rather have the Panels open on screen, Go: Window > Workspace 
[figure  G] and choose one of the two options, “Panel” [figure  H] or Type 
[figure  I] rather than “Basic.” 

Introduction: The Adobe Illustrator CS3 Interface
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Save your document! Organize your documents.  
Work more efficiently

Now that you have opened you document, 
and before you do anything else, SAVE it. 
Get into this habit. While you are saving, 
get into the habit of organizing your work 
as well. These to work habits will save you 
hours of time in the long run, and might 
even save your job. 
With your document open Go: File > Save 
or PRESS the COMMAND (Mac) or CONTROL 
(Win) Key and TYPE “s.” Because this is 
the first time this new document has been 
saved, the SAVE AS DIALOG BOX opens 
[figure J]. Note that the name you gave 
the document is automatically placed in 
the Name field. The default Save As Dialog 
Box has a DOWN POINTING ARROW BUTTON 
to the right of the name field [figure  J-1] 
and TWO POP-DOWN MENUS, WHERE 
and FORMAT, directly below the field 
[figure  J-2]. The WHERE POP-DOWN lets 
you scroll down a list of an assortment of 
your main folders and recently used other 

folders [figure K]. If you have not yet set up a folder for your work 
in Illustrator, put your file on the DESKTOP. The FORMAT POP-DOWN 
[figure J-2] lets you choose any six file formats in which to save your 
work. We will be using the Adobe Illustrator Document (default) format 
almost exclusively in the beginning.
When you Click the small Arrow Button, a full browser window 
[figure M] opens, allowing you to navigate through your hard drive(s) 
and folders and/or directories to place you new file exactly where you 
want it [figure M-1]. Notice that now the little arrow on the button now 
points up. If you don’t want the full browser, Click the button again 
to return to the default Save As Dialog Box. Like all browser windows 
it lets you create a new folder or subfolder in which to place your file 
[figure M-2]. Standard practice is to create a specifically named folder 
in the DOCUMENTS folder (Mac) or MY DOCUMENTS directory (PC). 
Name the folder with the class, client, job, or project for which you 
are creating the Illustrator document. For example, if you are taking 
DSGD83 at San Jose State, name the new folder dsgd83_(semester)_(2 
digit year) [figure M-3]. Since you named the file already, you can leave 
that as is: “my1st_ilust_doc”. Notice that the name now has “.ai” after 
it. This is called the “EXTENSION,” a two to four letter abbreviation of 
the originating program that helps identify the file. 
Now, CLICK SAVE [figure M-4]. The Illustrator Options Dialog Box will 
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open, presenting you with a number of choices [figure  N-1]. At the 
top of the Dialog Box is the “Version:” POP-DOWN MENU. CLICK on 
this and the POP-DOWN MENU lets you select the version of Illustrator 
in which you wish to save your document [figure N-2]. This feature is 
new in Illustrator CS3. In previous versions of Illustrator in the Adobe® 
Creative Suite® you needed to go through a more cumbersome saving 
routine or use the Export (later, Grasshopper) Menu to create “backward 
compatible” Illustrator files. Use the Illustrator CS3 choice, then release 
of your CURSOR.
For the time being, ignore the “Fonts” options section and move down 
to the “Options” options. Make sure that the “Create PDF Compatible 
File,” “Embed ICC Profile,” and “Use Compression” CHECK BOXES are 
CHECKED [figure N-3]. The “Include Linked Files” BOX is grayed out and 
will not be available until we begin PLACING files (these become LINKED 
FILES) in our documents later in the course. We will not INCLUDE LINKED 
FILES, if at all, until much further on. 
Let’s take the other three BOXES in order. We will always want the 
“Create PDF Compatible File” CHECKED because this allows page layout 

programs to present a “Preview” or visible version of your Illustrator 
file in the page layout document. This is extraordinarily helpful when 
putting pages together and also means that your document can be 
opened and viewed, including its FONTS, in a program that displays 
PDF’s such as Adobe ACROBAT® or Adobe READER® even if Illustrator 
and the fonts are not loaded on the machine. If this box is not checked, 
the page layout program will only show a box with coded text in it; 
not particularly helpful. The “Embed ICC Profile” BOX includes COLOR 
MANAGEMENT information with document, again used by page layout 
programs. “Use Compression” saves the file using “lossless” protocols 
to minimize the size of the file on your hard drive and for distributing 
the file through the internet.
We will ignore the “Transparency” and “Warnings” option sections at 
this time. Now, just CLICK “OK” and the DIALOG BOX will close and 
your document will be SAVED and visible again be on your screen. Now, 
you can go to work! 
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figure 1-a

figure 1-b

The Selection, Direct Selection, & Group Selection Tools

Figure 1-a, to the left, shows (from top to bottom) the three SELECTION 
TOOLS: The Selection (black arrow), Direct Selection (white arrow), 
Group Selection (white arrow with plus sign) Tools. All three are used 
to select and edit Illustrator OBJECTS — any on-screen image created 
with one of Illustrator’s CREATION tools — but each has different 
capabilities and allows you to select and edit Illustrator objects in 
different, often complementary, and powerful ways. 
Although we will use the SELECTION TOOL exclusively in the First 
Exercise, a short description of each tool and its most typical uses is 
given here.

Selection Tool
The Selection Tool (black arrow) only selects complete Illustrator 
Objects. In the First Exercise these will be limited to individual 
Illustrator Objects that you create with the Rectangle and Ellipse 
Tools (next page) and that you will either select singly or as a series 
of multiple selections. As you advance in the understanding and use 
of Illustrator, however, these will also include multiple Objects that 
have been organized into GROUPS. Intermediate users (you after a few 
exerises) and advanced users should access the  Selection Tool using 
the  KEYBOARD COMMAND (just type the letter ”v”)[figure 1-b].
When you use the MOUSE to CLICK on an Object with the Selection Tool, 
notice the ”BOUNDING BOX” (a rectangle composed of a thin colored 
line that surrounds the Object) 
with eight ”HANDLES” (little 
white boxes at the four corners 
and the center of each side of 
the box) and a ”CENTER POINT,” 
another little white box that is 
positioned, logically enough, 
at the center of the ”BOUNDING 
BOX” [figure 1-c]. NOTE: this is a 
DEFAULT setting. However, this 
function may have been reset 

in your Ilustrator View Menu and you will not see the BOUNDING BOX. 
In this case go to the VIEW MENU, CLICK and HOLD the MOUSE until 
the MENU OPENS, then SCROLL DOWN about two thirds of the way to 
the SHOW BOUNDING BOX Command and Selct it — hold the mouse on 
it until it highlights, then let go of the mouse button.  

Using the Selection Tool to MOVE an OBJECT
If you CLICK and DRAG (click and continue to hold the left button or 
the only button on a single button mouse and move the mouse up, 

down, or sideways) the CURSOR will MOVE the OBJECT in the direction 
and the distance you move the mouse [figure 1-d]. When you release 
the Mouse Button, you will stop moving the Object. 

The Selection Tools
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The Selection Tools continued

Moving the HANDLES of a BOUNDING BOX to 
SCALE and ROTATE
When you CLICK to SELECT an OBJECT, then 
move your CURSOR close to on of its HANDLES, 
notice the change in the CURSOR. It becomes 
a tiny, two headed arrow that runs , vertically 
on the TOP and BOTTOM HANDLES, and at a 45° 
diagonal at the CORNER HANDLES [figures 1-e-i, 

ii, iii]. When you move the CURSOR slightly 
away from the CORNER HANDLE, the diagonal, 
two headed arrow becomes a CURVED, two 
headed arrow [figures 1-e-iv]. These arrows show 
you the directions in which you can SCALE and 
ROTATE the OBJECT.

When you CLICK 
and DRAG one of 
the SIDE or TOP or 
BOTTOM HANDLES 
of an OBJECT, you 
will SCALE it — 
increase or decrease 
its size — only 
in the direction 

drag it and limited to a line connecting the handle 
with its opposite across the object; i.e. if you drag 
the right side handle to the right, the object will only 
increase in size horizontally to the right [figure 1-f-i].
When you CLICK and DRAG one of the CORNER HANDLES of 
an OBJECT, you will SCALE it from the diagonally opposite 
corner — increase or decrease its size — in the any of the 
directions you choose to move the CURSOR [figure 1-f-ii ].

Using the Shift Key to ”CONSTRAIN” a Move to HORIZONTAL, 
VERTICAL, and 45° INCREMENTS
If you HOLD DOWN the SHIFT KEY while you CLICK and 
DRAG an Object to a new position on the Ilustrator ART 

BOARD, you ”CONSTRAIN” or limit the directions in which you can drag 
the object to HORIZONTAL, VERTICAL, or a 45° ANGLE. This is just one 
way in which Illustrator makes incredible precision in drawing possible 
[figure 1-g - i, ii, iii].
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Using the Shift Key to create a “CONSTRAINED PROPORTIONAL” SCALE
If you HOLD DOWN the SHIFT KEY while you CLICK and DRAG on a 
HANDLE of an Object, you will create a ”PROPORTIONAL SCALE” of the 
object. This means that the ratio of the horizontal sides to the vertical 
sides of the bounding box and whatever shape it contains will remain 
the same as the box and shape are made larger or smaller [figure 1-g-iv ]. 
Rotating an OBJECT using the BOUNDING BOX CORNER HANDLES
If you hold your CURSOR near one of a BOUNDING BOX’S CORNER HANDLES 
you will see the diagonal, two headed arrow. If you move it slightly 
away from the HANDLE, this arrow changes to the CURVED, TWO HEADED 
ARROW [figure 1-g-v]. When you see the CURVED, TWO HEADED ARROW 
you can CLICK and DRAG the CURSOR to ROTATE the OBJECT around its 
CENTER [figure 1-g-vi]. Hold down the SHIFT Key while you ROTATE the 
OBJECT and you will CONSTRAIN your ROTATION to increments of 45° 
(45°, 90°, 135°, 180°, etc.) [figure 1-g-vii].

The Selection Tools continued
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Direct Selection Tool
The DIRECT SELECTION TOOL (white arrow — type “a” [figure 1-i]) only 
selects individual components of an Illustrator Object. It allows you 
to select a SINGLE PATH SEGMENT (the section of a Path between two 
Anchor Points) or a SINGLE  ANCHOR POINT (the “control” or edit 
point for any Illustrator Path segment). For example, if you CLICK on 
the corner of a rectangle, you should notice a number of details. First, 
the corner you Clicked will have a tiny BLACK SQUARE on it, meaning 
that it is SELECTED, while the other corners will be designated by TINY 
WHITE SQUARES, meaning that they are ACTIVE, but not SELECTED 
[figure 1-j-i— next page]. Second, you can Click and Drag the little 
Black Square to a different position, thereby changing the rectangle 
to a simple, four-sided object [figure 1-j-ii— next page]. Third, if you 
carefully CLICK on just one of the sides of the rectangle, you will 
see that all four corners have tiny white squares. This means that 
the Object is ACTIVE, but none of its corners are SELECTED. But the 
side you CLICKED is SELECTED. If, instead of just Clicking the side, 
you carefully CLICK and DRAG, you can move the side — called a 
PATH — and the little white boxes at each end of the PATH — called 
ANCHOR POINTS — in any direction you choose [figure 1-j-iii— next 

page]. Last, you can make what is called a MARQUEE SELECTION by 
CLICKING and DRAGGING the CURSOR over portion of an OBJECT. When 
you do this, you will see a rectangle described by pale, dotted line 
that is called a MARQUEE. All components enclosed by the MARQUEE 
will be SELECTED, including ANCHOR POINTS and any PATHS partially 
covered. The Anchor Points and Paths that are not touched will not be 
selected. However, since some of the Object is SELECTED, the OBJECT 
will be ACTIVE [figure 1-j-iv].

The Selection Tools continued
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Group Selection Tool
The GROUP SELECTION TOOL (white arrow with a plus sign) looks just 
like the DIRECT SELECTION TOOL, except that it has a small PLUS SIGN 
to the right of its top point on its Tool Bar ICON. However, when 
you select the GROUP SELECTION TOOL the PLUS SIGN moves to the 
lower right of the on screen cursor. The GROUP SELECTION TOOL can 
be considered a DIRECT SELECTION TOOL with “extras.” In fact, the 
best way to use it is never to choose it from the Tool Bar at all, but 
to remain in the DIRECT SELECTION TOOL and just depress the OPTION 
(Mac) or ALT (PC) Key when you need to access the GROUP SELECTION 
TOOL [figure 1-j-i].
In many ways, the GROUP SELECTION TOOL is like the SELECTION TOOL 
except that it is more versatile. This versatility will become ever more 
useful as your knowledge of ILLUSTRATOR grows. For now, use the 
GROUP SELECTION TOOL to Select an entire Object in ONE CLICK without 
leaving the DIRECT SELECTION TOOL. Just press the OPTION or ALT KEY 
while working in the DIRECT SELECTION TOOL and CLICK on an OBJECT. 
It will be completely SELECTED [figure 1-j-ii].

SHIFT-CLICKING to make Multiple Selections
If you depress the SHIFT KEY when using either the SELECTION TOOL  
or the GROUP SELECTION TOOL, you can make MULTIPLE SELECTIONS or 
DE-SELECTIONS. Of course, you first need some OBJECTS to SELECT, and we 
will cover that in the next section. For now, look at figures 1-j-iiia & b.

The Selection Tools continued
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The Zoom Hand Tool and Hand Tool

“Zooming” In with the Zoom Tool 

The “ZOOM” TOOL, located at the very bottom of the TOOL ICON sets 
in the, just above the FILL/STROKE ICONS on the Illustrator CS3 TOOL 
BAR. It Looks like a Magnifying GLASS and is called the “ZOOM” TOOL 
because you use it to “ZOOM IN” closer and “ZOOM OUT” farther from 
your work area in Illustrator. When you CLICK on the ZOOM TOOL, 
your CURSOR changes to the MAGNIFYING GLASS ICON with a PLUS 
SIGN [figure 1-k-i]. This is the DEFAULT MAGNIFYING GLASS TOOL and 
is the tool that, no surprise here, magnifies or “ZOOMS IN.” CLICK this 
tool on the part of your document that you want magnify and the 
image will enlarge using the POINT you CLICKED as the CENTER of the 
“ZOOM IN” [figure 1-k-ii]. 

As long as you have the MAGNIFYING GLASS TOOL SELECTED, the bottom 
left of the program “window” on the screen will show the “magnification” 

percentage of the current screen view [figure 1-k-iii]. The number 
“FIELD” that shows the percentage is a TEXT FIELD. You can 
CLICK in the FIELD to activate a BLINKING TEXT ENTRY CURSOR 
[figure 1-k-ii-in the box]. This allows you to TYPE  in any CUSTOM 
MAGNIFICATION PERCENTAGE that you wish.
When you CLICK on the TRIANGLE in the POP-DOWN, you will 
see a list of all the default magnifications. The current setting 
will have a CHECK MARK at its left. Move the CURSOR to the 
degree of MAGNIFICATION you desire and release the mouse 
[figure 1-k-iv].

Marquee Zooming
You can also ZOOM IN using the MAGNIFYING GLASS TOOL to create a 
MARQUEE, just as you can do with the SELECTION TOOLS. Just CLICK 
AND DRAG the MAGNIFYING GLASS CURSOR over the part of an image 
that you wish to enlarge. When you release the mouse, the area of the 
image within the MARQUEE will fill your screen [figure 1-k-v].

 

“Zooming” Out with the Zoom Tool 

With the ZOOM TOOL SELECTED and the MAGNIFYING GLASS ICON on 
the screen, press the OPTION KEY (Mac) or the ALT KEY (PC). The PLUS 
SIGN in the ICON’S center changes to a MINUS SIGN [figure 1-k-vi]. Now 
it is the “ZOOM OUT” TOOL. When you CLICK this tool on an image, you 
step down one increment of the default magnifications percentages — 
just the opposite of “zooming in” [figure 1-k-vii — next page]. While you 
can CLICK and DRAG a ZOOM OUT MARQUEE, they are not particularly 
useful or recommended.
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The Zoom Hand Tool and Hand Tool

Zoom Tool Keyboard Commands 
As you become familiar with Illustrator, you are bound to find that 
yourself ZOOMING IN and OUT of your image more and more often. 
More likely than not, constantly mousing over to the TOOL BAR to 
select the ZOOM TOOL and then, after ZOOMING, going back to re-chose 
the tool you were using will become progressively more annoying. 
KEYBOARD COMMANDS or SHORT-CUTS are the answer. No matter what 
tool you are using, just press the SPACE BAR and then the COMMAND 
KEY (Mac) or CONTROL KEY (PC) and you will access the ZOOM IN TOOL  
[figure 1-k-viii].
To access the ZOOM OUT TOOL, just press the SPACE BAR, then add 
the OPTION KEY (Mac) or ALT KEY (PC) to the COMMAND KEY (Mac) 
or CONTROL KEY (PC)/SPACE BAR combination [figure 1-k-ix]. This may 
feel a little awkward at the beginning, but stick with it. You will soon 
find that you are working faster and more efficiently; spending less 
time mousing around and more time creating. Note: these commands DO 

NOT work with the TYPE TOOL. 

If you have a two or more button mouse, especially if it has a “scroll 
wheel” or “scroll ball,” you can also program your mouse to ZOOM 
IN and OUT. The key to SHORT-CUTS is to use whatever you are most 
comfortable with. For most of this book, however, we will focus only 
on those SHORT-CUTS that are DEFAULTS in the program. 

Moving Around the Art Board and  
Paste Board with the Hand Tool 

The “HAND” TOOL is located right above the “ZOOM” TOOL at the bottom 
of the TOOL ICON sets on the Illustrator CS3 TOOL BAR. It is sometimes 
called the “Grabber Hand” because the HAND “closes” as if it were 
“grabbing” when you CLICK and DRAG this tool to use it  [figure 1-k-x].

While the ZOOM TOOL lets you “move” closer or further away from your 
image, the HAND TOOL complements this “movement” by allowing you 
to horizontally and vertically “shift” the position of your document’s 
ART BOARD on the PASTE BOARD — all the “empty” area surrounding  
the document boundaries. As an example: you have ZOOMED IN to the 
upper right hand corner of a SQUARE OBJECT on your document to 
make sure that its right hand edge is just inside the document’s right 
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The Zoom Hand Tool and Hand Tool

boundary. Now you want to make sure that the OBJECT‘S left hand 
edge is just inside the document’s left boundary. You could ZOOM back 
OUT then ZOOM IN to the new position. But it would certainly be easier 
just to slide the image over to the right until the left edge appeared. 
That’s what you can do with the HAND TOOL. Figure 1-k-xi shows this 
diagrammatically. First, CLICK and DRAG a ZOOM MARQUEE around the 

upper right hand corner [a]. The OBJECT STROKE (thick black line) 
is just inside the ART BOARD (thin black line). The HAND TOOL is 
then SELECTED. As it is CLICKED and DRAGGED (causing the CURSOR to 
“grab”) to the RIGHT until it reaches the right edge of the window, the 
OBJECT slides to the right inside the window [b].  The HAND TOOL is 
RELEASED, then immediately moved back to the left and CLICKED and 
DRAGGED to the right again [c]. The LEFT EDGE of the OBJECT becomes 
visible and it, too, is just inside the ART BOARD. The mouse is released 
and the HAND TOOL returns to its open position [d].
In most normal situations, the HAND TOOL provides the quickest and 
easiest way to move around inside your screen’s working area. There 
are, of course, numerous other tools available which will discussed later 
in the book, including the NAVIGATOR PANEL (under the WINDOWS 
MENU) and number of ZOOM and VIEW options under the VIEW MENU. 
All these options are all useful to an extent, and a few of the them are 
will end up being among the most important arrows in your quiver. But 
the HAND TOOL is the most important, especially when it is combined 
with its KEYBOARD COMMANDS so you avoid continually MOUSING 
OVER to the TOOL BAR. 

Key Board COMMANDS for the Hand Tool 

Just as you can always 
access the ZOOM TOOL no 
matter what tool you are 

using (except the TYPE TOOL) by using the KEYBOARD COMMANDS 
shown on the previous page, you can always access the HAND TOOL 
no matter what tool you are using (except the TYPE TOOL) by pressing 
the SPACE BAR. To “MOVE” the ART BOARD using this KEY BOARD 
COMMAND, just CLICK and DRAG while you are pressing the SPACE BAR. 
The exception for the TYPE TOOL is easily explained. When you are using 
the TYPE TOOL, the SPACE BAR creates spaces in the text. This is one of 
a few instances where MOUSING to the TOOL BAR becomes necessary. 
Likewise, when using the TYPE TOOL, the letter key commands for the 
SELECTION and SHAPE TOOLS do not work.
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SHAPE TOOLS: The Rectangle Tool and the Ellipse Tool

Using the Rectangle and Ellipse Shape tools

In the first exercise, we will create “compositions” consisting of black 
and white rectangles, squares, ellipses, and circles. To do this we need to 
use the SELECTION TOOL to both select and manipulate OBJECTS, which 
is what ILLUSTRATOR labels any on-screen image that you create using 
Illustrator’s creation tools. To SELECT and MANIPULATE an OBJECT, you 
need to have an OBJECT present. So, we will start by explaining and 
introducing the RECTANGLE and ELLIPSE TOOLS. By default (in other 
words, usually when the program opens), the RECTANGLE TOOL is the 
SHAPE TOOL available on the Tool Bar. Figure 1-l-ii shows its position in 
InDesign CS2, and CS3 single and double column Tool Bars. But, notice 
the tiny, black triangle in the lower right corner of the RECTANGLE tool 

icon. This little triangle indicates that there are other tools “nested” 
underneath the selected tool. To access the ELLIPSE TOOL, CLICK and 
HOLD the MOUSE BUTTON DOWN (left button on a two button mouse) 
and select the ELLIPSE TOOL as shown in figure 1-l-iii. This same 
procedure is used to access the other four tools in the SHAPE TOOL, but 
we will not be needing them for 
this  first exercise. Rather than 
MOUSING to the Tool Bar, select 
the RECTANGLE TOOL by Typing  
“m” and the ELLIPSE TOOL by 
Typing  “l” [figure 1-l-i].

figure 1-l-iii

figure 3 - Click and hold 

to access the submenus 

in the SHAPE TOOL. The 

Black Dot indicates the 

current active tool.

figure 1-l-i - You can 

also use KEYBOARD 

COMMANDS to access 

these tools. Type “m” for 

the rectangle tool and “l” 

for the ellipse tool.
While continuing to hold 

the mouse button down, 

move the cursor to the 

desired tool. 

figure 1-l-ii – By default, the 

RECTANGLE TOOL is selected on the 

Tool Bar when InDesign opens

When it highlights, let go 

of the mouse button and 

the tool is selected
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Using the Rectangle and Ellipse Shape tools

At the risk of stating the obvious, we use the RECTANGLE or ELLIPSE 
TOOLS to draw rectangles and ellipses, squares and circles. The easiest 
way to use either tool, once you have chosen it from the Tool Bar or by 
typing its respective KEYBOARD COMMAND,  is just to CLICK and DRAG 
the tool over the area where you wish to create a rectangle or an ellipse 
[figure 1-m-i & ii]. Notice that the CURSOR for both these tools changes 
to a CROSS-HAIR TARGET and the SHAPE you are “drawing” is simply 
shown as a shape in the current LAYER’s TARGET COLOR (more on this 
later). When you release the MOUSE BUTTON, the shape is drawn in the 
default WHITE FILL with BLACK STROKE mode (a white shape outlined 

in black — this will be discussed in depth in Chaper 2). Note also that 
the shape you have drawn is SELECTED (it keeps the Layer Target Color  
as a path with four HANDLES, also in the Layer Target Color; at the 
CORNERS for the RECTANGLE and at the CARDINAL POINTS for the 
ELLIPSE [figures 1-m-iii & iv].
To ”DRAW” a SQUARE, use the RECTANGLE TOOL and depress the SHIFT 
KEY as you CLICK and DRAG the shape [figures 1-m-v and vii].
To “DRAW” a CIRCLE, use the ELLIPSE TOOL and depress the SHIFT KEY 
as you CLICK and DRAG the shape [figures 1-m-vi and viii].

The Rectangle Tool and the Ellipse Tool continued
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Drawing Rectangles and Ellipses OUT FROM THEIR CENTERS
There will be times when you wish to draw a rectangle, ellipse, square, 
or circle OUT FROM ITS CENTER, rather than OUT FROM ONE CORNER 
as shown on the previous page. The process is nearly identical. The 
only difference is that you DEPRESS the OPTION (Mac) or ALT (PC) KEY  
while you are CLICKING and DRAGGING. Notice that when you press the 
OPTION or ALT KEY, the CURSOR adds a BOX-LIKE SHAPE around the 
CROSS HAIRS until you CLICK and start DRAGGING. The the CURSOR 
returns to the plain CROSS HAIR TARGET. As long as you start the shape 
by CLICKING at the point that you wish to be its CENTER, it does not 
matter if you depress the OPTION or ALT KEY before of after you start 
CLICKING and DRAGGING [figures 1-n-i through 1-n-viii].

Deselecting a SELECTED SHAPE after “Drawing” it 
To de-select any SHAPE after “drawing” it, choose the SELCTION or 
DIRECT SELECTION TOOL from the Tool Bar and CLICK it in an area 
outside the shape [figure 1-n-ix].

The Rectangle Tool and the Ellipse Tool continued
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The Rectangle Tool and the Ellipse Tool continued

Creating Rectangles and Ellipses WITH PRECISE NUMERIC DIMENSIONS
Adobe Illustrator allows you to be incredibly precise in you drawing 
when the need arises. The “internal grid” that Illustrator uses to 
position items on screen is accurate to 2 1/1000ths of an inch. 
You can put this precision to work for you by using “NUMERIC UNIT  
INPUT” rather than CLICK and DRAG “DRAWING”. 
Here's how.
From the UPPER LEFT CORNER 
CHOOSE either the RECTANGLE, or ELLIPSE TOOL form the Tool Bar. 
However, instead of CLICKING and DRAGGING the CURSOR on the 
ARTBOARD, just CLICK at the point on the artboard that will be the 
upper left hand corner of the shape. Immediately, the RECTANGLE or 

ELLIPSE DIALOG BOX appears on screen [figure 1-o-i]. Enter the size 
of the rectangle, square, ellipse, or circle you wish to create in the 
alpha-numeric text entry fields in the OPTIONS box. You can specify 
the size of your shape in inches (“in” - using decimals), centimeters 
(”cm”), millimeters (“mm”), or other units that we will cover when we 
discuss TYPE later in the book. CLICK “OK” to create the shape.
From the CENTER
The process here is almost exactly the same as described in the previous 
paragraph, except that you will hold down the OPTION (Mac) or ALT 
(PC) KEY  when you CLICK the point on the ”page” that will be the 
center of the shape [figure 1-o-ii: top of next page]. CLICK “OK” to 
create the shape out from the center point you clicked.
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The Rectangle Tool and the Ellipse Tool continued
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Using the Fill, Stroke, and None

What are FILL and STROKE? The easiest way to define them, at least at 
the beginning, is to call the FILL the “color” of an OBJECT and to call 
the STROKE the “outline” of the OBJECT. As you learn more about using 
Illustrator, you will learn a great deal more about these two terms and 
how to use them. 
One icon from the very bottom of the TOOL BAR is a GROUP of ICONS that 
allow you to set the FILL and Stroke of a Illustrator Object [figure 1-p]. 
Within this GROUP are two larger and five smaller icons. The first of 
these is the DEFAULT FILL & STROKE; White Fill with a Black Stroke 
[figure 1-p: 1]. No matter what colors make up the Fill or Stroke of a 
SELECTED OBJECT, when you CLICK this ICON, the FILL and STROKE will 
change to White and Black respectively. Notice that the tiny White 
square overlaps the tiny black outlined square. This signifies that the 
default setting is not only White Fill with a Black Stroke, but also that 
the fill is, by default, selected for editing.
To switch the FILL color to the STROKE and the STROKE color to the 
FILL, just CLICK on the small, curved, TWO-HEADED ARROW in the 
upper right corner of this set of Icons [figure 1-p: 2].
To edit the FILL color, you must have the LARGE, CENTRAL FILL ICON 
[figure 1-p: 3] overlap the LARGE, CENTRAL STROKE ICON [figure 1-p: 4]. 
In the case of Figure 1-p, this means you would CLICK on the FILL ICON  
so that it moves from behind to in front of the STROKE ICON before 
you can EDIT it. Once you have edited the FILL and then wish to EDIT 
the STROKE, just CLICK on the STROKE ICON. It will resume its original 
place in front of the FILL ICON.
You will notice that the color of “Figure 1-o: 5” will change to reflect 
which ever color is currently editable. The current example, [figure 1-p: 5] 
shows “WHITE” because the WHITE STROKE ICON is selected. If you 
switched the FILL and STROKE by CLICKING the curved, TWO-HEADED 
ARROW, “Figure 1-o: 5” would appear BLACK.
To create a FILL that is the DEFAULT WHITE to BLACK HORIZONTAL 
“GRADIENT,” CLICK on “Figure 1-o: 6”. In Illustrator, this ICON will only 
change the FILL.

 
To FILL or STROKE a shape with NONE (no color, just transparent 
space), CLICK on the last of these tiny square icons, the one with the 
DIAGONAL RED BAR running from the lower left corner to the upper 
right corner [figure 1-p: 7].

Keyboard Commands to control the FILL and STROKE ICONS 
When you are working in Illustrator, or any other high end graphics 
program, you don't really want to be continually running your cursor 
over to the Tool Bar to Select an TOOL, then running your cursor back 
to the image to edit it. Instead, make use of KEYBOARD SHORT-CUTS or 
COMMANDS. There are a number of them that you should learn to use 
with the FILL and the STROKE.

The first of these is the letter “d”. Just type “d” and Illustrator 
changes the Fill and Stroke to the DEFAULT WHITE FILL with a 
BLACK STROKE.

The next command is the letter “x.” Just type “x” and the 
Fill and Stroke Icons will change their overlap. Typing “x” 
works just like CLICKING on the ICON that is ”underneath” the 

currently active icon (the one in front) to bring it to the front and 
make it active. Type “x” again and the Icons will switch places again. 
When one command allows operations to alternate in this way, it is 
called a “TOGGLE.”

Typing “/” applies NONE to either the FILL or the STROKE, 
whichever is currently active.

Finally, there is the KEYBOARD COMMAND that 
duplicates the small, curved, TWO-HEADED 
ARROW by SWITCHING the FILL and STROKE 

COLORS. For this command, HOLD DOWN the SHIFT KEY and TYPE “x”. 

 Introduction: the FILL and STROKE Icons on the Tool Bar

figure 1-p
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 Introduction: COPYING, PASTING, and the ”CLIPBOARD” 

Copying and Pasting in Adobe Illustrator

Illustrator, like most applications, allows you to duplicate “information.” 
In Illustrator this means the OBJECTS you create. You do this by the 
process called ”COPYING” and “PASTING.” 
To “COPY” an OBJECT so that you can “PASTE” it, first SELECT the 

OBJECT using the SELECTION or GROUP SELECTION TOOL 
[figure 1-q: 1]. Then, Go: Edit>Copy [figure 1-q: 2]. 
You have now COPIED the OBJECT to the CLIPBOARD. What is 
the CLIPBOARD? It is a function designed into the Illustrator 
application (and most other computer applications) that 
holds the code for the most recently COPIED data in a 
special area of memory until: (1) it is called with the PASTE 
command so that a duplicate is placed into an open file, 
(2) another data set is COPIED and takes the place of the 
first data set, (3) you QUIT the program. In Illustrator, as 
in most programs, you can continue to PASTE an item an 

unlimited number of times. In some applications, the CLIPBOARD 
can hold more than one item. This is not the case in Illustrator.
Once the item is copied, Illustrator gives you a number of 
PASTING options. The first, and simplest, is the PASTE COMMAND 
— Go: Edit>Paste [figure 1-q: 3]. This PASTES (places) the copied 
OBJECT in the center of the active program window [figure 1-q: 4]. 

The PASTED OBJECT is SELECTED. 
That means if you are using the 
SELECTION TOOL, the OBJECT has a 
full BOUNDING BOX complete with 
four corner handles, four side 
handles, and a center point. If 

you are using the 
DIRECT or GROUP 
SELECTION TOOLS, 
the  OBJECT  wi l l 
o n l y  s h o w  i t s 
CONTROL POINTS 
and CENTER POINT.

Paste In Front and Paste In Back

Illustrator offers two other option for PASTING an OBJECT once it 
has been copied: PASTE IN FRONT [figure 1-q: 5] and PASTE IN BACK 
[figure 1-q: 6]. These two options allow you to place the PASTED 

OBJECT exactly in the same position as the COPIED OBJECT, but 
either exactly in front of it or behind it. As you advance in your 
knowledge of using Illustrator, this command will prove to be 
immensely useful. In the first exercises, however, you will be using 
PASTE IN FRONT and PASTE IN BACK to help you create more complex 
shapes from simple RECTANGLES, SQUARES, ELLIPSES, and CIRCLES. 

Here's how: 
(1) Create an ELLIPSE (or any other of the three shapes possible with 
the RECTANGLE or ELLIPSE TOOLS) that has a BLACK FILL and NO 
STROKE and COPY it to the CLIPBOARD [figure 1-q: 7].
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(2) GO: Edit>Paste In Front [figure 1-q: 8]. It will not look like 
anything has happened because an IDENTICAL OBJECT will be 
placed exactly on top of the OBJECT you SELECTED and COPIED 
[figure 1-q: 9].
(3) Using the SELECTION or GROUP SELECTION TOOL, CLICK and 
DRAG the Pasted ELLIPSE down a little, holding down the SHIFT 
KEY to CONSTRAIN the DRAG to VERTICAL [figure 1-q: 10]. Because 
the original Black Filled ELLIPSE was directly behind the new 
PASTED IN FRONT ELLIPSE, you will see it “emerge” as you DRAG 

the new Ellipse Down. 
(4)  CLICK on the DEFAULT 
WHITE FILL/BLACK STROKE 
ICON in the FILL and STROKE 
area at the bottom of the 
TOOL BAR. Make sure the 
STROKE ICON is in front of 
the FILL ICON (click it), 
and CLICK on the tiny NONE 
ICON at the bottom right 
below the FILL/STROKE 

ICON [figure 1-q: 11]. You have create a 
CURVED, ARC SHAPE by “LAYERING” a 
WHITE FILLED ELLIPSE on top of a BLACK 
FILLED ELLIPSE - in the example, the 
pale, dotted gray outline is there only to 
show the boundaries of the copied shape 
[figure 1-q: 11].
Note: If your ELLIPSE has a STROKE on it, do this. CLICK the STROKE 

ICON if it is ”behind” the FILL ICON (if it is in front, DO NOT CLICK it), 

and last, CLICK  on the tiny NONE ICON at the LOWER RIGHT of this 

area to remove the Stroke.

The CUT command
You may have noticed the “CUT” menu 
item above the “COPY” command on the 
Edit Menu [figure 1-q: 12]. What does it 

do? Like the COPY command, it takes 
a copy of the SELECTED OBJECT and 
places it on the CLIPBOARD. Unlike 
the COPY command, it DELETES 
the SELECTED OBJECT from the 
DOCUMENT. Because it places a copy 
of the OBJECT on the CLIPBOARD, 
once you have CUT an OBJECT, you 
can PASTE it just as if it was a COPY.

Copy and Paste using Keyboard Commands
Just as you don't really want to be continually running your 
cursor over to the Tool Bar to Select an TOOL, you don't want to be 
“mousing” allover you computer screen to COPY and PASTE. Here too, 
Illustrator makes things easier by offering KEYBOARD SHORT-CUTS 
for the COPY command and for all three PASTE commands. To COPY, 
just hold down the COMMAND (Mac) or CONTROL (PC) Key and Type 
“c”. To PASTE, just hold down the COMMAND (Mac) or CONTROL (PC) 
Key and Type “v”. To CUT, just hold down the COMMAND (Mac) or 
CONTROL (PC) Key and Type “x”. To PASTE IN FRONT, just hold down 
the COMMAND (Mac) or CONTROL (PC) Key and Type “f”. To PASTE IN 
BACK, just hold down the COMMAND (Mac) or CONTROL (PC) Key and 
Type “b” [figure 1-q: 13]. 
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COPY “DRAGGING”
There is another way to duplicate OBJECTS that combines COPYING and 
PASTING into a simple, single process. This is COPY-DRAGGING. Use the 
SELECTION TOOL (or the GROUP SELECTION TOOL) in combination with 
the OPTION (Mac) or ALT (PC) Key. Here's how: (a)  CLICK to SELEC
T the OBJECT you wish to COPY but don't release the MOUSE BUTTON. 
(b)  START to DRAG the OBJECT then HOLD DOWN the OPTION (Mac) or 
ALT (PC) Key. The CURSOR will change to a DOUBLE MOVE ARROW and 
you will be DRAGGING a COPY of your OBJECT and can move it to the 
position you desire [figure 1-p: 14a & 14b]. 

Using this method you can quickly place many SHAPES in different 
places on your ART BOARD. You can also create interesting 
COMPOUND SHAPES by scaling and rotating the shapes you create 
and copy. By changing some of the COPIED SHAPES from BLACK to 
WHITE, you can also create SHAPES where the alternate colored 
shape REMOVES part of the main shape [figure 1-q: 15a, b, & c]. 
Note: to see how you can use this process to “hide” the parts of any shape that 

extends beyond the edge of six inch by six inch boundaries of the document you 

named “my1st_illus_doc.ai”, create your composition of RECTANGLES, ELLIPSES, 

SQUARES, and CIRCLES in BLACK and WHITE. Realize that you will be cutting off 

all parts of all shapes that extend beyond the document’s six by six boundary. 

When you have the composition organized the way you want, CLICK and DRAG 

RECTANGLES so that they form a “window” of rectangles around the document. 

The examples in figure 1-q: 15a, b, & c show this “framing” as pale, dotted 

lines around the compositions. Don’t use the dots (even if you know how) on 

your compositions. To make these RECTANGLES to “frame” your work, do this: 

If you did not already have the FILL set to WHITE and the STROKE set to NONE, 

see figure 1-q: 16-1, -2, & -3. CLICK on the little DEFAULT (FILL & STROKE) ICON 

in the TOOL BAR or TYPE “d”. With the WHITE SHAPE with its BLACK OUTLINE 

still SELECTED, make sure that the FILL/STROKE has the 

STROKE ICON in front, then CLICK on the NONE ICON in the 

lower right of the icon group. 

 Sec1:18

alt

option
OR 

figure 1-q: 14a figure 1-p: 14b

 figure 1-q: 15a figure 1-q: 15b figure 1-q: 15c

    figure 1-q: 16

a b

3

2

1



making Illustrator work so you can work in Illustrator

Create four, black and white compositions

In the first exercise, we will create six ”compositions” consisting 
of black and white rectangles, squares, ellipses, and circles 
similar to the examples shown in figures 1-p: 15 a, b, & c. As 
you can see from the examples on the following four pages, you 
can be creative, eloquent, and elegant using these simple means. 
You will want to use the “WHITE FILL/NO STROKE” to “frame” the 
compositions as shown in figures 1-p: 15 a, b, & c as well.
You will also need some kind of concept to structure your thinking 
when you make these compositions. Concepts that are simple, or 
terse tend to be the easiest to “illustrate.” They can be purely 
abstract or abstract representations of emotions, feelings. Single  
words are best. One thing that all the examples share is the use 
of the fewest possible elements; you will see that some of them 
use complex and numerous elements to create “texture.” 
The tools you will use are:
(1) the SELECTION TOOL to select, move, manipulate, and “copy-drag” 

OBJECTS.
(2) the DIRECT SELECTION TOOL to select, move, and manipulate parts 

of OBJECTS.
 (3) the GROUP SELECTION TOOL to select, move, manipulate and 

“copy-drag” OBJECTS.
 (4) the ZOOM and HAND TOOLS to navigate around your OBJECTS and 

the ART BOARD and PASTE BOARD.
 (5) the RECTANGLE and ELLIPSE TOOLS to create OBJECTS, specifically 

RECTANGLES, SQUARES, ELLIPSES, and CIRCLES.
 (6) The COPY and CUT commands along with the PASTE, PASTE IN 

FRONT, and PASTE IN BACK commands
 (7) Artistic awareness of POSITIVE/NEGATIVE SPACE
 (8) The imaginative ability to see how to build complex shapes from 

rectangles, squares, ellipses, and circles
 (9) The imaginative ability to see how to “subtract” areas of shapes 

by using other shapes of the opposite color; i.e. a WHITE SHAPE 
removing part of a BLACK SHAPE and vice versa.

To start with, CREATE FOUR NEW DOCUMENTS named: 
“(your last name)-(your class or your class and section)-ex1a.ai” 
“(your last name)-(your class or your class and section)-ex1b.ai” 
“(your last name)-(your class or your class and section)-ex1c.ai” 
and so forth until you reach “…ex1f.ai”.
As an example, if your name is Ethelbert Miserere Gesundheit and you are 
taking DSGD83 at San Jose State University and are enrolled in Section 2, 
your first file must be named “gesundheit-dsgd83sect2-ex1a.ai”. 
Setting up a job or project protocol for naming files is essential to 
working efficiently. If you do it at the beginning, you will not need to 
go back to find and individually change a large number of randomly 
named files once the use of a system becomes obvious and necessary.

Please note: 
 a. NAME YOUR FILE AS SHOWN ABOVE. Save your creativity for the 

exercises.
 b. USE YOUR LAST NAME ONLY, DO NOT USE YOUR FIRST NAME unless 

there is another student in your section or employee in your 
department with the same last name.

 c. Use lower case only and separate words with dashes or underlines 
unless specifically requested not to. This will alleviate possible cross 
platform issues.

 d. If your copy of Illustrator does not automatically add the extension 
(the “.ai”) add it to the file name yourself for now and ask 
your instructor, check your manual, or check the web site of the 
manufacturer of your operating system (Apple for Mac OSX, Microsoft 
for Windows, etc) for instructions on how to enable this feature.

Next, create the files at 6 inches by 6 inches. If the Units are not set to 
INCHES, use the Units POPDOWN to change them. Since your document 
is a square, ignore the ORIENTATION ICONS. 
If your “New Document” Dialog box does not give you the further 
options at the bottom of the window [figure  1-p:  17], CLICK on the 
DOWNWARD POINTING ARROW. Then, use the POPDOWNS to match 
figure 1-q:17 at the top of the next page.

 Exercise 1: Black and white compositions

 Sec1:19
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CLICK OK and your document will 
open. Repeat this process each of the 
five times you start a new image. 

When the document opens, make 
sure that the LAYERS PANEL is visible 
on your screen. Go to the bottom 
of the LAYERS PANEL and CLICK on 
the NEW LAYER ICON immediately to 
the left of the LAYER TRASH ICON 
[figure 1-p: 18].

As you learned earlier in this chapter, this will create 
a NEW LAYER immediately above the original LAYER 
[figure 1-p: 19]. 
When you work on more complex documents with 
more Layers, remember this: the NEW LAYER is always 
inserted in the LAYER STACK directly above the CURRENTLY 
HIGHLIGHTED LAYER. Remember also that, when you are 
working on one of any number of SUB-LAYERS (INDENTED 
LAYERS created BELOW the HIGHLIGHTED LAYER when 
you “draw” OBJECTS on that HIGHLIGHTED LAYER), 
the NEW LAYER will be created above the CURRENTLY 
HIGHLIGHTED LAYER, not the SUB-LAYER you are working 
on [figure 1-p: 20]. 
DOUBLE-CLICK the newly created LAYER [figure 1-p: 21] 
to open the LAYER OPTION DIALOG BOX. In the text field, 
which will be HIGHLIGHTED by default, TYPE “frame” 
to name the LAYER [figure  1-p:  22]. Use this same 
process to change the name of “LAYER 1” to “Content” 

[figure 1-p: 23].
Then, CLICK once 
on  the LAYER named 
“frame” to SELECT it. 
Now ZOOM OUT (make 
the ART BOARD smaller 
on screen) by HOLDING 

DOWN the SPACE BAR plus the 
COMMAND and OPTION KEYS 
(Mac) or the CONTROL and ALT 
KEYS (PC) and CLICKING in the 
center of the ART BOARD —the 
thinly outlined, 6” X 6” square 
that showed on screen when 
you CLICKED “OK” on the NEW 
DOCUMENT DIALOG BOX in figure 

1-q: 17— two or 
more times, until the 
ART BOARD SQUARE 
is fairly small and 
surrounded by a 
goodly amount of 
on - s c reen  space 
[figure 1-p: 24].  

Make sure that the FILL/STROKE 
ICON at the bottom of the TOOL 
BAR is set to the DEFAULT 
WHITE FILL with BLACK STROKE. 
If not, CLICK on the TINY ICON 
above and left of the main FILL/
STROKE ICON as shown in figure 
1-q: 16-1 on page Sec1: 18. Then, 
SELECT the RECTANGLE TOOL and 
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“draw” FOUR RECTANGLES that surround but do not intrude into 
the 6” X 6” ART BOARD as shown in figure 1-q: 25. 
SELECT all these FOUR RECTANGLES by CLICKING the “FRAME” 
LAYER TARGET CIRCLE at the TOP RIGHT of the LAYER as shown 
in figure 1-q: 26. Go to either the COLOR PANEL or the FILL/
STROKE ICON at the base of the TOOL BAR, make the STROKE 
ACTIVE (it will be on top of the FILL), then CLICK the NONE ICON 
(the red diagonal) to remove the BLACK STROKE from all FOUR 
RECTANGLES. When you DE-SELECT 
these rectangles, all you should on 
screen is the ART BOARD. 
Now, CLICK on the LOCK square, 
immediately left of the EYEBALL, 
on the “FRAME” LAYER. A dark 
PADLOCK ICON will appear in the 
“FRAME” LAYER LOCK square and 

lighter gray, PADLOCK ICONS will appear in the LOCK squares of the 
FOUR SUB-LAYERS figure 1-q: 27. Click on the tiny, downward pointing 
TRIANGLE just to the right of the PADLOCK to HIDE the SUB-LAYERS.
CLICK on the “CONTENT” LAYER, to make it ACTIVE. It will be 
HIGHLIGHTED [figure 1-p: 28].
You are now ready to “draw” on the CONTENT LAYER. Because of the 
NON-STROKED, WHITE-FILLED RECTANGLES surrounding your ART 
BOARD on the LAYER above it in the LAYER STACK, only those parts 
of the SHAPES you “draw” will be visible on he ART BOARD. The rest 
of the SHAPES will be hidden by the OBJECTS on the FRAME LAYER. 
In other words, they will FRAME the ART BOARD [figure 1-p: 29].

On the four pages that follow are twenty-four examples of this 
exercise, done by students in the DSGD83 class at San Jose State 
University. Use these examples to help generate your own ideas. 
Notice how they make use of all the techniques discussed in the 
preceding chapter to create interesting shapes, shapes that “nest” 
within each other, shapes that are cut off by the edge of the 
compositions borders. Try to “reverse engineer” the shapes that 
interest you most to imagine how they were built. Try, as well, to 
come up with your own interpretation  for underlying concept of 
each piece. 
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General Notes on Color

The Illustrator Color Interface: 

Fill and Stroke Tool Bar Icon, 

Color Panel, Swatches Panel,

The Layers Panel

 Sec2:1
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More about CMYK and RGB: 
We have touched on the differences between the CMYK and the RGB 
color systems. Before we start using the Color Palette to create color 
Swatches for the Swatches Palette, we need to explore the uses and 
differences of these two systems a bit more.
First and foremost, the RGB (red, green, blue) color mode is the color 
mode we use to see. As you probably know, our retinas employ two 
kinds of cells by which we convert and transmit visual stimuli into 
vision. These are the Rods and the Cones, so called because of their 
shapes. The Rods see in gray scale only and are sensitive to a larger 
range of light values than the Cones, which are the retinal cells which 
perceive color. Consequently, the world appears in a “silvery” or black 
and white version to us at night and in other low light situations. 
This visual apparatus is evolutionarily much older than color vision. 
Our brains use this more ancient form of visual perception not only 
to see in the dark, but also to add edge and contrast definition to our 
color vision. The ancient nature of this type of vision is probably why 
we still derive enormous “artistic” satisfaction from black and white 
media.   
The Cones, on the other hand, are able to distinguish between the 
three main color components of the visible part of the electromagnetic 
spectrum, which we name Red, Green, and Blue. The sensory information 
that the Cones send to our brains are combined with each other and 
the information from the Rods in our visual cortex. In a manner 
that is still incompletely understood, the visual cortex converts this 
electromagnetic energy into our fabulously rich and colorful visual 
environment. 
The range of light and color we are able to see is enormous: from the 
blinding glare of looking straight at the sun to the complete darkness 
one experiences in an underground cavern when there are no lights. 
This natural range from lightest light to darkest dark, with all the 
myriad colors and shades of gray in between, is the foundation set of 
all colors by which we describe smaller sets or ranges of colors. There 
are many of these smaller sets of colors. The two major divisions are 
subtractive or reflective and additive or direct. Subtractive color is 
the range defined by the limitations of the reflective properties of the 

physical pigments that are present in leaves, grass, rocks, the sea, and 
feathers, as well as, more prosaically, in paint, ink, and other drawing 
and printing media. 
Additive color uses electromagnetic energy to cause substances to emit 
light in certain color wave lengths or, in the case of photographic 
filters, to only allow certain color wave lengths to “pass through.” 
The proportions of Red light, Green light, and Blue light emitted or 
“passed through” determines the color we see. 
The sun is our defining RGB color source. While nothing else in our 
everyday world emits such an enormous amount of electromagnetic 
energy in the visible spectrum, all RGB systems work in a similar 
fashion. Electromagnetic energy (it need not be visible light) falls on 
some physical object, like the phosphor in a CRT (cathode ray tube) or 
is fed into a transistor in an LED (light emitting diode) on a flat screen 
computer monitor, which is energized to a point where it gives off light 
of a certain color. On video and computer screens, these elements are 
tiny and, when viewed from a sufficient distance, they blend together. 
The lower the degree of excitation of each individual element, the 
dimmer or darker the color emitted. The higher the level of excitation, 
the brighter until the element reaches its point of saturation. When 
these physical elements are present in equal quantities of Red, Green, 
and Blue, and are all at their saturation point, the light they emit in 
aggregate appears to us as White. When they emit no light in aggregate, 
it appears as Black. When they emit light in identical quantities of 
each type, the light creates all the grays between black and white. 
When they emit light in differing quantities of each of the three types, 
the light appears colored.
When our eyes have adjusted to the limitations within a specific 
“gamut” between White (saturation) and Black (absence), we seem to 
see the full range of colors provided by sunlight. What we are actually 
“seeing” is a proportionally accurate “analog” of reality. For example, 
when the ratio of the brightness and color of the blue sky to the sunlit 
ground on the video screen is the same as the ratio of the brightness 
and color of the true sky to the true ground outside your window, our 
eyes and minds pretend that we are looking at the actual, rather than 
the analog, much dimmer, image.

 Color in Illustrator: Background Color Basics
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This secret of color ratios has long been known to painters and other 
artists who depict the world, even though they work with pigment 
(reflective) color rather than light. By creating ratios of brightness and 
color between elements in a picture, as well as by using other (fairly 
slippery) qualities of color, painters can create blindingly brilliant 
sunsets out of pigments that look dark compared to bright sun light.
Of course, the sun is also the defining source for all reflective colors as 
well. Rather than emitting visible light when visible electromagnetic 
energy strikes them, pigments absorb this energy, except for specific 
parts of the spectrum that the pigment cannot absorb. This part of 
the spectrum is reflected or “bounced off” by the pigment. We see 
only this unabsorbed portion of the original light source’s spectrum 
and recognize it as a “color.” The more different pigments that are 
combined together, the more light absorbing pigments there are, the 
darker the color. This is why adding all the paint colors together makes 
a sickly dark gray-brown. 
Theoretically, the range of additive colors should be nearly infinite 
and the range of reflective colors much more constrained. In reality, 
however, we are constrained to a much more limited gamut in both 
color modes. In additive color systems we are constrained by both 
the  nature and number of “light emitting” substances we can find or 
manufacture and by the very real physical and economic limitations 
placed on the amount of power we are able to pump through them. With 
reflective color systems, the major constraint is the limited number of 
substances we can find or create that are both useful as pigments 
and also moderately safe to use. Further constraints are added as we 
examine all the ways in which certain pigments do or don’t interact 
with other pigments. 
When we move into the world of printing, we encounter further sets 
of limitations. The first limitation is the mechanical act of transferring 
colored pigment from a “master image” onto a receiving medium, 
usually paper. With a few exceptions such as the gradient skies in some 
Japanese wood block prints and the “rainbow rolls” of contemporary 
fine-art lithographers, printed color is applied one color at a time. It 
is easy to imagine the technical difficulties inherent in printing more 
than eight to ten colors on one image. Printers and print makers found 

an answer to this problem by adapting the three “primary” colors of 
the reflective spectrum — red, yellow, and blue and adding a fourth 
color-black. In a sense, they came up with an intuitive implementation 
of the Rods and Cones of our eyes, adjusted to fit the limitations 
of reflective color. This pigment system is called the CMYK or Four 
Color Process system. It is the most widely used system for printing 
in “full color,” whether with low price ink jet printers or state of 
the art commercial presses. It combines tiny dots of various sizes of 
semi-transparent ink in one of four colors: Cyan (a sky blue), Magenta 
(a violet tinged red), Yellow (a strong but neutral, nearly transparent 
color), and Black on a white paper. These four colors do a passable 
job of creating a full color world, but only when the proportionate 
relationships of the colors are rigorously adhered to. Compared with 
the range of color available to the painter in oils, the CMYK range 
appears remarkably dull. The dark colors in CMYK tend more and more 
to slightly hinted dark grays as they approach black. The delicate 
pastels tend to wash out because there is so little pigment compared 
to the white of the paper. Rich dark greens and blues are absent. In 
high-end printing, especially in advertising for luxury goods, printers 
make up for these deficiencies of CMYK printing by adding “touch 
plates,” a fifth, sixth, seventh, or eighth pass through the press using 
specified ink colors to add the required intensity to certain areas of the 
image. However, this is no longer simply Four Color Process Printing.
How can these four colors simulate the full color spectrum? In the first 
place, the individual dots of ink are tiny. Even in common four color 
printing, there can be as many as 22,500 dots of each color in a square 
inch! Even if the printer keeps the maximum ink density, the total or 
the percentages of the four inks, to a conservative 280%, that comes 
to about 63,000 dots of colored ink in every square inch of the image. 
Because of the limitation of our vision’s acuity, and our evolutionary 
psychological preference for seeing solid or massed objects, our eyes 
see the tiny dots and our brains blend them together. Our preference 
for “seeing” reality within visual analogues combines these ink dots 
into images of the world (figure 2:A-8).
A further limitation to color printing is encountered when we add the 
Postscript Page Description Language to this mix. Postscript, a computer 
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language developed by Adobe 
Systems, Inc., allows for the 
precise, two-dimensional 
placement of coded objects 
upon a surface. It also 
converts the RGB system of 
the computer screen to the 
CMYK system of the print 
world and is the de facto 
computer language for almost 
all digital image printing. It 
works with both vector and 
bit mapped graphics codes. 
Current Postscript Printing 
technology only allows for 
256 color divisions, the binary 
limits set by 8 bit color output 
2 8 = (2 X 2 X 2 X 2 X 2 X 2 X 
2 X 2) = 256. There are four 
colors in the postscript world 
(C, M, Y, & K), each with 
256 divisions between full 
saturation and no saturation. 
While that theoretically 
allows for 16,777,216 colors 
on a computer screen 
(RGB-2563), it actually allows 

us only 1,024 colors or color divisions (CMYK, 256 X 4) 
when we are printing. While that number certainly allows 
us to create a very smooth gradient between two saturated 
colors on a normal image, it leads to problems when we 
are dealing with gradients between very pale colors or any 
color over large (20”) distances. These last are prone to an 
output artifact called “banding,” which creates a definite 
line of difference between the colors of a blend (figure 

2:A-9). There are a number of methods to minimize this 
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effect, in particular “dithering” and/or the addition of  
“noise,” but they work best in the bit mapped world.
Back to the Color Palette: So far we have been looking 
at the CMYK Color Palette. Most people who have 
worked with paint or ink find this the most intuitive 
because it works within a reflective or subtractive color 
system. However, because more and more designs and 
illustrations are destined for the web exclusively, the 
RGB system is coming into its own. As stated before, 
RGB allows you a much greater range, or gamut, of 
colors; especially in the deep blues, acid greens, and 
warm pastels. For those deeply entrenched in the subtractive system, mixing and 

blending colors in an additive system seems distinctly odd at first.  It 
is only a different color language, however; practicing and exploring 
within the RGB MODE are the answers. Below are the “primaries” and 
“secondaries” in both CMYK and RGB Color Systems.The formulas are 
accurate, but the images on the page, especially the RGB, are too much 
dull — print, even PDF Print, is a CMYK medium.
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Close value gradient showing Postscript BANDING

CMYK - Subtractive Color RGB - Additive Color

CMYK - Gamut (range) RGB - Gamut (range)

C = 0% 
M = 0% 
Y  =  100% 
K = 0%
C = 0% 
M = 50% 
Y  =  100% 
K = 0%
C = 0% 
M = 100% 
Y  =  100% 
K = 0%
C = 35% 
M = 100% 
Y  =  35% 
K = 0%
C = 100% 
M = 90% 
Y  =  10% 
K = 0%
C = 75% 
M = 5% 
Y  =  100% 
K = 0%

R = 255 
G = 255 
B = 0

R = 255 
G = 128 
B = 0

R = 255 
G = 0 
B = 0

R = 186 
G = 0  
B = 186

R = 71 
G = 0 
B = 255

R = 0 
G = 255 
B = 0
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Fill/Stroke Icon Review
In the first exercise, we created “compositions” consisting of black 
and white rectangles, squares, ellipses, and circles. To do this we used 
the SELECTION TOOLS to both select and manipulate ILLUSTRATOR  
OBJECTS. We used a somewhat cumbersome system to FILL and STROKE 
the OBJECTS that made up these compositions. That system worked, 
even if clumsily, but its only true advantage was that it was very simple 
to explain. Let’s review how it worked before we go on.
Figure 2-a: 1 shows the four areas of the FILL/STROKE ICON on the Tool 
Bar. At the top left is the DEFAULT ICON; CLICK this and any SELECTED 
OBJECTS will take on a White FILL with a BLACK STROKE of 1 POINT. 
The FILL ICON will be in front, meaning that it is ACTIVE and can be 
EDITED. Next to this little ICON is the CURVED TWO-HEADED ARROW 
that TOGGLES the ACTIVE part of the FILL/STROKE ICONS. In other 
words, if the FILL ICON is in front of the STROKE ICON [Figure 2-a: 1], 
CLICKING this ICON drops the FILL ICON is in back of the STROKE ICON, 
making the STROKE ICON ACTIVE. CLICKING the CURVED TWO-HEADED 
ARROW again reverses the positions of the ICONS again. Below the 
FILL/STROKE ICON are three small square ICONS in a row. The square 
on the left shows the ACTIVE COLOR, FILL or STROKE, whichever 
component is ACTIVE. The center ICON applies a BASIC, LINEAR, WHITE 
to BLACK GRADIENT to the ACTIVE COMPONENT — this will be covered 
later in the book. On the right is the NONE ICON. CLICKING this ICON 
removes all COLOR from the ACTIVE COMPONENT of the OBJECT, leaving 
it “transparent.”
Now, let’s explore a much more powerful way to use color in 
ILLUSTRATOR.
Figure 2-a: 2 gives eight examples of the eighteen possible options 
for the FILL/STROKE ICONS using only BLACK, WHITE, and NONE (we’ll 

ignore the GRADIENT ICON for now). Especially if you are new to Illustrator, 
create a simple shape on a new document, then use just the FILL/
STROKE ICON SET to FILL and STROKE the shape with BLACK, WHITE, 
and NONE in the eighteen possible ways for the FILL/STROKE ICONS to 
be ACTIVE.
Now it’s time to begin exploring more complicated and powerful ways 

to use color in Illustrator. The first of the TOOLS we will look at is 
the COLOR PANEL. With the COLOR PANEL you can create an almost 
limitless number of colors. 
In BASIC WORKSPACE mode, 
the COLOR PANEL is accessed 
by CLICKING on the “artist’s 
palette” ICON in the ICON 
DOCK at the top right of the 
ILLUSTRATOR  INTERFACE 
[figure 2-a: 3].
In both PANEL WORKSPACE 
and TYPE WORKSPACE mode, 
the COLOR PANEL [figure 2-a: 4] is at the top of the PANEL COLUMN at 
the right of the ILLUSTRATOR INTERFACE. The COLOR PANEL shows 
you (a) the FILL COLOR and (b) the STROKE COLOR and allows you 
to make one or the other ACTIVE with the same process as we used 
with the FILL/STROKE ICON on the TOOL BAR. Once the FILL or the 
STROKE has been activated, CLICKING the (c) WEB SAFE COLOR ICON 

changes the chosen color 
to the nearest WEB SAFE 
COLOR. When you are in 
the CMYK COLOR system 
(as shown in figure 2-a: 4), 
the (d) PRINTABLE COLOR 
BOX shows the same color 
as the FILL ICON because 
CMYK colors are PRINTABLE 
by definition. If you are 
working in another COLOR 
SYSTEM, for example in 
RGB [figure 2-a: 5], the 
SLIDER BARS and the 
PERCENTAGE TEXT FIELDS 
will change accordingly. 
Notice, also, that a small 
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YELLOW TRIANGLE with an “!” in it has appeared 
beside the PRINTABLE COLOR BOX [CLICK circle on 

figure 2-a: 5]. This means that the color created in 
the specified COLOR SYSTEM (RGB, HSB, or WEB 
SAFE) cannot not matched in the CMYK SYSTEM and, 
therefore, will change if printed. If a PRINTABLE 
COLOR is required, just CLICK the little YELLOW 
TRIANGLE or the PRINTABLE COLOR BOX [CLICK circle 

on figure 2-a: 5] and the currently ACTIVE COLOR 
will change to a PRINTABLE COLOR [figure 2-a: 6], 
although the COLOR SYSTEM will not change. Notice 
how the positions of the sliders and the numbers 
in their associated text fields has changed from 
[figure 2-a: 5] to [figure 2-a: 6].

Creating Colors with the COLOR PANEL

For the present, we will be working in CMYK 
COLOR. This is the main, international standard 
for printing color on PRINTING PRESSES. We will 
discuss this COLOR SYSTEM and the other COLOR 

SYSTEMS available in Illustrator in 
much greater detail later in the book. 
If you remember, we specified CMYK 
color when we set up “my1st_illust_
doc” in the Introduction to the book. 
If, for whatever reason, you find that 
you are not presently in the CMYK 
mode (if you open the COLOR PANEL 
and it does not show 4 COLOR SLIDERS, 
you are not in CMYK), here is how to rectify this.

1. Click on the File Menu and SCROLL DOWN to the bottom 
to show the DOCUMENT COLOR MODE and 

choose CMYK COLOR from the FLY-OUT [figure 2-a: 7i]. This 
changes the DOCUMENT COLOR MODE to CMYK.

 2. Click on the FLY-OUT button [figure 2-a: 4-l, previous page] to show 
the COLOR PANEL OPTIONS MENU and choose CMYK, the fifth 
item down the list [figure 2-a: 7ii]. This changes the COLOR PANEL 
COLOR SYSTEM to CMYK.

It is necessary to make both these changes because you can specifiy 
colors using any color system you choose in the COLOR PANEL. The 
DOCUMENT COLOR MODE will override the COLOR PANEL COLOR SYSTEM, 
however, and this can cause both color and OUTPUT problems, espcially 
if you are specifying RGB colors in a CMYK document.
Note: If your COLOR PANEL is only the SPECTRUM BAR, CLICK on the 
FLY-OUT and choose SHOW OPTIONS [figure 2-a: 8].  
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The FILL/STROKE TOOL BAR ICON and the COLOR PANEL
Watch the main FILL/STROKE ICON on the TOOL BAR when specify a 
color on the COLOR PANEL. For example, CLICK on the STROKE ICON at 
the bottom of the TOOL BAR and notice how the STROKE ICON is now in 
front on the COLOR PANEL. Then CLICK on the FILL ICON on the COLOR 
PANEL and watch the TOOL BAR FILL ICON return to the FRONT. The FILL 
and STROKE ICONS will always be in agreement, CLICKING on one FILL or 

STROKE ICON will always change all the 
FILL or STROKE ICONS [figure 2-a: 9].

Using the SPECTRUM BAR
The SPECTRUM BAR is among the most 
intuitively obvious of Illustrator’s 
color tools. Just move the CURSOR 
over the color you desire, CLICK, and 
you have SELECTED the COLOR. But, 
let’s take some time out to look at the 
SPECTRUM BAR in a little more depth  
[figure 2-a: 10a]. At the far left is the 
NONE square. CLICK here and you 
remove any FILL or STROKE that is 

currently ACTIVE on a SELECTED OBJECT. 
Likewise, if you CLICK on either the upper 
right WHITE RECTANGLE or the Lower right 
BLACK RECTANGLE on the SPECTRUM BAR 
you place either a WHITE or BLACK FILL 
or STROKE on a the ACTIVE component of 
a SELECTED OBJECT. Note also, that when 
you move the CURSOR onto the SPECTRUM 
BAR, it changes from an ARROW to an 

EYEDROPPER [figure 2-a: 10a]. Furthermore, when 
you CLICK the EYEDROPPER CURSOR over a color 
on the SPECTRUM BAR, the CURSOR changes to show 
that it has “picked up” the color [figure 2-a: 10b] 
and PLACED this color into the currently ACTIVE 
FILL or STROKE ICON [figure 2-a: 10c].  

Using the CMYK SLIDERS
For the present, as mentioned already, we will be using the CMYK COLOR 
MODE, the international standard for color printing on presses. It is the 
only REFLECTIVE or SUBTRACTIVE COLOR MODE available on the computer*. 
All the other COLOR MODES are DIRECT or ADDITIVE COLOR SYSTEMS; like 
sunlight, the more colored light the brighter and lighter the color. More 
on this later.
We start with the CMYK because it is the COLOR SYSTEM most similar to 
“mixing paint.” Just as when you were in elementary school and mixed 
RED, BLUE, and YELLOW poster paints to make a range of colors, CMYK 
achieves its range of colors by mixing percentages of its four component 
colors: CYAN (“C”— a pure “sky” blue), MAGENTA (“M”— a “pinkish” 
red), YELLOW (“Y”— a neutral, somewhat ”lemony,” yellow), and BLACK 
(“K”— either for KEY, a traditional printer’s term for Black, or to avoid 
confusion with “b” for blue) [figure 2-a: 11]. Note, there is no WHITE in 

CMYK. Lighter colors merely have less pigment and show more of the white 
of the printing paper. And, just like with elementary school poster paints, 
the more paint you mix together the darker and, usually, the muddier the 
colors get. There are innumerable technical details inherent in the use 
of the CMYK SYSTEM, some of which we will cover in detail later in the 
book. For this chapter, just remember these four rules: less color (lower 
percentage) makes a lighter color, more color (higher percentage) makes 
a darker color, the more different the positions of the CMYK SLIDERS (or 
the numbers in the percentage text fields) the more intense the color, the 
more similar the SLIDER positions (or the numbers in the percentage text 
fields) the more neutral the color.
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* Actually, it is only an emulation of the true CMYK system’ more limited COLOR GAMUT 
within the computer’s much larger, native RGB COLOR FORMAT. This is a necessary 
procedure because computer screens generate light rather than reflecting it. 

figure 2-a: 9

figure 2-a: 10a

figure 2-a: 10b

figure 2-a: 10c

figure 2-a: 11

  CYAN MAGENTA YELLOW BLACK
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Figure 2-a: 12i through iv below show the COLOR SLIDER POSITIONS on 
the COLOR PANEL for the four CMYK colors.
Also below are the COLOR SLIDER POSITIONS on the COLOR PANEL for 
the CMYK percentages that make up yellow-orange, orange, blue, red 
violet, red, green, blue-green, blue-violet [Figure 2-a: 13i through viii], 
four neutral grays [Figure 2-a: 13ix through xii], and four soft colors 

[Figure 2-a: 13xiii through xvi]. Of course, the range of all colors possible 
in the CMYK MODE, while no where near infinite, is remarkably broad, 
considering it uses only four inks and the white of the paper.
STUDY EXERCISE: familiarize yourself with the color sliders, study the 
slider positions and the percentage fields, then create your own series 
of CMYK colors.
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Using the Swatches Panel
In the previous section, you learned how to make 
colors using the COLOR PANEL. Naturally, if you 
have an OBJECT SELECTED and the FILL or the 
STROKE ACTIVE when you make the color, that will 
be the color of the ACTIVE COMPONENT. The fly in 
the ointment here is that, if you do not have an 
OBJECT SELECTED, and you don’t remember the 
percentages or SLIDER positions, that COLOR is 
gone the minute you CLICK on any OBJECT with a 

different FILL or STROKE. What you need is a way to SAVE the COLORS 
you create with the COLOR PANEL. That is what you do with the 
SWATCHES PANEL. 
To open the SWATCHES PANEL in the BASIC WORKSPACE, just CLICK 
the third ICON from the top of the ICON DOCK — the little grid that 
becomes colorful when you move the CURSOR over it [Figure 2-b: 1]. 
If you are working in the PANEL or TYPE WORKSPACE, the SWATCHES 
PANEL is the second PANEL from the top, right below the COLOR PANEL 
[Figure 2-b: 2]. 
You have probably noticed that when you access a PANEL, the PANEL 
name you selected is placed in a light colored TAB at the top of the 
PANEL and there are darker colored TAB(S) with other names beside it. 
This is a standard ILLUSTRATOR CONVENTION (way of doing things) and 
is called NESTING. Any PANEL that has more than one TAB at the top 
is called a NESTED PANEL. The ACTIVE PANEL is named on the LIGHT 
TAB. The other PANEL(S) are just a MOUSE CLICK away. CLICK on one 

of the darker TABS and the current 
PANEL will be replaced by the PANEL 
named on the TAB you CLICKED. The 
new PANEL will now have the lighter 
TAB and the TAB of the previous, 
now hidden, PANEL will be darker 
[Figure 2-b: 3].
Now, let’s take a closer look at the 
SWATCHES PANEL. The central area, 
which is expandable, shows thumbnails 

of all the SWATCHES currently saved [Figure 2-b: 4a]. The MINIMIZE 
BUTTON shrinks the PANEL to just its TABS [Figure 2-b: 5].  The OPTIONS 
FLY-OUT opens a menu [Figure 2-b: 6] that allows for comprehensive 
management of the SWATCH PANEL. We will discuss these Options 
at greater length later. The SWATCH LIBRARIES MENUS POP-DOWN 
[Figure 2-b: 7 - next page] opens a list of all the SWATCH LIBRARIES 
currently available in your Illustrator Application. 

What, you may ask, is a SWATCH LIBRARY? It is an internally stored, exportable 

database of named groups of SWATCHES. LIBRARIES (and here we mean all 

ILLUSTRATOR LIBRARIES, not just SWATCH LIBRARIES)  are sometimes grouped 

into main and sub-menus There are a number of SWATCH LIBRARIES that come 

with Illustrator and you can create any number of your own. For example, if a 

designer has a client who uses only 10 different CMYK colors on all their print 

jobs, the designer can create a SWATCH LIBRARY of that set of colors and save 

it. It is then available to the designer anytime he or she is working on a project 

for that client.

 Color in Illustrator: The Swatches Panel

 Sec2:10

              figure 2-b: 1

 figure 2-b: 2

figure 2-b: 4 figure 2-b: 5

 figure 2-b: 6

 figure 2-b: 3

a

e f g h i j k

b c

d

a. Swatch Thumb-
nails

b. Minimize Button

c. Close Button

d. Options  
fly-out menu

e. Swatch Libraries 
Pop-down Menus

f. Swatch Kinds  
Pop-down Menus

g. Swatch Options 
dialog Box

h. New Color Group 
dialog Box

i. New Swatch  
dialog Box

j. Swatch Trash

k. Panel expansion 



making Illustrator work so you can work in Illustrator

When you have chosen a specific SWATCH LIBRARY by 
highlighting it and then releasing the mouse, the LIBRARY 
appears on screen as another panel [Figure 2-b: 8].
Later in the book, we will go into far more depth about 
LIBRARIES and their use. For now, just be aware that they 
exist and that they can be accessed from the bottom left 

ICON on the SWATCHES PANEL.
Next to the SWATCH LIBRARY ICON is the 
SWATCH KINDS ICON [Figure 2-b: 9]. When 
this ICON is CLICKED, the SWATCH KINDS 
POP-DOWN appears, offering a choice of 
All Swatches (the current setting for all 
the SWATCHES PANELS to this point), 
COLOR SWATCHES [Figure 2-b: 10a],
GRADIENT SWATCHES [Figure 2-b: 10b]. 

PATTERN SWATCHES [Figure 2-b: 10c], and COLOR 
GROUPS [Figure 2-b: 10d].

If you are brand new to Illustrator, you may be asking 
yourself, “Self, do I need to know and 
remember all this so early in the game?” 
The answer is a simple “no!” However, 
it won’t hurt to familiarize yourself with 
the ICONS and the concepts that go with 
them. You will be using all these tools 
as you become more proficient with the 
program. If you do take the trouble to 
come to terms with these aspects of 
both the COLOR and  SWATCHES PANEL,  
to quote the Ancient Sage of Brooklyn, 
“How zit gonna hoit?”
If you are already enlisted in the 
Illustrator army, but are new to CS3, 
many of these tools on the SWATCHES 
PANEL (as well as the fact that what were 
called Palettes are now called PANELS) 
will be new, and possibly exciting.

Just to the right of the SWATCH KINDS ICON is the SWATCH OPTIONS 
ICON. CLICKING this ICON opens the SWATCH OPTIONS DIALOG BOX 
[Figure 2-b: 11a]. Given its name, it 
isn’t surprising that this DIALOG 
BOX presents you with a number of 
options. First of all, you can name 
or re-name your SWATCH in the 
text field.
Second, you have a POP-DOWN  
MENU for a choice of PROCESS 
or SPOT COLOR for the SWATCH 
[Figure 2-b: 11b — we will discuss 
these two options later in the book 
when we go into more depth on 
color]. Third, another POP-DOWN 
offers a menu of ILLUSTRATOR’S 
COLOR MODES [Figure 2-b: 11c — as 
above]. Last, there are the COLOR 
SLIDERS and PERCENTAGE FIELDS, 
familiar from the COLOR PANEL, 
a color square with the tiny 
WEB-SAFE SQUARE below it, and 
two check boxes [Figure 2-b: 11d 

— as above]. The COLOR SQUARE 
changes color as the SLIDERS or 
the PERCENTAGE FIELDS are edited. 
Just as on the COLOR PANEL, 
CLICKING the WEB-SAFE SQUARE 
will convert the color in the COLOR 
SQUARE to the nearest WEB-SAFE 
COLOR. We will discuss GLOBAL 
COLOR later in the book. When you 
check the PREVIEW CHECK BOX, 
any SELECTED COLOR on an OBJECT 
and the corresponding SWATCH will 
change as you edit the color.

 Color in Illustrator: The Swatches Panel
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Next on the list is the NEW COLOR GROUP ICON. Briefly, a COLOR 
GROUP is an “on-Panel” folder that allows you to group certain 
colors together. The reasons are limited only by your imagination: 
client palettes, color harmonies, sheer perversity. When visible on 
the thumbnail window of the SWATCHES PANEL (having been opened 
from the SWATCH KINDS ICON), each COLOR GROUP is displayed as 
a horizontal line of SWATCHES that starts with a little “folder” 
SWATCH at the left edge of the PANEL WINDOW [Figure 2-b: 10d].
To use the NEW SWATCH GROUP ICON, you should have already 
created the colors you wish to include in the GROUP as SWATCHES 
or as colors on one or more OBJECTS.  If the COLORS you wish to 
group are on the SWATCHES PANEL, you SELECT them by CLICKING 
on them [Figure 2-b: 12a]. If you wish to SELECT a continuous series 
of SWATCHES, CLICK on the first (or last) SWATCH in the series, 
HOLD DOWN the SHIFT KEY and CLICK the last (or first) SWATCH in 
the series [Figure 2-b: 12b]. If you wish to SELECT a discontinuous 
group of colors, CLICK on the one of the colors you wish to 
include, then HOLD DOWN the COMMAND (Mac) or CONTROL (PC) 
KEY and continue to HOLDING it DOWN while CLICK on each the 
remaining colors of your choice [Figure 2-b: 12c].  If the colors you 
desire are on an OBJECT or set of OBJECTS, SELECT the OBJECT or 
those parts of the set of OBJECTS that contain the colors you wish 
[Figure 2-b: 13]. 

Then, when you CLICK the NEW SWATCH GROUP ICON, 
the NEW SWATCH GROUP DIALOG BOX opens  If you 
have SELECTED only COLOR SWATCHES on the SWATCHES 
PANEL, the simple, Name-Field-Only  NEW COLOR GROUP 
dialog box will open [Figure 2-b: 14a]. If you have 
SELECTED an OBJECT or OBJECTS, or some OBJECTS and 
some SWATCHES on the SWATCHES PANEL, the complete 
NEW COLOR GROUP dialog box will open [Figure 2-b: 14b]. 
If you have selected only OBJECTS, the lower, “Selected 
Artwork” radio button  will be checked. If you have 
selected the colors of more SWATCHES than OBJECTS, the 
upper radio button, “Selected SWATCHES” will be checked; 
if more OBJECTS than SWATCHES, the lower, “Selected 

Artwork” radio button  will be checked. You are free to change the 
RADIO BUTTON selection. No matter which Dialog comes up, name the 
COLOR GROUP in a way that it will be easy to remember.

NOTE: a COLOR GROUP can only contain COLORS. You cannot add gradients 
or patterns to a COLOR GROUP. If you inadvertently SELECT a GRADIENT 
or PATTERN SWATCH on the SWATCHES PANEL or a SELECTED OBJECT, and 
then CLICK the NEW COLOR GROUP ICON, you will be presented with the 
NEW COLOR GROUP DIALOG BOX. However, after naming the GROUP and 
CLICKING OK, a warning dialog will open to tell you that you cannot do 
this (it would have been nice if it had opened before you named it). 
CLICK OK and try it again [Figure 2-b: 15]. Note also that when you have a 

COLOR GROUP SELECTED, the SWATCH OPTIONS ICON changes to the EDIT COLOR 

GROUP ICON [Figure 2-b: 16] which we will consider later in the book.

 Color in Illustrator: The Swatches Panel
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The next ICON to the right is the NEW SWATCH ICON. When it is CLICKED, 
it opens the NEW SWATCH DIALOG BOX [Figure 2-b: 17a]. This is nearly 
identical to and works very much the same as the SWATCH OPTIONS 
DIALOG BOX. It has the PROCESS COLOR/SPOT COLOR POP-DOWN 
[Figure 2-b: 17b], the COLOR MODE POP-DOWN [Figure 2-b: 17c], and the 
SLIDERS, PERCENTAGE TEXT FIELDS, the COLOR SQUARE, the WEB-SAFE 

SQUARE, and the GLOBAL CHECK BOX [Figure 2-b: 17d].
All that was said concerning these commands and options in the 
section about the SWATCH OPTIONS DIALOG BOX holds true for the 
NEW SWATCH DIALOG BOX.
Last of all, at the far right of the bottom ICON BAR of the SWATCHES 
PANEL is the SWATCHES TRASH ICON. Just CLICK a SWATCH and DRAG it 
over this little ICON and the SWATCH is DELETED. You can also SELECT 

a range of SWATCHES as in figures 2-b: 12b & 12c and DRAG them over 
this ICON to DELETE them. You can also SELECT one or more SWATCHES, 
then CLICK on the TRASH ICON. This opens the “DELETE THE SWATCH 
SELECTION?” WARNING DIALOG [Figure 2-b: 18]. When you CLICK “OK,” 
the SWATCH, SWATCHES, or COLOR GROUP is DELETED.

It’s worth noting here that the SWATCHES TRASH is remarkably 
useful. For some designers and Illustrator artists, it is the site of the 
first action they take after opening, naming, and saving a file: they 

immediately SELECT and DRAG all the SWATCHES 
on the PANEL to the TRASH — except the NONE 
and REGISTRATION SWATCHES [Figure 2-b: 19], 
which cannot be deleted. This insures that only 
those SWATCHES used in the document will be 

on the SWATCHES PANEL attached to that document. It is also worth 
noting that all SWATCHES in a given document’s SWATCHES PANEL are 
saved with that document. This is worth remembering since it means 
you can always reclaim a set of SWATCHES by opening the document 
to which they are attached.

STUDY EXERCISE — CREATE A SPECTRUM: open a new document, name 
it “exercise2-color-1,” and 
save it to your Illustrator 
projects folder. Unless 
you are in the PANELS 
WORKSPACE [Figure H in the 

Introduction], Go: Window 
> Workspace > [Panel]   
[Figure 2-b: 20]. 
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 1. Make sure that both the COLOR PANEL and the SWATCHES 
PANEL are open. 

 2. SELECT and DELETE all the THUMBNAILS in the SWATCHES 
PANEL (DRAG the SELECTED SWATCHES over the TRASH 
ICON) except the NONE and REGISTRATION SWATCHES. 
(if you include the NONE and REGISTRATION SWATCHES 
in your selection, the TRASH ICON will be dimmed and, 
therefore, unavailable.) 

 3. Make sure that you are in the CMYK COLOR SYSTEM. 
If there are FOUR SLIDERS on the COLOR PANEL, you 
are in CMYK. If there are three or only one SLIDER, 
go to the COLOR PANEL FLY-OUT and SELECT CMYK 
[figure 2-a: 7ii].

 4. Create a color using this formula: C = 0, M = 100, 
Y = 100, K = 0. Your COLOR PANEL should look like 
[Figure 2-b: 21]. 

 5. Do either of the following:
 (a) CLICK and DRAG the FILL COLOR with the RED SQUARE to 

the THUMBNAIL area on your newly emptied SWATCHES 
PANEL [Figure 2-b: 22a]. 

 (b) CLICK the FILL COLOR with the RED SQUARE, then 
CLICK the NEW SWATCH ICON on the SWATCHES PANEL 
[Figure 2-b: 22b]. The NEW SWATCH DIALOG BOX 
will open, showing the name in its CMYK formula 
[Figure 2-b: 23], along with the other details mentioned 
in examples in figures 2-b: 17a, b, c, d. CLICK “OK” and 
the DIALOG BOX will close and the NEW SWATCH will 
appear in the THUMBNAILS  of the SWATCHES PANEL.

 6. Continue creating colors with the COLOR PANEL and adding 
them to the SWATCHES PANEL using these CMYK formulae:  
C = 0, M = 0, Y = 0, K = 0 (white); C = 0, M = 0, Y = 0, K = 100 (black);  
C = 0, M = 100, Y = 50, K = 0; C = 0, M = 0, Y = 100, K = 0;  
C = 100, M = 0, Y = 100, K = 0; C = 100, M = 100, Y = 0, K = 0;  
C = 50, M = 100, Y = 0, K = 0 [Figure 2-b: 24].

  SAVE YOUR DOCUMENT for later use.

The LAYERS PANEL
Finally, we come to one of the most powerful tools of all in Illustrator, 
LAYERS. It is neither the most intuitive nor the easiest to learn of Illustrator’s 
tools. However, once you come to terms with it and its many subtleties, 
you will understand why so many graphic arts professionals love working 
in Illustrator. Figure 2-c: 1 shows the ICON at the bottom of the “DOCK” 

that open the 
LAYERS PANE and 
Figure 2-c: 2 shows 
the LAYER PANEL in 
its DEFAULT position 
at the bottom of the 
[PANEL] WORKSPACE 
stack. Unless you 
are working very 
specifically on a 
detail of an image 
and you have a real 

shortage of screen real estate, it is helpful to have the LAYER PANEL open 
and in an easily reached position at all times — it is too useful to keep 
mousing around to its DEFAULT position or to keep showing and hiding it, 
even with the “F7” KEYBOARD SHORTCUT. Here’s how:
 1. If you are in the [PANEL] WORKSPACE, position your MOUSE on the 

gray area to the right of the Layers TAB, then CLICK and DRAG the 
LAYER PANEL left and out of the PANEL STACK [Figure 2-c: 3]. The 
LAYERS PANEL is now a “FLOATING” PANEL and can be moved to any 
part of your screen you wish. It will remain on screen in that position 
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until you re-position it, move it back (again using the gray 
bar to the right of the TAB) onto either the PANEL STACK 
or the ICON DOCK, or you CLICK the CLOSE BUTTON, just 
as on the COLOR and SWATCHES PANELS, the tiny “X” at 
the upper right hand corner of the PANEL. If you have 
CLICKED the CLOSE BUTTON, you will need to Go: WINDOW 
> LAYERS [Figure 2-c: 4], or type “F7” [Figure 2-c: 3] to 
reopen the PANEL. 
Let’s look at the parts of the LAYERS PANEL. You are 
already aware of the LAYER TAB and the GRAY BAR that 
you used to move the LAYERS PANEL from the PANEL 
STACK [Figure 2-c: 6a]. Likewise, you should be familiar 
with the three tiny ICONS in the upper right corner of the 
PANEL: the MINIMIZE BUTTON (single horizontal line), 
the CLOSE BUTTON (X), and the OPTIONS MENU FLY-OUT 
(three horizontal lines) [Figure 2-c: 6b]. On the left-most 
edge of the PANEL there are squares [Figure 2-c: 6c]. In 
this example, the top two squares have “open eyes” 
in them. This ICON is called, amazingly enough, the 
EYEBALL. When there is an EYEBALL in the square, the 
content of that particular LAYER is VISIBLE. Conversely, 
when the square is empty (no EYEBALL), the content 

of that particular LAYER is INVISIBLE. CLICK the MOUSE in the square 
containing an EYEBALL and the EYEBALL disappears, rendering the 
LAYER INVISIBLE. CLICK the MOUSE in the square of INVISIBLE LAYER, 
an EYEBALL reappears and the LAYER is again VISIBLE.
Immediately to the right of the EYEBALL squares is another stack of 
tiny squares [Figure 2-c: 6d]. In our example, the middle one of these 
contains a tiny PADLOCK ICON. This LOCKS the LAYER. You cannot 
work on a LOCKED LAYER. Your CURSOR becomes a tiny pencil with 
the international “NO” slash through it. CLICKING in this square on a 
UNLOCKED LAYER LOCKS the LAYER. CLICKING on the PADLOCK ICON of 
a LOCKED LAYER UNLOCKS it.
Next to each LOCK BOX ICON is a bar of color [Figure 2-c: 6e]. This is the 
LAYER SELECTION COLOR, the HANDLES and BOUNDING BOXES of any 
SELECTED OBJECTS on this LAYER will use this color. We will go into 

more detail on this when we look at the LAYER OPTIONS DIALOG.
Beside the LAYER SELECTION COLOR BAR you will see first a small gray 
triangle, then a small square with either color and/or an image in it, 
and a name [Figure 2-c: 6f]. The little triangle, when CLICKED, rotates 
down to display the “SUB-LAYERS” of the given LAYER, but that’s all 
we’ll say about it for now. The small square is the LAYER THUMBNAIL 
and shows a tiny preview image of the LAYER contents. By DEFAULT, 
Illustrator numbers its LAYERS as they are made. When we discuss the 
LAYERS OPTIONS DIALOG, we will describe how you can re-name your 
LAYERS to make them less confusing.
At the far right of the PANEL are two under-used and highly useful 
little ICONS (although in the example only the little circle shows on 
two of the three LAYERS). The circle is called the TARGET [Figure 2-c: 6g]

and is also sometimes called THE MEATBALL. Either name is fine but 
TARGET is a bit more dignified, don’t you think? In the example, the top 
TARGET’S outline is double. This means that the content of this LAYER 
is SELECTED. The best part about the TARGET is this: when you CLICK 
the TARGET, it changes from a single outline (un-selected) to a double 
outline, indicating that the LAYER’S content has been SELECTED, all 
from the LAYERS PANEL. On the top LAYER of the example, just to the 
right of the TARGET, you see a tiny colored square [Figure 2-c: 6h]. Its 
color is the same as the LAYER SELECTION COLOR BAR color. It indicates 
that there are SELECTED OBJECTS on that layer.
Figures 2-c: i and 2-c: j show the MAKE/RELEASE CLIPPING MASK and 
the CREATE NEW SUBLAYER ICONS respectively. They are powerful, 
complicated, and a little tricky, so we’ll consider them later. 
Figure 2-c: k is the CREATE NEW LAYER ICON. CLICK on this and Illustrator 
adds a new LAYER immediately above the current ACTIVE LAYER (the 
LAYER with the highlight color — usually pale blue). The new LAYER is 
seductively named “LAYER” followed by the next consecutive number in 
the series. You can also CLICK and DRAG an existing LAYER onto to the 
CREATE NEW LAYER ICON and the LAYER will be DUPLICATED. This is a 
great help when creating multi-part images that need the different parts 
to line up exactly. 
Figures 2-c: l is the DELETE SELECTION ICON. You can CLICK and DRAG a 
LAYER over this ICON to DELETE it. Or, you can CLICK a LAYER to SELECT 
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it and then CLICK this ICON. If the LAYER is empty, it 
will be deleted. If it contains any OBJECTS, a WARNING 
DIALOG OPENS [Figure 2-c: 7] asking if you really want 
to delete your artwork. If you want to, CLICK “YES,” if 
not, CLICK “NO.”
Last is the “EXPANSION” area, already familiar from the 

COLOR and SWATCHES PANELS [Figure 2-c: 6m — previous page]. CLICK 
and Drag here to resize the LAYERS PANEL if you so desire.

Using the LAYERS PANEL
You’ve already learned that the LAYERS PANEL allows you lock and 
unlock LAYERS and to make LAYERS visible or invisible. We mentioned 
CLICKING the TARGET to SELECT all the OBJECTS on a given LAYER and 
DRAGGING a LAYER over the CREATE NEW LAYER ICON to copy that 
LAYER.  
Equally, if not more importantly, the LAYERS PANEL allows you to 
manage the imagery on your document in numerous other ways. Later 
in the course, when we discuss the many OPTIONS on the OPTIONS  MENU 
FLY-OUT, you will learn many of these advanced tools and commands. 
For now, we will concentrate on three techniques: STACKING ORDER, 
NAMING, and SELECTION COLOR management. 
STACKING ORDER
By far the most important of these three techniques, STACKING ORDER 
is also the most complicated and least intuitive. When you “DRAW” 
OBJECTS in Illustrator, the program makes “STACKS” of these 
POSTSCRIPT CODE OBJECTS with the most recently made being at the 
top of the STACK. You may have noticed this when you were creating 
the Black and White Compositions in Chapter 1, especially if you had 
the LAYERS PANEL open.
To explain further, look at Figure 2-c: 8. A RED SQUARE overlays a 
PURPLE CIRCLE which overlays an ORANGE HEXAGON on the square 
ARTBOARD. On the LAYERS PANEL, “Layer 4” has an ORANGE HEXAGON 
in the square of its THUMBNAIL at the bottom of the column of LAYERS. 
“Layer 5” has a PURPLE CIRCLE in the square of its THUMBNAIL in 
the middle of the column and in “Layer 6” the THUMBNAIL is a RED 
SQUARE. The OBJECT on the top of the LAYER STACK is also the OBJECT 

that “overlays” all the other 
OBJECTS in the image; i.e. the 
TOP LAYER in the STACK is in FRONT of of all the other image OBJECTS 
in the picture. Now, CLICK and DRAG “Layer 6” to the bottom of the 

STACK and RELEASE the MOUSE [Figure 2-c: 9]. CLICKING and DRAGGING 
has changed the positions of the LAYERS in the STACK, and it has 
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also change the arrangement 
of the OBJECTS on the 
document [Figure 2-c: 10]. The 
RED SQUARE is now behind 
the other two OBJECTS. Now, 
CLICK and DRAG “Layer 5” 
to the middle of the STACK 
[Figure 2-c: 11]. Now the 
ORANGE HEXAGON is the TOP 
LAYER, and it also OVERLAYS 
the two other OBJECTS on 
the ART BOARD; the PURPLE 
CIRCLE has moved between the 
ORANGE HEXAGON and the RED 
SQUARE, which has remained 
at the back [Figure 2-c: 12]. 
By rearranging the STACKING 
ORDER of the LAYERS on the 
LAYERS PANEL, we created 
three separate compositions 
from a set of three Illustrator 

OBJECTS.

NAMING LAYERS
On simple Illustrator 
documents with 
just a few LAYERS 
comprised of large, 
easily differentiated, 
OBJECTS, the NAMES 

of the LAYERS are not critical. But, as you continue with Illustrator, 
documents with tens, or even hundreds, of LAYERS and thousands 
of SUB-LAYERS won’t be uncommon. Don’t let that scare you. Just 
NAME the LAYERS as you make them. It is a good habit to get into 
even on simple files. We will start with our brightly colored example 
above [Figure 2-c: 12] by DOUBLE-CLICKING on “Layer 4” [Figure 2-c: 13] 

to open the LAYER OPTIONS DIALOG 
BOX [Figure 2-c: 14]. The NAME FIELD 
opens, by DEFAULT, highlighted. 
This means that all you need to do to 
change the LAYER NAME is to start 
typing the name you prefer. Let’s 
call this LAYER “Orange Hexagon.”  
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If you are happy with the current, BLUE SELECTION 
COLOR do nothing else. Just CLICK “OK” and you will 
leave the LAYER OPTIONS DIALOG BOX and return 
to your document. Notice that the top LAYER, the 
previous ”Layer 4,” is now named “Orange Hexagon” 
[Figure 2-c: 15].
Here, let’s make a couple of brief remarks about the 
rest of the LAYER OPTIONS DIALOG BOX. We will discuss 
the COLOR POP-DOWN in the section immediately 
following, so hang tight. While we will leave the six 

radio buttons as is for now, here are brief descriptions of what they are 
do and how they are used. 
 1. Checking TEMPLATE converts the LAYER into an Illustrator 

TEMPLATE LAYER. TEMPLATE LAYERS serve very specific purposes, 
especially when you are TRACING a PLACED photograph or graphics 
file. Note: TEMPLATE LAYERS do not print, nor will they be visible 
when saved as PDF files.

 2. The SHOW button works like CLICKING the EYEBALL on the LAYERS 
PANEL. By DEFAULT it is CHECKED, meaning that the LAYER is 
visible. If you UN-CHECK it, the LAYER will be invisible. 

 3. The PREVIEW button allows you to see the LAYER in PREVIEW or 
OUTLINE VIEW. By DEFAULT, PREVIEW is CHECKED. We will discuss 
PREVIEW and OUTLINE VIEWS when we look at the VIEW MENU.

 4. The LOCK button works the same as the LOCK SQUARE ICON on the 
LAYERS PANEL. By DEFAULT, LOCK is UN-CHECKED.

 5. The PRINT button, quite reasonably, controls whether the LAYER 
can be PRINTED or not. By DEFAULT, PRINT is CHECKED. Note: the 
PRINT BUTTON, like the TEMPLATE BUTTON, also controls saving 
images as PDF files.

 6. The DIM IMAGES button serves a very specific purpose, and is 
used when you are TRACING a PLACED photograph or graphics file. 
By DEFAULT, PREVIEW is UN-CHECKED. When it is CHECKED, the 
small TEXT FIELD to its right becomes ACTIVE and you can enter 
a percentage, or leave the DEFAULT 50%. Also, when CHECKED and 
you CLICK “OK” to return to the file, any graphic on that LAYER will 
be transparent to the percentage set in the TEXT FIELD.  

LAYER SELECTION COLOR POP-DOWN
This aspect of the LAYERS PANEL is the one area most open to personal 
preference. You are free to make the LAYER SELECTION COLOR whatever 
you want for any reason you want. You may wish to set up a color 
hierarchy, some kind of palette mnemonic, or even some arcane 

metaphysical color order for 
your files. Feel free.
There is, however, at least one 
situation where control of this 
color has practical value. If the 
LAYER you are working on has 
been assigned (or you have 
chosen) the YELLOW SELECTION 
COLOR and you are working 
on a YELLOW or very light 
colored OBJECT, seeing the 

CONTROL POINTS, PATH LINES, and BOUNDING BOXES can be difficult 
to impossible [Figure 2-c: 16]. This makes it difficult to work with 
these OBJECTS. TO remedy this, DOUBLE-CLICK the problem LAYER to 
open its LAYER OPTIONS DIALOG BOX. CLICK and HOLD on the COLOR 
POP-DOWN to display the SELECTION COLOR MENU and choose a more 
easily visible SELECTION COLOR. When you CLICK ”OK,” the CONTROL 
POINTS, HANDLES, and BOUNDING BOX will be the newly chosen color 
and much easier to see [Figure 2-c: 17].
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Create six, color bar compositions based on six “themes”

In the first exercise, we created six ”compositions” consisting 
of black and white rectangles, squares, ellipses, and circles. For 
this second exercise, you will create six compositions composed 
of either horizontal or vertical rectangles or “bars.” This time, 
however, each composition will be on a different LAYER of a 
single document.
To start with, CREATE ONE NEW DOCUMENT named “(your last 
name)-(your class or your class and section)-ex2.ai”. Give it these 
specifications: [Figure 2-c: 18].
(1) 6” X 6”.
(2) inches.
(3) CMYK.
 (4) 300 ppi.
 (5) Preview = default.
Create a FRAME LAYER on this NEW DOCUMENT just as you did 

in Exercise 1. Instead of ONE CONTENT 
LAYER below the FRAME LAYER, create 
SIX CONTENT LAYERS below the FRAME 
LAYER. You will once again need some 
kind of concept to structure your thinking 
when you make these compositions. This 
time, however, let these concepts, words, 
or emotions develop as you create colors. 
Spend the majority of your time at the 
beginning just trying out possible CMYK 
color formulae. When a trio, quartet, or 

quintet of color begins to be “expressive” of a concept or feeling, 
push the concept and adjust the colors accordingly. For the last 
part of your work, study your near finished composition and try out 
some very subtle changes to the colors. Sometimes, a one or two 
percent difference in the CMYK formula will make a big difference 
in the way two colors interact. 
Just as in previous exercise, concepts that are simple, or terse tend 
to be the easiest to “illustrate.” But bear this in mind; bright, 

full strength, pure colors tend to have the least subtlety. Often, 
the most expressive color combinations involve close value, grayed, 
pastel, or darkened colors.
Finally, once your composition is final, add its colors to the 
SWATCHES PANEL, if you have not done so already. And, don’t 
forget to save often.
The tools you will use are:
(1) the RECTANGLE TOOL.
(2) the ZOOM and HAND TOOLS to navigate around your OBJECTS and 

the ART BOARD and PASTE BOARD.
(3) the LAYER PANEL and the LAYER OPTIONS DIALOG BOX.
(4) the SWATCHES PANEL and, possibly, the NEW SWATCH DIALOG 

BOX.
Make sure you create a New Layer for each color composition. 
You can hold off naming each LAYER until you have come up 
with a concept for its composition. It is also a good idea to turn 
off the visibility of the LAYERS you are not working on. You may 
even want to LOCK them so that you don’t inadvertently add part 
of a different composition to the wrong LAYER.

NOTE:
CREATE SIX, COLOR COMPOSITIONS composed of either HORIZONTAL 
or VERTICAL BARS.
DO NOT MIX HORIZONTALS and VERTICALS
CREATE TWO COMPOSITIONS with THREE COLORS EACH
CREATE TWO COMPOSITIONS with FOUR COLORS EACH
CREATE TWO COMPOSITIONS with FIVE COLORS EACH

When a LAYER has more 
than one OBJECT (and 
often when it only has 
one OBJECT) you will see 
the little GRAY TRIANGLE 
pointing right toward 
the THUMBNAIL of the 
LAYER. CLICK on this 
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little TRIANGLE [Figure 2-c: 19]and the LAYER “opens” 
to reveal its SUB-LAYERS, each one given the rather 
uninspiring name of “<path>”.  
Renaming these SUB-LAYERS is the same as 

NAMING LAYERS. DOUBLE CLICK the SUB-LAYER of your choice 
[Figure 2-c: 20]. The sub-layer OPTIONS DIALOG BOX, much simpler 
than the LAYER OPTIONS BOX, opens. Type the NAME for the 
SUB-LAYER, then CLICK “OK” [Figure 2-c: 21].

Examples:
On this page and the three pages that follow are 21 examples of this 
exercise, done by students in the DSGD83 class at San Jose State 
University. Use these examples to help generate your own ideas. 

 Exercise 2: Color Bar Compositions
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A powerful tool for outlining OBJECTS

Up to this point, we haven’t paid much attention to the STRIKE of 
OBJECTS. Unless you used the DEFAULT 1 point STROKE in the first 
exercise, you have probably not used the STROKE command at all. For 
that matter, the COLOR COMPOSITIONS in exercise two should not have 
had STROKES.
So, before we go any farther, we had better take a good, long look 
at STROKES: what they are, how they work, how you can use them. 
Technically, the STROKE is a PREVIEW OBJECT. That means that it is a 
POSTSCRIPT OBJECT that exists only after the OBJECT is RASTERIZED 
(made visible on a RASTER GRID, like your monitor, output from an 
image setter or direct plate setter). The POSTSCRIPT CODE for the 
STROKE places an OUTLINE of variable width, color, continuity, and 
placement around OBJECTS that the user creates with Illustrator’s 
DRAWING TOOLS. While this doesn’t sound particularly intuitive, in 
visual practice it is fairly easy to grasp.

The STROKE ICON and the STROKE PANEL
First let’s look at the STROKE ICON and/or STROKE PANEL. 
Technically, the STROKE is a PREVIEW OBJECT. That means that 
it is a POSTSCRIPT OBJECT that exists only after the OBJECT 
is RASTERIZED (made visible on a RASTER GRID, like your 
monitor, output from an image setter or direct plate setter). 
The POSTSCRIPT CODE for the STROKE places an OUTLINE of 
variable width, color, continuity, and placement around 
OBJECTS that the user creates with Illustrator’s DRAWING 
TOOLS. While this doesn’t sound particularly intuitive, in 
visual practice it is fairly easy to grasp.
The first step is to open the STROKE PANEL. If you are in the 
BASIC WORKSPACE, CLICK the sixth DOCK ICON from the top 
[Figure 3-c: 1] (it shows horizontal lines). If you are in the 
PANEL WORKSPACE, the STROKE PANEL is immediately below the 
SWATCHES PANEL [Figure 3-c: 2], and in the TYPE WORKSPACE 
it is immediately above the LAYERS PANEL [Figure 3-c: 3].

Next, you need to open the PANE’S full OPTIONS as shown in 
Figures 4a, b, & c. If your STROKE PANEL open in MINIMAL form, either 
open the full PANEL using SHOW OPTIONS as above or just DOUBLE-CLICK 
in the GRAY BAR above the tabs [Figure 3-c: 5]. Unless you are working 
on a very small screen, it is convenient to have the STROKE PANEL, in 
any of its forms, open and easily available when you are creating and 
editing OBJECTS.

Using the STROKE PANEL: Weight, Miter, End Caps, Joins, Alignment
Let’s look at the STROKE 
PANEL, fully open, in detail 
[Figure 3-c: 6].
 a. WEIGHT: the number in this 

field, along with the unit 
type, determines the width 
of the SELECTED OBJECT’S 
STROKE. It is usualy set in 

 Strokes: The Strokes Panel
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 Strokes: The Strokes Panel

POINTS, the standard unit of measurement for Printing 
in the United States and Britain, although Illustrator 
allows inches, millimeters, centimeters, and PIXELS. 
Unless you are doing WEB work, when PIXELS are the 
preferred unit (more on this in a later section), come to 
terms with POINTS. 
Examples: a .3 pt HAIRLINE [Figure  3-a:  7a], a 1 pt 
LINE [Figure 3-a: 7b], a 6 pt LINE [Figure 3-a: 7c]. 
Here are starting rules of thumb. 1 POINT (pt) is a thin outline. 
“.3 pt” is the smallest “HAIRLINE” that will print safely. 
Above “3 pt” you can usually trust the screen preview 
(more on this in a later section). 

 b. MITER LIMIT determines the extension of the sharp 
corners of an acute angle; the higher the number, 
the greater the extension. More on this later. 

 c. END CAP: determines how the STROKE terminates on 
OPEN PATHS. 

 d. JOIN determines how the STROKES from two sides of 
an OBJECT meet at a corner. 

 e. ALIGN STROKE: determines whether the WIDTH of the 
STROKE extends equally in and out from the middle 
of the PATH, the full WIDTH is only inside the PATH, 
the full WIDTH is only outside the PATH. 

 f. DASHED LINE CHECK BOX: turns DASHED LINE 
OPTION on and off. When CHECKED, the DASH and 
GAP TEXT ENTRY FIELDS are ACTIVE 

 g. DASH and GAP TEXT ENTRY FIELDS: allow you to set 
the length (usually in POINTS) of DASHES and GAPS 
for a BROKEN LINE STROKE.

Figure  3-c:  8 shows the three END CAP OPTIONS and the THREE JOIN 
OPTIONS. Figure 3-c: 8a is the BUTT CAP. Figure 3-a: 8b is the ROUND CAP.  
Figure 3-a: 8c is the PROJECTING CAP. Figure 3-a: 8d is the MITER JOIN. 
Figure 3-a: 8e is the ROUND JOIN.  Figure 3-a: 8f is the BEVEL JOIN. 
Figure  3-a:  9a the ALIGN STROKE TO CENTER OPTION, centering the 
STROKE equally either side of the PATH. This is the STROKE ALIGNMENT 
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  Strokes: The Strokes Panel

DEFAULT. 
Figure  3-a:  9b the ALIGN 
STROKE TO INSIDE OPTION, 
placing the entire STROKE 
inside of the PATH.
Figure  3-a:  9c the ALIGN 
STROKE TO OUTSIDE OPTION, 
placing the entire STROKE 
outside of the PATH.
Notice where the BOUNDING 
BOX lines up in these 
examples and that the 
interior area of the OBJECT, 
out old friend the FILL 
changes depending on the 
STROKE ALIGNMENT. You 
may “mix and match” END 
CAPS, JOINS, and STROKE 
ALIGNMENTS. The only 
limitation on using the 

STROKE ALIGNMENT settings occurs when you are using the TYPE TOOL to 
create TYPE OBJECTS. These are limited to the ALIGN ON CENTER OPTION. 

Using the STROKE PANEL to create BROKEN LINES
There are many times when you need to create a broken or “DASHED LINE” 
with Illustrator; especially true when working with MAPS and DIAGRAMS. 
Illustrator allows for the creation of fairly complex “DASHED” patterns 
that can have three separate lengths each for the “DASHES” and the 
“GAPS” between “DASHES.”
To create a “DASHED” STROKE, CLICK on the DASHED LINE CHECK BOX 
[Figure 3-a: 10a]. The BOX becomes ACTIVE as do the TEXT ENTRY FIELDS 
for “DASHES” and “GAPS,” opening with a simple, DEFAULT “6 pt.” by 
“6  pt.” pattern [Figure  3-a:  10b] which creates an evenly “DASHED” 
outline around a rectangular OBJECT [Figure 3-a: 10c]. 
As you can see, there are six TEXT ENTRY FIELDS, three each for DASHES 
and GAPS. This allows you to create complex patterns of dashes on any 

OBJECT that requires such treatment. Shown 
below are  just a few examples of the possible 
patterns that can be made, along with the 
settings that make them [Figure 3-a: 11]. 
Note: a “0 pt.” DASH with a ROUND END CAP 
gives ROUND DOTS with the diameter of the 
STROKE size.
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Create four compositions using different strokes
In this exercise, we will create four ”compositions” consisting 
of rectangles, squares, ellipses, circles, and the parts of these 
shapes. The shapes can be filled with COLOR or with BLACK or 
WHITE. More important is the versatility and creativity you bring 
to adding STROKES to these open and closed PATHS.
You may wish to start with one or more of the compositions 
you created for exercise 1. Use the DIRECT SELECTION to SELECT 
individual parts of the SHAPES created with the SHAPE TOOLS. 
Experiment with THICK and THIN STROKES (higher or lower 
numbers in the “WEIGHT” text entry field of the STROKE PANEL), 
STROKES with BUTT, ROUND, and PROJECTING CAPS and MITER, 
ROUND, and BEVELED JOINS, STROKES INSIDE, OUTSIDE, and on 
the OBJECT’S bounding shape, as well DASHED LINES of different 
types. Remember to use the LAYERS PANEL to organize the 
structure of these compositions. 
The tools you will use are:
(1) the SELECTION TOOL to select, move, manipulate, and “copy-drag” 

OBJECTS.
(2) the DIRECT SELECTION TOOL to select, move, select, delete, or 

manipulate parts of OBJECTS.
 (3) the GROUP SELECTION TOOL to select, move, manipulate and 

“copy-drag” OBJECTS.
 (4) the ZOOM and HAND TOOLS to navigate around your OBJECTS and 

the ART BOARD and PASTE BOARD.
 (5) the RECTANGLE and ELLIPSE TOOLS to create OBJECTS, specifically 

RECTANGLES, SQUARES, ELLIPSES, and CIRCLES.
 (6) The COPY and CUT commands along with the PASTE, PASTE IN 

FRONT, and PASTE IN BACK commands
 (7) Artistic awareness of POSITIVE/NEGATIVE SPACE, made more subtly 

difficult by the “implied spaces” of color.
 (8) The imaginative ability to see how to build complex shapes from 

rectangles, squares, ellipses, and circles and the imaginative ability 
to see how to “subtract” areas of shapes by using other shapes of 
the opposite color as we did in exercise 1.

 

Exercise 3, example  -  Liu/Berendt

This time, make each composition 
a SEPARATE LAYER or GROUP of 
LAYERS on the same DOCUMENT. 
Again, the new document size 
should be 6 inches by 6 inchesand 
you should create a FRAME LAYER 
at the top of the LAYER STACK. If 
the Units are not set to INCHES, 
use the Units POPDOWN to change 
them. Since your document is a 
square, ignore the ORIENTATION 
ICONS. 
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  The GRID TOOLS

Two Powerful Tools for creating GRIDS

There are many methods for creating GRIDS in Illustrator, some more and 
some less precise, complicated, and versatile. But none are quicker or 
easier that using the two GRID TOOLS: the RECTANGULAR and the POLAR 

GRID TOOL. They can be found “NESTED” at the bottom of 
the LINE SEGMENT TOOL FLY-OUT MENU [Figure 3-b: 1] and 
[Figure 3-b: 2]. 

The Rectangular Grid Tool
First we will look at the RECTANGULAR GRID TOOL. Once 
you SELECT this tool, you can CLICK and DRAG out a 
GRID with it, just as you did with the RECTANGLE TOOL 
[Figure 3-b: 3]. Also, and again just as with the RECTANGLE 

TOOL, if you HOLD DOWN the OPTION KEY (Mac) or ALT KEY (PC) 
and then CLICK and DRAG with the RECTANGULAR GRID TOOL, you 
will create a RECTANGULAR GRID centered on the POINT on the ART 
BOARD where you CLICKED [Figure 3-b: 4].
Finally, and once again just as with the RECTANGLE TOOL, if you 

HOLD DOWN the SHIFT KEY along with the OPTION KEY 
(Mac) or ALT KEY (PC) and then CLICK and DRAG with the 
RECTANGULAR GRID TOOL, you will create a SQUARE GRID 
centered on the POINT on the ART BOARD where you CLICKED 
[Figure 3-b: 5].
The DEFAULT RECTANGULAR GRID is set to FIVE HORIZONTAL 
and FIVE VERTICAL DIVISIONS, creating a grid six units wide 
and six units tall. While this certainly creates a nice, very 

grid-like grid, both RECTANGULAR and SQUARE, it is somewhat limited. As 
the Ancient Sage of Brooklyn says, “Limits? Schlimits! Who needs ‘em?” Of 
course there is an easy way, two easy ways in fact, to specify a different 
set of divisions. Instead of CLICKING and DRAGGING to create the GRID, 
just CLICK on the ART BOARD and the RECTANGULAR GRID TOOL OPTIONS 
DIALOG BOX will open. Or, just DOUBLE-CLICK on the RECTANGULAR GRID 
TOOL itself on the TOOL BAR. Once again, the RECTANGULAR GRID TOOL 
OPTIONS DIALOG BOX will open [Figure 3-b: 6 - next page]. 
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 The GRID TOOLS: the Rectangular Grid Tool Dialog Box

This DIALOG BOX offers a number of tools that 
allow you to create highly customized grids. 
First, look at the DEFAULT SIZE text entry field 
[Figure 3-b: 6a]. As is the standard in the graphics 
arts world, WIDTH precedes HEIGHT (the Ancient 
Sage of Brooklyn always walks into the room ahead 
of Michael Jordan). Whatever size GRID had been 
previously specified will continue as the DEFAULT  
in whichever unit of measurement you had specified 
when setting up your new document will be in 
place in these text fields. However, you can specify 
the WIDTH and HEIGHT using any measurement 
system Illustrator supports: inches (“in” or “), 
picas (numeral + “p” + numeral for points — i.e. 
“1p3”), points (numeral+ pt), centimeters (“cm”), 
millimeters (“mm”), or pixels (“px”) and Illustrator 

will convert your input to the current DEFAULT MEASUREMENT SYSTEM 
on the fly. 
In the upper right hand corner of the DEFAULT SIZE box you will see 
a small square ICON with one BLACK CORNER SQUARE and three WHITE 
CORNER SQUARES [Figure  3-b:  6b]. The BLACK SQUARE represents the 
“origin point” for your GRID. In other words, you GRID will be drawn out 
in the dimensions specified, using the point at which you CLICKED as that 
“origin point.” For example, the “origin point” default is the UPPER LEFT. 
If you do not change the “origin point,” the point you CLICKED will be 
the UPPER LEFT CORNER of the GRID. If you do change the “origin point” 
to the LOWER RIGHT, the GRID will now use the point you CLICKED as the 
GRID’s LOWER RIGHT CORNER. 
Note, however, if you HOLD DOWN the OPTION (Mac) or ALT (PC) KEY when 
you CLICK with the RECTANGULAR GRID TOOL, the point you CLICK will be the 
CENTER POINT of your GRID. Changing the “origin point” will have no effect. 
The HORIZONTAL DIVIDERS BOX [Figure 3-b: 6c] let’s you set the number 
of top to bottom divisions of the GRID. Note, both here and in the 
VERTICAL DIVIDERS BOX, these are internal divisions only, and do not 
count the sides of the grid. For example, a GRID with 5 horizontal and 
5 vertical divisions will be a grid with six rows and six columns, a GRID 

with 7 horizontal and 4 vertical divisions will be a grid with eight rows 
and five columns.
The HORIZONTAL DIVIDERS SKEW SLIDER [Figure 3-b: 6d] actually changes 
the sizes of the rows as they move vertically. Negative numbers on the 
SLIDER will make the rows start small at the top and get larger as they move 
to the bottom. Positive numbers on the SLIDER do the reverse. Numbers 
over about 60 make the small rows extremely tiny. Numbers above 100 put 
most of the size of the GRID into the largest row [Figure 3-b: 7].

The VERTICAL DIVIDERS BOX [Figure 3-b: 6e] let’s you set the number of 
side to side divisions of the GRID. It works on your GRID’S COLUMNS just 
as the HORIZONTAL DIVIDERS BOX works on ROWS. 
The VERTICAL DIVIDERS SKEW SLIDER [Figure 3-b: 6f] actually changes 
the sizes of the columns as they move vertically. Negative numbers on the 
SLIDER will start with small left hand columns getting larger as they move 
to the right. the sizes of the columns as they move vertically. Positive 
numbers on the SLIDER will start with large left hand columns getting 
smaller as they move to the left [Figure 3-b: 8 — next page].
The USE OUTSIDE RECTANGLE AS FRAME CHECK BOX is CHECKED by 
DEFAULT [Figure 3-b: 6g]. This CHECK BOX introduces one of the more 
interesting aspects of Illustrator GRIDS. The GRIDS you create are Illustrator 
OBJECTS, very similar to the RECTANGLES and ELLIPSES you have already 
created. CLICK on them with the SELECTION TOOL, and you SELECT the 
entire GRID. However, the GRID is actually a GROUP of OBJECTS, none of 
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 The GRID TOOLS: the Rectangular Grid Tool Dialog Box, editing Grids 

which are RECTANGLES. That is, unless you CHECK the little 
USE OUTSIDE RECTANGLE AS FRAME BOX. Then, the boundary 
rectangle of your GRID is indeed a RECTANGLE (or SQUARE). 
The remaining parts of the GRID, are individual OPEN PATHS, 
usually STROKED. If you wish to remove one or more “SIDES” 
of you GRID, UNCHECK this BOX. This changes the BOUNDING 
RECTANGLE to four separate PATHS. Then, a simple CLICK with 
the GROUP SELECTION TOOL will allow you to SELECT and 
DELETE just one side of the GRID [Figure 3-b: 9].
If you do leave the USE OUTSIDE RECTANGLE AS FRAME BOX 
CHECKED, and you have a FILL COLOR selected, you can CHECK 
the FILL GRID BOX [Figure 3-b: 6g — previous page]. When 
you CLICK “OK,” your grid will be filled with the FILL COLOR 
[Figure 3-b: 10]. But take careful note here. The only OBJECT 
that was filled in this case was the bounding RECTANGLE. 

Each of the  other lines in the 
GRID remains a single, OPEN 
PATH. If you do not CHECK 
the USE OUTSIDE RECTANGLE 
AS FRAME BOX, your GRID 
will not be FILLED even if you 
have selected a FILL COLOR. 
Also note, if you have no FILL 
selected, your GRID will not be 
FILLED, even if you CHECK the 
FILL GRID BOX.
If you had CHECKED the USE 
OUTSIDE RECTANGLE AS FRAME 

BOX, but had no FILL selected, you can FILL the BOUNDING RECTANGLE 
after the fact by SELECTING it with the GROUP SELECTION or DIRECT 
SELECTION TOOL, making the FILL ICON on the COLOR PANEL or the 
bottom of the TOOL BAR ACTIVE, and creating a color on the COLOR PANEL 
or CLICKING a color on the SWATCHES PANEL.

Editing the Grid with the Selection Tools
As has already been mentioned a few times, each RECTANGULAR GRID is 
made up of intersecting, single, OPEN PATHS surrounded by a RECTANGULAR 
FRAME consisting of either (a) a RECTANGLE or (b) four, single, OPEN PATHS 
forming a RECTANGLE. This means that, if the RECTANGULAR FRAME is a 
RECTANGLE, it can be edited like any other RECTANGLE: it can be FILLED 
or not, STROKED or not, and the STROKE can be edited in all the ways 
possible for STROKES. It also means that all the single OPEN PATHS can be 
edited the way PATHS are edited: made longer or shorter, moved in, out, 
or over, have their STROKES adjusted, be deleted. Yes, and while you can 
FILL an OPEN PATH , a straight OPEN PATH has no area, so there is nowhere 
for the FILL to go.
It has also been stated that the GRID is a GROUPED OBJECT. When you 
CLICK it with the SELECTION TOOL, you SELECT the entire GRID OBJECT 
[Figures  3-b:  11c — next page]. If you increase or decrease the 
STROKE size, al the lines in the GRID will be affected. If you FILL it, a 
FILL will be attached to each of the PATHS making up the GRID, but 
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 The GRID TOOLS: editing Grids 

will only show on the boundary RECTANGLE. It will have a 
BOUNDING BOX and that can be ROTATED and SCALED just as 
you would with a RECTANGLE, SQUARE, ELLIPSE, or CIRCLE 
[Figures 1-g: ii through vii in Chapter 1].
If, however, you CLICK on the DIRECT SELECTION TOOL (or TYPE: 
“a”), you can ACTIVATE the individual PATHS and SELECT their 
middle PATHS or their END POINTS [Figure 3-b: 11a]. If you 
enable the GROUP SELECTION TOOL by holding down the OPTION 
(Mac) or ALT (PC) KEY with the DIRECT SELECTION TOOL, a single 
CLICK will completely SELECT a single PATH [Figure 3-b: 11b] 
or the whole bounding RECTANGLE. A DOUBLE-CLICK will 
select the entire GRID OBJECT [Figure 3-b: 11c].
This also means that you can SHIFT CLICK with the DIRECT 
SELECTION TOOL to SELECT a number of single END POINTS 
of PATHS, then make major edits or distortions of the GRID 
[Figure 3-b: 12].
Lastly, you can remove the BOUNDARY RECTANGLE, whether a 
single OBJECT or four separate PATHS from the GRID. You are 
left with a GRID without a frame [Figure  3-b:  13a], a GRID 
with its own, rather expressive personality and possibilities 
[Figure 3-b: 13b]. This, of course, will remove any FILL that you 
have applied, since the FILL only fills the area surrounded by the 
BOUNDARY RECTANGLE. 

The Polar Grid Tool
The POLAR GRID TOOL operates similarly to the RECTANGULAR GRID 
TOOL,  except, of course, in that it creates a GRID of CONCENTRIC CIRCLES 
(Concentric Dividers) and RADII (Radial Dividers). This leads to some rather 
different attributes. First, while the number of CONCENTRIC DIVIDERS 
continues to be ONE LESS than the NUMBER of CONCENTRIC CIRCLE GRID 
UNITS (i.e. 5 dividers gives 6 concentric circles), the number of RADIAL 
DIVIDERS gives the same number of RADIAL DIVISIONS (i.e. 5 Radial 
Dividers give 5 Radial Wedges around the POLAR GRID) [Figure 3-b: 14]. 
Second, while the RADIAL DIVIDERS are single, OPEN PATHS just as they 
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are on the RECTANGULAR GRID, the CONCENTRIC DIVIDERS 
create SEPARATE, CLOSED CIRCLE or ELLIPSE OBJECTS. 
As such, each can be FILLED separately with any fill 
you choose. The OUTER CIRCLE or ELLIPSE is the lowest 
on the LAYER STACKING ORDER. As you proceed toward 
the center, each of the next CIRCLES or ELLIPSES is one 
SUB-LAYER HIGHER in the SUB-LAYER STACK. This also 
means that your fills, as in the case of a multi-colored 
target, proceed from the OUTSIDE IN [Figure 3-b: 15]. 
At the bottom of the POLAR GRID OPTIONS DIALOG BOX, 
there are two CHECK BOXES, just as there are on the 
POLAR GRID OPTIONS DIALOG BOX. However, the USE 
OUTSIDE RECTANGLE AS FRAME CHECK BOX is replaced 
by the CREATE COMPOUND PATH FROM ELLIPSES CHECK 
BOX. It’s a bit too early to get deeply involved Illustrator’s 
COMPOUND PATH functions at this point. For now, think 
of COMPOUND PATHS as Illustrator OBJECTS with HOLES 
made in them by other Illustrator OBJECTS. When you 
CHECK the CREATE COMPOUND PATH FROM ELLIPSES CHECK 
BOX, Illustrator causes every other CIRCLE or ELLIPSE on 
a POLAR GRID, from the outside in, to become part of 
a single OBJECT. All the alternate CIRCLES or ELLIPSES, 
starting with the first one in from the outside, are HOLES. 
This becomes easy to see if you also CHECK the FILL GRID 
CHECK BOX [Figure 3-b: 16].

The RADIAL DIVIDERS on a POLAR GRID, as has already been stated, are 
single, OPEN PATHS. If you CLICK on one of them with the DIRECT or 
GROUP SELECTION TOOL, you can edit it as you wish. In the example 
here, the selected path has been increased to an eight point stroke 
[Figure 3-b: 17]. We cold just as easily have moved one or both of its END 
POINTS, or removed the PATH completely.
Figure 3-b: 18 Shows the workings of the CONCENTRIC DIVIDERS SKEW 
SLIDERS for the POLAR GRID OPTIONS DIALOG BOX. Negative numbers 
cause the CONCENTRIC CIRCLES to get smaller as they move in to the 
center. Positive numbers cause them to start small at the outer edge 
and get larger as they move in. As with the HORIZONTAL and VERTICAL 
DIVIDERS SKEW SLIDERS on the RECTANGULAR GRID OPTIONS DIALOG 
BOX, number over one hundred in either direction make the changes on 
the DIVIDERS almost useless, unless the “real world,” OUTPUT size of your 
file is enormous.
The RADIAL DIVIDERS SKEW SLIDERS, on the other hand, work a bit 
differently. Moving to the left, the negative numbers, have the RADIAL 
DIVIDERS get smaller as they move CLOCKWISE, starting with the VERTICAL 
RADIAL DIVIDER centered at the bottom of the POLAR GRID. When you 
move the SLIDERS to the right, into the positive numbers, the RADIAL 
DIVIDERS get smaller as they move COUNTER-CLOCKWISE (or, as the Brits 
say, anti-clockwise), starting with the VERTICAL RADIAL DIVIDER centered 
at the bottom of the POLAR GRID [Figure 3-b: 19].
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In the Introduction to this book, brief mention is made about the difference 
between vector and raster (or bit map) graphic programs. What was not 
mentioned was that there must be a raster “image” of even the purest 
vector object for it to be seen on the computer screen: the vector object 
is defined only by the letters and numbers of code. In other words, the 
shapes and colors displayed on the monitor while working in Illustrator 
are BIT MAPPED IMAGES of the underlying VECTOR CODE.
Adobe Illustrator’s technology applies this on-screen raster imagery so 
that many different RASTER EFFECTS can be added to the VECTOR CODE 
as shown on the screen, without permanently embedding these effects 
in the VECTOR CODE. This means that the on-screen effects added to 
VECTOR OBJECTS can be EDITED over and over again without changing 
the underlying VECTOR OBJECT CODE. Adobe calls this continuously 
editable, on-screen functionality in Illustrator LIVE EFFECTS. In later 

chapters, when we explore BLENDS, COMPOUND 
PATHS, DISTORTIONS, MESHES, and others, the 
extraordinary power of thee LIVE EFFECTS will 
become far more apparent. 
Here, however, we are going to start with the 
easiest and, possibly, most intuitive of the LIVE 
EFFECTS — LIVE PAINT. After converting an 
OBJECT into a LIVE PAINT OBJECT, a single CLICK 
with the LIVE PAINT BUCKET TOOL [Figure 3-c: 1] 
applies the FILL COLOR to any enclosed area of the 
LIVE PAINT OBJECT. 
Similarly, once an OBJECT has been converted into 
a LIVE PAINT OBJECT, disparate parts of it can be 
individually or consecutively selected by the LIVE 
PAINT SELECTION TOOL [Figure 3-c: 2] then have 

FILL or STROKE COLOR applied to them with a single CLICK in the FILL/
STROKE, SWATCH, or COLOR PANEL. Here’s how.

Creating a LIVE PAINT Object
The LIVE PAINT TOOLS work differently than the normal SELECTION TOOLS. 
With the latter, you can FILL or STROKE OBJECTS defined by PATHS. With 
the LIVE PAINT BUCKET TOOL, you can FILL any area that is surrounded by 

intersecting PATHS, even if each of these PATHS is a separate and distinct 
OBJECT. With the LIVE PAINT SELECTION TOOL, you can select any segment 
of an OBJECT or a PATH by other distinct PATHS crossing it.  
The RECTANGULAR GRID TOOL, covered in the previous segment of this 
chapter, creates ideal OBJECTS to demonstrate this. 
 1. Select the RECTANGULAR GRID TOOL and CLICK and DRAG to create 

a RECTANGULAR GRID [Figure 3-c: 3].
Then, either:
 2. Go: Object > Live Paint > Make [Figure 3-c: 4]
or
 3a. SELECT the LIVE PAINT BUCKET TOOL [Figure 3-c: 1] and
 3b. Then move the LIVE PAINT BUCKET TOOL CURSOR over the ACTIVE 

GRID OBJECT and CLICK [Figure 3-c: 5]. You have created a LIVE 
PAINT GRID OBJECT. Note that the LIVE PAINT BUCKET TOOL CURSOR, when it is not hovering 

over an ACTIVE OBJECT has a small white “X” in a BLACK SQUARE at the bottom of the BUCKET ICON. When 

you move the CURSOR over an ACTIVE OBJECT, the White “X” becomes a small BLACK ARROW  pointing to the 

right and the words, “Click to make a Live Paint group” are added to the CURSOR. On the CURSOR, the larger,  

middle square contains the FILL color that is current on the FILL/STROKE ICON and that will be added to the 

selected area of the LIVE PAINT OBJECT, the smaller squares on the left and right show the color to the left and 

color to the right of the FILL COLOR on the SWATCHES PANEL.
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 LIVE PAINT: working with the LIVE PAINT BUCKET 

Now that we have created a LIVE PAINT GROUP (or 
Object), how do we use this new item? It’s almost too 
easy. Without leaving the LIVE PAINT BUCKET TOOL, create 
a COLOR using the COLOR PANEL, or select a COLOR from 
the SWATCHES PANEL. Then, just move the LIVE PAINT 
BUCKET TOOL CURSOR over one of the enclosed areas on the 
GRID. See how the edges of the area are highlighted with a 
thick, (by default) red line and the CURSOR now is a Paint 
Bucket with its bottom portion filled with black. Now CLICK 
[Figure 3-c: 6]. The highlighted area takes on the currently 
selected FILL COLOR [Figure 3-c: 7].
You can also CLICK and DRAG the LIVE PAINT BUCKET TOOL 
across any number of areas on the grid [Figure  3-c:  8]. 
When you release the mouse button, all the areas that you 
moved over will be painted with the current FILL COLOR 
[Figure 3-c: 9]. 

If you intend to fill a fairly large, complex grid with multiple colors, the 
preferred strategy is to, first, create your intended PALETTE of COLORS 
using the COLORS PANEL, second, place them in the SWATCHES PANEL, 
and, third, use the LIVE PAINT BUCKET TOOL to FILL each area on your 
OBJECT with the color you desire. Don’t leave the LIVE PAINT BUCKET 
TOOL, just CLICK it on the SWATCH you need and then CLICK it on the area 
you wish to fill [Figure 3-c: 10]. 
So far, we have only filled the areas on the GRID with colors. But you can 
use the LIVE PAINT BUCKET TOOL to FILL an enclosed area on an OBJECT 
with any of the three types of FILLS that can reside on the SWATCHES 
PANEL: Colors, Gradients, Patterns 
[Figure  3-c:  11 — next page]. 
Later on in the book, will discuss 
both Gradients and Patterns, where 
to find them and how to make 
them in detail.
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When we discussed GRIDS, we showed how each line in a RECTANGULAR 
GRID is a separate OBJECT. We also showed how the “OUTSIDE 
RECTANGLE” could be made a single SHAPE OBJECT (FRAME) or a set 
of FOUR PATHS depending on whether we checked a CHECK BOX in 
the RECTANGULAR GRID DIALOG BOX. If we create a GRID without 
making the OUTSIDE RECTANGLE a FRAME, we can use the DIRECT 
SELECTION or GROUP SELECTION TOOLS to remove one or more of the 
paths making up the OUTSIDE RECTANGLE [Figure 3-c: 12]. 
Having done this, there are now areas of the GRID that oar only 
partially enclosed. When we use the LIVE PAINT BUCKET TOOL to 
FILL this GRID, we will not be able to FILL those areas that are not 
completely enclosed [Figure 3-c: 13 ]. This can also come into play 
when you edit the individual lines that make up the interior of the 
GRID [Figure 3-c: 14]. Notice how, in this example, the LIVE PAINT 
BUCKET TOOL ignores any line  that does not extend far enough to 
intersect another line when it FILLS an area [Figure 3-c: 14-1]. 
LIVE PAINT considers this lack of “enclosure” a “GAP” and  Illustrator 
has controls within the LIVE PAINT TOOLS to edit how LIVE PAINT deals 
with GAPS. To make changes to how the LIVE PAINT TOOLS will deal 
with GAPS, Go: Object > Live Paint > Gap Options… [Figure 3-c: 15]. 
This opens the GAP OPTIONS DIALOG BOX [Figure  3-c:  16]. This 

DIALOG BOX allows you to make adjustments to how LIVE PAINT FILLS 
areas in three different ways. It also allows you the change the HIGHLIGHT 
COLOR used by the LIVE PAINT BUCKET TOOL to designate an area that is 

ready to be filled.
By DEFAULT, the GAP OPTIONS DIALOG BOX opens with the GAP DETECTION 
CHECK BOX in the upper left hand corner CHECKED. This allows you to set 
the “GAP DETECTION” (the automatic assessment of gaps) with the three 
option POP-DOWN [Figure 3-c: 17] 
or by CHECKING the CUSTOM BOX 
and entering a unit value in the 
TEXT FIELD [Figure  3-c:  18]. The 
UNITS will reflect the DEFAULT 
UNITS you set when you created 
the document. Remember that 
Illustrator will translate any units 
that you enter “on-the-fly.” 
The GAP PREVIEW COLOR POP-DOWN 
lets you change the HIGHLIGHT 
COLOR [Figure 3-c: 19]. 
The third method for changing 
how the LIVE PAINT BUCKET TOOL 
fills an area is the CLOSE GAPS 
WITH PATHS BUTTON just below 
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the GAP PREVIEW COLOR POP-DOWN [Figure 3-c: 20]. If the GAP 
DETECTION settings detect one or more GAPS in the OBJECT (in 
this case, the GRID), it or they will be shown on the OBJECT as a 
short line in the HIGHLIGHT COLOR that joins the line causing the 
GAP to the nearest possible “intersecting” line [Figure 3-c: 21].
If there are GAPS on the OBJECT when you CLICK the CLOSE 
GAPS WITH PATHS BUTTON, the CLOSE GAPS WITH PATHS 
WARNING DIALOG opens to ask if you wish to “TURN OFF GAP 
DETECTION”  and replace the currently detected GAPS with PATHS 

[Figure  3-c:  22]. If you CLICK “YES,” an UNFILLED, 
UNSTROKED PATH in the LAYER HIGHLIGHT COLOR 
replaces the HIGHLIGHTED GAP [Figure 3-c: 23]. 
If there are no GAPS on the OBJECT when you CLICK 
the CLOSE GAPS WITH PATHS BUTTON, the NO GAPS 
FOUND WARNING DIALOG opens [Figure  3-c:  24]. It 
means that the GAP DETECTION settings have found no 
GAPS to fill. Just CLICK “YES” and continue working. 
If there are GAPS that your settings do not recognize, 
reopen the GAP OPTIONS DIALOG BOX, re-check the 
GAP DETECTION CHECK BOX, and adjust the settings.

Remaining Live Paint Menu Options
There are still three options on the LIVE PAINT MENU 

that we have not discussed. The first of these is RELEASE. For this example, 
we will use the LIVE PAINT GROUP GRID in Figure 3-c: 25. With this LIVE 
PAINT GROUP SELECTED, Go: Object > Live Paint > Release [Figure 3-c: 26]. 
Immediately, all the LIVE PAINT FILLS are removed, leaving the original 
GRID, in this case a GRID of BLACK LINES [Figure 3-c: 27]. 
The second option is EXPAND. Again, starting with the LIVE PAINT GROUP 
GRID in Figure 3-c: 25, Go: Object > Live Paint > Expand [Figure 3-c: 28]. 
In this case, the LIVE PAINT FILLS are converted into separate Illustrator 
Objects, each of which can be SELECTED and EDITED [Figure 3-c: 29].

The last of these options is the MERGE command. It 
is used to create ONE LIVE PAINT GROUP from two or 
more LIVE PAINT GROUPS. This is a fairly specific, fairly 
advanced capability which we will not be using for the 

project at the end of this chapter. So, file this possibility away. You may 
need to use it some day, but we don’t need it now. Instead, let us now 
consider the LIVE PAINT SELECTION TOOL.
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The LIVE PAINT SELECTION TOOL (Arrow) [Figure 3-d: 1] allows you to 
manipulate the color of multiple whole areas of a LIVE PAINT GROUP as 
well as single or multiple individual line segments and single, enclosed 
areas in a LIVE PAINT GROUP. 
When you SELECT the LIVE PAINT SELECTION TOOL, notice first that the 
tool has two distinctive states for its CURSOR. The first is when the CURSOR 
is outside of a LIVE PAINT GROUP: it is then the “hollow” arrow with a tiny 
“x” below its lower right corner [Figure 3-d: 2a]. When the CURSOR moves 
inside a LIVE PAINT GROUP, it changes to the “hollow” arrow pointer with 
a tiny pyramid below its lower right corner [Figure 3-d: 2 b].
Just as with the LIVE PAINT BUCKET TOOL, the closed areas are highlighted 
with a red (or other specified) highlight color on their edges. 
If you CLICK with LIVE PAINT SELECTION TOOL and then CLICK on a LIVE 
PAINT GROUP LINE SEGMENT or ENCLOSED AREA, the SELECTED SEGMENT 
or AREA is HIGHLIGHTED with a BLACK and WHITE GRID PATTERN. 
Figure 3-d: 3 shows this GRID PATTERN separated from the LIVE PAINT 
GROUP (above) and as it looks on the LIVE PAINT ART (below). While 
this highlight shows a unique visual effect, all that it signifies is that 
the particular area filled with the HIGHLIGHT PATTERN GRID is SELECTED. 
What is unique is that the HIGHLIGHTED area is not necessarily a 
complete Illustrator OBJECT. It is merely that part of an OBJECT enclosed 
by intersecting PATH “LINES.”

Beyond these visible, “interface” differences, this tool is essentially 
similar to the SELECTION TOOL and is used, within the context of a LIVE 
PAINT GROUP, in much the same way. For example, if you hold down the 
SHIFT KEY while CLICKING in successive LIVE PAINT GROUP AREAS and/
or directly on the INTERSECTING LINES that surround an area, you will 
SELECT all these areas and lines [Figure 3-d: 4]. And, just as with the 
SELECTION TOOL, holding down the SHIFT KEY and then CLICKING on a 
SELECTED AREA deselects it [Figure 3-d: 5]. 
The LIVE PAINT SELECTION TOOL, just like the SELECTION TOOL, selects 
areas (FILLS) and lines (STROKES).  Figure 3-d: 6 shows a number of “LINE” 
selections in the left and center “window” with an “AREA” selection in the 
right “window.”
The GAP CONTROL for the LIVE PAINT SELECTION TOOL is the same as 
for the LIVE PAINT BUCKET TOOL. Just Go: Object > Live Paint > Gap 
Options… [Figure 3-c: 15]and then follow the directions on page twelve 
of this chapter. The RELEASE, EXPAND, and MERGE commands in the GAP 
OPTIONS sub-menu also work the same. 
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The various options offered by LIVE PAINT discussed in the preceding 
section are the first of Illustrator’s so-called “LIVE” options that we have 
used. We will go into the meaning of “LIVE” in Illustrator in much greater 
detail in later chapters. For now, understand that all “LIVE” effects (for 
want of a better word) exist as the ON-SCREEN  OBJECTS only. They must 
be converted to “regular” POSTSCRIPT OBJECTS in order to be processed 
and/or displayed outside the Illustrator program. 
The next set of “LIVE” OBJECTS we will take up are Illustrator’s SYMBOLS.  
SYMBOLS allow you to have multiple Illustrator OBJECTS that are fully 
described in the underlying code only once. All the examples of the 
OBJECT in the Illustrator on-screen art are INSTANCES of that single code 
description: something like place holders, with or without edits and/or 
manipulations, that visibly “channel” the original OBJECT into this new 
position. As you might imagine, this means that the program need not 
rewrite the code for the OBJECT, no matter how many times it is used.   
Instead, the program puts in a short bit of code pointing back to the 
SYMBOL then adds the code necessary to describe the OBJECT’S position 
and any changes to its size, proportions, etc. This can help minimize the 
size of the DOCUMENT: it will load and display faster.

Opening the SYMBOLS PANEL
In Illustrator’s BASIC WORKSPACE, the SYMBOLS PANEL is behind the 
“CLUB” ICON [Figure 3-e: 1], the fifth ICON from the top of the ICON DOCK 
in the upper right corner of the screen. In the PANELS WORKSPACE, the 
SYMBOLS PANEL is “nested” behind the SWATCHES and BRUSHES on the 
second PANEL from the top of the PANEL STACK in the upper right corner 
of the screen [Figure 3-e: 2]. To access the SYMBOLS PANEL, just CLICK on 

the SYMBOLS TAB as shown in Figure 3-e: 3. This puts the SYMBOLS TAB in 
front of the other two TABS so that the SWATCHES and the BRUSHES are 
now “nested” behind it. In the TYPE WORKSPACE the SYMBOLS PANEL is 
hidden. To access it, you need to OPEN IT through the WINDOWS MENU. 
GO: Windows > Symbols or TYPE: Shift + Command (Mac) or Shift + Control 
(Windows) + F12 [Figure 3-e: 4]. The SYMBOLS PANEL, with the BRUSHES 

will open grouped with the FLASH TEXT (minimized above), BRUSHES 
(nested behind it), and the APPEARANCE/GRAPHIC STYLES (minimized 
below) nested PANELS [Figure 3-e: 5].
The SYMBOLS PANEL opens with six DEFAULT SYMBOL THUMBNAILS 
showing [Figure 3-e: 6]. Notice the 
tiny ICONS along the bottom of the 
PANEL, labeled on the example in 
yellow boxes. When the PANEL opens, 
only the SYMBOLS LIBRARIES MENU 
ICON (left-most) and the NEW SYMBOL 

ICON (second from right) are 
active. The other four ICONS are 
grayed-out. CLICK on a SYMBOL 
THUMBNAIL [Figure 3-e:  7], 
and three more of these tiny 
ICONS become active: PLACE 
SYMBOL INSTANCE, SYMBOL 
OPTIONS, DELETE SYMBOL. 
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First, let’s look at the PLACE SYMBOL INSTANCE ICON. You SELECT 
the SYMBOL you wish to use by CLICKING on its THUMBNAIL as 
in Figure  3-e:  7. Then, CLICK on the PLACE SYMBOL INSTANCE 

ICON and an INSTANCE (see above) of that 
SYMBOL will be PLACED in the CENTER OF 
YOUR SCREEN on the currently ACTIVE 
LAYER [Figure 3-e: 8].
Notice that the file has a “BOUNDING 
BOX” similar to other Illustrator Objects 
you have created. Just like those 
OBJECTS, this “BOUNDING BOX” allows 
you to SCALE the SYMBOL: (a) using 
the SELECTION TOOL [Figure  3-e:  9], 
(b) SCALE PROPORTIONATELY using the 
SHIFT KEY and the SELECTION TOOL 
[Figure 3-e: 10], and (c) to ROTATE using 
the SELECTION TOOL [Figure 3-e: 11]. 

If you use the SHIFT KEY while you ROTATE the SYMBOL you will 
RESTRAIN the ROTATION to 45° increments as in figure 1-g-vii on 
page “sec1:4.” 
Without going into some very powerful intermediate and advanced 
processes at this time, we can still use the SYMBOLS PANEL to allow 
us to edit the SYMBOL we PLACED into our DOCUMENT. Notice that 
when the SYMBOL was PLACED, the last of the GRAYED-OUT, TINY 
ICONS (the “broken link”) at the bottom of the PANEL, became 
ACTIVE [Figure 3-e: 12]. If you CLICK this ICON while the PLACED 
SYMBOL is SELECTED, this SYMBOL INSTANCE is UNLINKED from the 

SYMBOL in the SYMBOLS PANEL and is converted into a regular Illustrator 
OBJECT [Figure 3-e: 13]. Notice that the multiple shapes that create the 
bird are now surrounded by PATHS with CONTROL POINT. 

This OBJECT can be edited and/or manipulated just as can any other 
Illustrator OBJECT. It can even be converted into a LIVE PAINT OBJECT 
[Figure 3-e: 14].  

Working exercise: open a 6” X 6” 
document, place a default SYMBOL on 
it. De-link the SYMBOL, convert it to a 
LIVE PAINT OBJECT, and color it until 
you are comfortable with the process 
and satisfied with the outcome.

Making SYMBOLS from OBJECTS
You can also reverse this process and 
convert OBJECTS into SYMBOLS. The 
easiest way is merely to select the 
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OBJECT or GROUP of OBJECTS that you wish convert into an Illustrator 
SYMBOL and CLICK and DRAG [Figure 3-e: 15] it onto the SYMBOLS PANEL. 
The SYMBOLS OPTIONS DIALOG BOX will open, giving you the opportunity 

to name the SYMBOL. This DIALOG BOX also allows you to select 
options that are specific to the Adobe Flash™ Program, which we 
won’t consider at the present time. Having chosen the OPTIONS 
you wish, CLICK OK [Figure  3-e:  16]. The “blue bird” SYMBOL 
is added to the SYMBOLS PANEL and, note this especially, the 
MULTIPLE OBJECTS on the ART BOARD that composed the BLUE 
BIRD IMAGE have been converted into that SYMBOL as well 
[Figure 3-e: 17]. This feature was introduced in Illustrator CS3.
The second way to create a SYMBOL from Illustrator ARTWORK 
is to SELECTED the ART and then CLICK the new SYMBOL ICON 
(the second tiny Icon from the right) on the bottom of the 
SYMBOLS PANEL [Figure 3-e: 18]. When you do this, you initiate 

the same process previously 
described in Figure 3-e: 16 and 
Figure 3-e: 17 above. 
The third method for converting 
ART to a SYMBOL is to CLICK 
and HOLD, or just quickly CLICK 
the “FLY-OUT” button (the three 
tiny horizontal lines preceded by 
an equally tiny triangle pointing 
down) in the upper right corner 

of the PANEL.. 
This opens the 
SYMBOLS PANEL 
FLY-OUT MENU. 
At the top of 
the list is the 
“NEW SYMBOL…”  
command. If 
you are holding 
down the MOUSE 
BUTTON, just 

slide the CURSOR over to this command. 
Otherwise, just CLICK it [Figure 3-e: 19]. 
Once again you will initiate the process previously described in 
Figure 3-e: 16 and Figure 3-e: 17 above and add your NEW SYMBOL to the 
SYMBOLS PANEL. 

More about working with SYMBOLS
When you opened the SYMBOLS PANEL FLY-OUT MENU, you may have 
noticed that there are a number of commands listed below the “NEW 
SYMBOL…” command. In fact, the sixth command from the top, “PLACE 
SYMBOL INSTANCE,” is the same as the TINY ARROW ICON, second from the 
left at the bottom of the SYMBOLS PANEL [Figure 3-e: 20]. Obviously this 
is a second way to PLACE a new INSTANCE of a chosen SYMBOL. 
Yet a third way to PLACE a SYMBOL INSTANCE is to CLICK and DRAG it from 
its position on the SYMBOLS PANEL [Figure 3-e: 21].

 Symbols 1: introduction to the Symbols Panel and Library 
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For the time being, we will nor discuss how to use the 
REFINE SYMBOL or EDIT SYMBOL command. While they 
are fairly straight forward in action, they involve some 
of Illustrator’s more complicated concepts. Instead, lets 
first look at the DUPLICATE SYMBOL command. When 
you choose this command, it adds a copy of the SELECTED 
SYMBOL to the SYMBOLS PANEL [Figure 3-e: 21]. And, 
just to keep things full of options, you can accomplish 
thing same duplication by CLICKING and DRAGGING 
the SYMBOL of your choice onto the NEW SYMBOL 
ICON, one ICON to the left of the DELETE SYMBOL ICON 
(trash can) at the bottom right of the SYMBOLS PANEL 
[Figure 3-e: 22].
Likewise, you DELETE a SYMBOL from the SYMBOLS 
PANEL by either CLICKING and DRAGGING the chosen 
SYMBOL onto the DELETE SYMBOL ICON (trash can) 
[Figure  3-e:  23a] or by SELECTING the SYMBOL you 
wish to DELETE by CLICKING it in the SYMBOLS PANEL 
and choosing DELETE SYMBOL from the SYMBOLS PANEL 
FLY-OUT MENU [Figure 3-e:  23b]. In either case, the 
DELETE SYMBOL WARNING DIALOG will open, allowing 
you to DELETE the SYMBOL by CLICKING YES or to 
change your mind and keep the SYMBOL by CLICKING 
CANCEL [Figure 3-e: 24].

About the SYMBOLS LIBRARIES
Illustrator comes with a number of SYMBOLS already for 
you to use. When you open the SYMBOLS DOCK ICON or 
the SYMBOLS PANEL for the first time, a DEFAULT set of 
SYMBOLS is displayed, as we’ve seen throughout 

this section. But there are many more already available when you open 
the SYMBOLS LIBRARY. How is this done? Again, there is more than one 
way to access these LIBRARIES.
The easiest is to CLICK on the SYMBOLS LIBRARIES MENU ICON, the tiny 
ICON at the far left of the bottom of the SYMBOLS PANEL as shown in 
figure 3-e: 6. When the ICON is CLICKED, the 
SYMBOLS LIBRARIES MENU “pops-down” to 
display twenty-seven options [Figure 3-e: 25].
To start with, explore this assortment to find 
those SYMBOLS that you think will be of use to 
you. Just move you CURSOR down the list and 
release it when you’ve found a SYMBOL category 
that intrigues you. The LIBRARY of SYMBOLS 
that you have chosen will open as a separate 
panel on you screen [Figure  3-e:  26]. Select 
as few or as many of the SYMBOLS as you want 
[Figure  3-e:  27] (remember to hold down the 
COMMAND KEY [Mac] or CONTROL KEY [PC] to 
make discontinuous selections), then CLICK and 
DRAG the chosen SYMBOLS to your SYMBOLS 
PANEL [Figure 3-e: 28]. You can use the SYMBOLS 
OPTIONS ICON (third 
from the bottom 
right) to rename the 
SYMBOLS, you can 
DUPLICATE or DELETE 
SYMBOLS. Finally, 
once you have a set 
of SYMBOLS that you 
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would like to keep, you can SAVE the SYMBOL SET as a USER 
DEFINED SYMBOL LIBRARY. Simply CLICK the SYMBOLS LIBRARY 
MENU ICON (bottom, far left) to access the SYMBOLS LIBRARY 
MENU [Figure  3-e:  29]. Choose SAVE SYMBOLS… then release 
the MOUSE. The SAVE SYMBOLS AS LIBRARY DIALOG BOX opens 
[Figure  3-e:  30]. By Default, it opens to Illustrator’s SYMBOLS 
sub-folder, a couple directories down, inside the main Illustrator 
Program Folder. For now, don’t change this or any of the other 

settings. Just name your SYMBOL LIBRARY with a descriptive, easy to 
remember name and CLICK SAVE. The next time you CLICK on the SYMBOLS 
LIBRARY MENU ICON, slide your CURSOR down to “USER DEFINED” and 
the USER DEFINED SUB-MENU will pop-out [Figure  3-e:  31]. You will 
see your new LIBRARY (in the example, “primitive-and-default.ai”) on 
the SUB-MENU. Now, you can access these SYMBOLS in this way on any 
Illustrator document you are working on.

Working exercise: explore at least nine of the provided SYMBOL LIBRARIES. 
Add them to your SYMBOLS PANEL, DELETE some, RENAME the ones you 
intend to keep. Choose the three best new sets of SYMBOLS you have created 
and add them to your Illustrator Program by saving them as SYMBOL 
LIBRARIES as described in this section.

A Brief Introduction to Clipping Masks
In the three Exercises that have been detailed, we created a FRAME LAYER 
so the images on the ART BOARD would be limited to the boundaries of 
the ART BOARD. Even so, the FRAME LAYER process was rather clumsy and 
inelegant. Wouldn’t it be better if there were a much simpler method to 
make it possible to confine images within specific boundaries? 

NOTE ABOUT THE ART BOARD: 
Remember that the ART BOARD is the thinly outlined RECTANGLE or SQUARE 
that represents the “physical” boundaries and size of your document. It 
exists on the PASTE BOARD, the much larger area that surrounds it. Since 
both are WHITE on the computer screen, you must learn to ignore the PASTE 
BOARD as you are composing images. Initially, this is not too easy to do. 
But with practice, you will learn to see the ART BOARD as a “piece of paper” 
on the “drawing table” of the PASTE BOARD.

Of course, when we ask these kinds of rhetorical questions in this kind 
of book, it is usually to introduce exactly that kind of simpler solution. 
In this case, the simpler, more elegant solution is the CLIPPING MASK. 
CLIPPING MASKS are much more elegant. And, they are rather simple, at 
least once you get used to their rather peculiar nature. It is coming to 
terms with how they work that causes most students some problems. So, 
let’s try to come to terms with CLIPPING MASKS.
What is a CLIPPING MASK, you may ask. To answer the question, let us 
first look at the two words individually. Most of us are familiar with the 
word CLIP, at least in many of its definitions. But the meaning here is a 
rather specialized and limited definition that is used mostly in electronics. 
When an electronic signal CLIPS, it means that the device reproducing the 
signal can not reproduce it completely or accurately. Most of us usually 
only experience this kind of clipping in the electronic reproduction of 
music or speech. If an amplifier cannot accurately reproduce all of the 
peaks (and corresponding valleys) of a musically signal, it cuts off the 
extremes that are beyond its capability; it CLIPS them. This is readily seen 
on a oscilloscope, where the pointed “peaks,” either above or below the 
null line are “flattened” at the point where the amplifier can no longer 
reproduce them. It CLIPS them off. The same thing happens with small 
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or low quality speakers. Bigger and/or better speakers sound more “real,” 
partly because they are capable of producing more of any signal that is 
fed to them. All the signal is there for all speakers, but better and bigger 
speakers CLIP less of it. That is why a fancy, audiophile music system 
sounds better than a cheap boom box.
In normal speech, a mask is something that is worn and that, usually, 
hides some part of the wearer. Therefore, a mask is a method for hiding 
part or all of something.
When we work in Illustrator, we are working with electronic signals. They 
are what are reproduced on the computer screen as images. To “hide” 
part of this reproduced signal, we need something akin to a MASK. And, 
since we are dealing with a electronic signal, this mask should function 
by CLIPPING that signal in the areas we desire. That is what a CLIPPING 
MASK does.
A CLIPPING MASK must be an Illustrator SHAPE OBJECT. It can be any 
SHAPE, and its size is only limited by the size of your image. It is most 
easily compared a “viewing portal” that is surrounded by emptiness. 
Whatever is within boundaries of the viewing port is visible, whatever 
is outside its boundaries cannot be seen. To continue with the electronic 
metaphor, the electronic signal is CLIPPED to the SHAPE of the MASK. If 

that has left you a little confused or uncertain, let’s see how a CLIPPING 
MASK works in action.
Open one of your images from Exercise 1. Drag the FRAME LAYER to 
the LAYER TRASH (the garbage can ICON) to DELETE it [Figure 3-f: 1]. 
Make sure that the CONTENT LAYER is UNLOCKED and HIGHLIGHTED, 
then CREATE a new LAYER [Figure 3-f: 2]. On this NEW LAYER, using the 
RECTANGLE TOOL and holding down the SHIFT KEY, “draw” a SQUARE that 
starts at the upper left corner of the ART BOARD and ends at the lower 
right corner of the ART BOARD [Figure 3-f: 3]. In other words, a square 
that fits exactly over the ART BOARD. You need not worry if is filled or 
not filled, stroked or not stroked, although at least one of the above will 
make it easier to see. 
After you have created the square on the NEW LAYER, go: Select > All,  or 
hold down the COMMAND KEY (Mac) or CONTROL KEY (PC) and then TYPE 
“A.” Or, you could use the SELECTION TOOL to “draw” a MARQUEE around 
all the imagery, including the new square, on your ART BOARD, thereby 
SELECTING it [Figure  3-f:  4a]. With every OBJECT on your document 
SELECTED [Figure 3-f: 4b], go: Object > Clipping Mask > Make or TYPE: 
COMMAND (Mac) or CONTROL (PC) and “7” to CREATE A CLIPPING MASK 
[Figure 3-f: 5].
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Your image should look again as it did when you had the FRAME LAYER 
in place. But now, instead of the cumbersome, four rectangle FRAME, you 
have CLIPPED the image to the boundaries of the ART BOARD, MASKING 
OUT everything outside those boundaries [Figure  3-f:  6]. Notice, also, 
that the BOUNDING BOXES of the individual OBJECTS are visible beyond 
the boundary of the CLIPPING MASK when SELECTED. 

Releasing Clipping Masks
There will be times when it will be necessary or advantageous to remove 
a CLIPPING MASK from an OBJECT or group of OBJECTS. To do so, simply 
SELECT the OBJECT or group of OBJECTS and their CLIPPING MASK by 
CLICKING on them with the SELECTION TOOL [Figure 3-f: 7a]. By default, 
Illustrator considers the entire CLIPPING MASK OBJECT a “GROUP,” so a 
single SELECTION TOOL CLICK will select the whole group.
You can also SELECT the entire CLIPPING MASK OBJECT by CLICKING the 

TARGET CIRCLE on the LAYER or SUB-LAYER that 
contains all the SUB-LAYERS of the CLIPPING 
MASK OBJECT [Figure 3-f: 7b].
Finally, vuse the COMMAND (Mac) or CONTROL 
(PC) plus “A” keyboard shortcut, as long as 
all the LAYERS of the DOCUMENT EXCEPT the 
LAYER containing the CLIPPING MASK OBJECT 
are LOCKED [Figure 3-f: 7b, 7c].
Once the CLIPPING MASK OBJECT is SELECTED, 
Go: Object > Clipping Mask > Release or TYPE: 
COMMAND/OPTION (Mac) or CONTROL/ALT (PC) 
plus “7” [Figure 3-f: 8a, 8b].
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Filling and Stroking Clipping Masks
CLIPPING MASKS, strange as it may seem since they are “invisible” by 
default, can be FILLED and STROKED. Even though the SHAPE you use 
to create a CLIPPING MASK is “drawn” above the shapes to be CLIPPED 
in the LAYER or SUB-LAYER STACK, when you FILL a CLIPPING MASK, the 
FILL shows “behind” all the parts of the CLIPPING MASK GROUP. And, 
just to make things a little stranger, any STROKE you apply to a CLIPPING 
MASK will be attached to the CLIPPING MASK OBJECT’S PATH, and remain 
“above” all the parts of the CLIPPING MASK GROUP. 
You must use the DIRECT SELECTION or GROUP SELECTION TOOL to FILL or 
STROKE a CLIPPING MASK: they are the only TOOLS that can SELECT parts 
of GROUPS, leaving the other parts UN-SELECTED. In this example we will 
use the GROUP SELECTION TOOL. So you can either go to the TOOL BAR and 
CLICK and HOLD the DIRECT SELECTION TOOL until the sub-menu opens. 
Then, slide your CURSOR over to the on the GROUP SELECTION TOOL to 
choose it. The more efficient way to get the GROUP SELECTION TOOL is to 
TYPE: “A” — the keyboard shortcut for the DIRECT SELECTION TOOL. Then, 
hold down the OPTION (Mac) or ALT (PC) KEY [Figure 3-f: 9] when you 
are SELECTING the CLIPPING MASK OBJECT’S PATH [Figure 3-f: 10]. Notice 
that when SELECTED with the DIRECT or GROUP SELECTION TOOLS, the 
SELECTION TOOL BOUNDING BOX with its nine tiny “handles” is changed  
to only five tiny squares of solid color; one in the center and one at each 
corner [Figure 3-f: 11].

To FILL the SELECTED CLIPPING MASK SHAPE with a color, CLICK the FILL 
ICON on either the TOOL BAR [Figure 3-f: 12] to bring it to the front 
of the two ICONS and make it active. Then CLICK the COLOR of your 
choice on the SWATCHES PANEL. To add a STROKE COLOR to the SELECTED 
CLIPPING MASK SHAPE, CLICK the STROKE ICON on either the TOOL BAR 
to bring it to the front of the two ICONS and make it active. Then CLICK 
the COLOR of your choice on the SWATCHES PANEL [Figure 3-f: 13]. In the 
example below, we have added a CYAN FILL behind the CLIPPING MASK 
contents and surrounded it with a RED STROKE.
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Of course, there is a great deal more to CLIPPING MASKS, and an entirely 
different version of the same thing called a CLIPPING LAYER. We will cover 
them later in this course. Now is the time to test yourself with all these 
new tools: STROKES, LIVE COLOR, GRIDS, SYMBOLS, and CLIPPING PATHS. 
That brings us to EXERCISE 4.

Grids have always been used as powerful, decorative devices. Many modern 
artists, painters, print makers, fabric artists, and sculptors alike, have used 
grids as compositional devices and compositional units. In the mid to late 
1970’s, some artists even made grids compositional subjects by themselves. 
The repetitive nature of the grid can unite disparate objects in a common 
structure. A “broken” grid can also give tension to a composition. 
In this project, you will create a fairly simple RECTANGULAR GRID, color it, 
and then fill parts or all of it with images from one or many of Illustrator’s 
SYMBOL LIBRARIES. If that were all there was to it, this would be just a 
technical exercise. 
But there is a further component. In the “COLOR BAR COMPOSITIONS,” 
you were pushed very simple elements trying to bring some “emotional” 
or “narrative” content to a few colored stripes. In the same way, in this 
exercise you are to push these slightly less simple elements, within their 
repetitive, grid structure, to be more than the sum of their parts. Meditate 
a little bit on grids in general before you start. What part have grids 
played in your life, where do you see them, what, if any, are your feelings 
about them. That should give you a place to start. 
When you are working, try to see what kind of visual relationships seem 
to be developing between the grid colors and the symbol images. Are there 
rhythmic patterns beginning to emerge? Are there “cross rhythms” that 
let you see the positive/negative space in the composition in ways that 
change over time?
The purpose of this is to get you to start a dialog with your composition 
within its set constraints. As a designer or illustrator, you will usually 
have an objective to work toward. Even if this goal has been rigidly set, 
there is room for creative thought and ideas if you can “live” completely 
within the boundaries and process of the project.

Exercise 4: A small GRID and SYMBOL Composition 
This exercise will bring together everything we have covered so far: 
SHAPES, FILLS, STROKES, using the COLOR and SWATCHES PANELS, GRIDS, 
SYMBOLS, and CLIPPING MASKS. 

 1. To start, create a new DOCUMENT named “lastname-grid-ex4” and 
let Illustrator put the “.ai” extension on it when you first SAVE it. 
The dimensions are your choice with these restrictions: no larger 
than 10.5” X 8” or 8”X 10.5” (remember width precedes height) and 
no smaller than 7 inches in any direction. Also, make sure that the 
“Create PDF Compatible File” check box is checked as shown in 
Figure N-3 on page “intro:xv”. 

 2. When the file opens, OPEN the LAYERS PANEL and name the 
DEFAULT LAYER “Grid.” 

 3. Now, make a SECOND LAYER and name it “Symbols1” and LOCK it.
 4. Then, make sure that the “Grid” LAYER is highlighted in the 

LAYERS PANEL. Go to the TOOL BAR and CHOOSE the RECTANGULAR 
GRID TOOL. 

 5. Create a RECTANGULAR GRID the same size as your document. You 
will find it easiest to CLICK the tool on the UPPER LEFT-HAND 
CORNER of the document to OPEN the RECTANGULAR GRID 
OPTIONS DIALOG BOX. 

 6. Set the DEFAULT SIZE to the size of your DOCUMENT. 
Set the HORIZONTAL and VERTICAL DIVIDERS to no fewer than 
5 each and no more than 9 each. You can use the SKEW control 
at your discretion. If you do use SKEW, you will probably wish 
to set the SKEW by trial and error. This will entail CLICKING 
OK, checking the result, and, probably, repeating this procedure 
until you get the SKEW the way you want it. The easiest course 
is to not use SKEW.

 7. Open the SWATCHES PANEL and the COLOR PANEL. You will need to 
CLICK and DRAG them both away from the ICON DOCK by the pale 
gray bar at the top of each panel to move them into the central area 
of your screen. This will keep them both on screen at the same time.  
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If there are a no COLORS on the SWATCHES PANEL, you will 
need to create a few using the COLOR PANEL and add them to 
the SWATCHES PANEL. Or, you can open some of the pre-loaded 
SWATCH LIBRARIES available by opening the SWATCH OPTIONS 
FLY-OUT > Open Swatch Library > your choice. When the LIBRARY 
PANEL opens, don’t forget to SELECT the SWATCHES you want 
and add them to the SWATCHES PANEL by any of the methods 
discussed in Chapter 2. 

  If there are a number of COLORS on the SWATCHES PANEL, you can 
decide if they are the colors you want or whether you want to add a 
few new colors to them using the methods described above.  

 8. Go to the TOOL BAR and CHOOSE the LIVE PAINT BUCKET TOOL. 
Place the LIVE PAINT BUCKET CURSOR over your GRID OBJECT 
and CLICK to convert the GRID to a LIVE PAINT OBJECT. Color the 
GRID as you wish. 

 9. LOCK the GRID LAYER and UNLOCK the SYMBOLS1 LAYER.
 10. Either CLICK on the SYMBOL TAB if it is “nested” in the SWATCHES 

PANEL or drag the SYMBOL PANEL from the ICON DOCK or the 
PANEL STACK. 

 11. Use the SYMBOL OPTIONS FLY-OUT > Open Symbol Library > your 
choice to explore the great variety of SYMBOLS included with the 
program. As you choose SYMBOLS from the LIBRARIES you open, 
add them to the SYMBOLS PANEL. 

 12. Place the SYMBOLS of your choice onto the SYMBOLS1 LAYER 
using the “Place Symbol Instance” arrow at the bottom of the 
SYMBOLS PANEL or by CLICKING the SYMBOL in the PANEL and 
DRAGGING it onto the  ART BOARD. Keep the SYMBOLS on the 
SYMBOLS1 LAYER aligned with the RECTANGULAR GRID on the 
GRID LAYER to create a composition that uses the repetitive 
nature of the grid. 

 13. It is very likely that you will want to “CLIP” off part of the 
SYMBOLS you are using so that they fit more exactly in the 
grid structure on the LAYER(S) below. To accomplish this, use a 
CLIPPING MASK. It is best to ZOOM IN on the SYMBOL so that your 

MASK can be as accurate as possible. Don’t ignore the creative 
possibilities in using a circular or elliptical CLIPPING MASK with 
in the GRID COMPOSITION. 

14. If you created STROKED LINES on your GRID and wish to change  
their color all at once, UNLOCK and HIGHLIGHT the GRID LAYER, 
choose the SELECTION TOOL and CLICK on the GRID OBJECT. Make 
sure the STROKE ICON on the TOOL BAR or the COLOR PANEL is in 
front  the FILL ICON and then choose a different color, WHITE, 
BLACK, or NONE. 

 15. If you SELECT the GRID OBJECT with the SELECTION TOOL, make 
the FILL ICON active, and then CLICK on a SWATCH COLOR, you 
will change all the LIVE PAINT FILLS to the color you CLICKED. 

 16. Add SYMBOL LAYERS as you wish. 

Grids, Symbols, and Clipping Masks: Examples
The following three pages show fourteen examples of this project done by 
students at San Jose State University. Some of the examples use tools and 
procedures we have not covered yet. But they should al provide you with 
ideas for your own work.
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Illustrator’s beating heart
The PEN TOOL [Figure 4-a: 1] and the three variations “nested” within 
it, the ADD ANCHOR POINT [Figure  4-a:  2,], DELETE ANCHOR POINT 
[Figure 4-a:  3], and CONVERT ANCHOR POINT [Figure 4-a: 4], are the 
tools that define Illustrator. The PEN TOOL allows you to draw POSTSCRIPT 
VECTOR OBJECTS composed of lines, corners, curves, and composite 
shapes. Its “nested” variants let you edit the shapes you create with it 
or Illustrator’s other SHAPE TOOLS in compelling, powerful, and accurate 
ways. Without the PEN TOOL, Illustrator would just be another so-called 
“drawing” program.
All the shapes we have created so far with Illustrator Tools can be 
duplicated using the PEN TOOL, although for some, such as SQUARES and 
CIRCLES, RECTANGLES and ELLIPSES, and the other SHAPE TOOLS we have 
not yet discussed, the RECTANGLE TOOL, and the tools “nested” within it, 
are quicker and easier. 
The PEN TOOL offers the graphic artist incredible control. But that control 
comes at a price. Using the PEN TOOL is a very deliberate act: it is not 
an art tool that is expressive in and of itself. You need to think before 
and as you use it. It allows extreme precision and demands thoughtful, 
engaged attention to control that precision. Once you have spent the time 
necessary to come to terms with it, you either will love it or hate it. There 
is nothing half-way about the PEN TOOL.
There is also very little that is “intuitive” about the PEN TOOL. It is nothing  
at all like a pen, except that the OBJECTS it “draws” are delineated by an 
even, unwavering line. But, you don’t “draw,” in any conventional sense, 
with the PEN TOOL: no line appears as you move it over you ART BOARD. 
Instead, you use the PEN TOOL to initiate a line and define the ”curvature” 
of that line, the end the line, at the same time specifying the ending 
”curvature” of the line. This description of initiated and finished lines and 
their curves includes, of course, lines that have no ”curvature” either at 
their beginning not their end.
Two CLICKS for a straight line
Let’s examine this last case, lines with  no ”curvature” or, more commonly, 
straight lines, first. When you SELECT the PEN TOOL and move the CURSOR 
onto the ART BOARD, the CURSOR becomes the NIB or “drawing” end of 
a traditional writing pen with a tiny “x” at its lower right-hand corner. 

This means that the PEN TOOL is ready to begin creating an Illustrator 
OBJECT. When you CLICK at one point on the ART BOARD with the PEN 
TOOL [Figure 4-a: 1-a] a small SQUARE will appear on the ART BOARD: 
you have initiated the POSTSCRIPT CODE for a path. The “PEN” CURSOR 
looses the tiny “x.” When you then CLICK at another point on the ART 
BOARD, Illustrator creates a POSTSCRIPT PATH between the two CLICK 
POINTS [Figure 4-a: 1b].
You can continue CLICKING at new points on the ART BOARD to create a 
single PATH with as many “hard corners” in it as you like [Figure 4-a: 2a 
through 4-a: 2h]. Notice that the CURSOR remains the simple PEN NIB for 
each CLICK of the MOUSE except for the first.
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Now, let’s attempt as simpler SHAPE; a four sided OBJECT 
that connects the first and last CLICK POINTS to create 
a CLOSED PATH [Figure 4-a: 3]. First, CLICK the  PEN 
CURSOR with the tiny “x” at a point on the ART BOARD 
[Figure 4-a: 3a]. Move a ways to the right and CLICK 
again, this time the CURSOR will be just the PLAIN PEN 
[Figure 4-a: 3b]. Move the PLAIN PEN CURSOR below 
the last point and CLICK again [Figure 4-a: 3c]. Move 
to the left and repeat [Figure  4-a:  3d]. Now, move 
the PLAIN PEN CURSOR up until it is right on top of 
the first point that you CLICKED. It will change into 
the “CLOSE PATH” PEN CURSOR, a PEN NIB with a tiny 
square at its lower right, when it is on top of the first 

point. When the  “CLOSE PATH” PEN CURSOR appears, CLICK one last time 
to attach this last line to the first line, thereby creating a CLOSED PATH 
[Figure 4-a: 3e]. 
Let’s check to make sure that you CLOSED the PATH. Here’s how. Select 
the DIRECT SELECTION TOOL (the White Arrow) by TYPING the letter “a”. 
Carefully CLICK and then DRAG on the LAST POINT that you made. As 
you move this POINT, the two PATH LINES attached to it should both 
move as there mutual corner moves [Figure  4-a:  4]. If you did not 
successfully CLOSE the PATH, only the final PATH LINE you created will 
follow the CLICK POINT, leaving a space between it and the first CLICK 
POINT [Figure 4-a: 5]. If you did not successfully CLOSE the PATH, use 

the DIRECT SELECTION TOOL to select just the end of the PATH — the end 
that was supposed to CLOSE the PATH — and then PRESS the “DELETE” 
Key [Figure 4-a: 6a]. The line between the fifth and fourth CLICKS that 
you made disappears, leaving the ENDPOINT of the fourth CLICK POINT 
Highlighted [Figure  4-a:  6b]. Now, TYPE the letter “p” to RE-SELECT 
the PEN TOOL. Move the PEN TOOL CURSOR over the ENDPOINT of the 
HIGHLIGHTED fourth CLICK POINT. The PEN CURSOR adds a SLASH mark to 
its lower right corner [Figure 4-a: 6c]. Finally, move the CURSOR over the 
first CLICK POINT (the starting point for the path) until the CLOSE PATH 
PEN CURSOR (the PEN with the tiny square at its lower right) appears 
and then CLICK [Figure 4-a:  6d]. The PEN TOOL demands precision. If 
you don’t CLOSE the PATH the first few times, keep practicing until you 
succeed.
Once you have CLOSED the PATH, you have created a complete Illustrator 
OBJECT, no different in any thing but shape to the OBJECTS created with 
the RECTANGLE or ELLIPSE TOOLS. You can FILL it with any COLOR you 
wish from the SWATCHES PANEL or by creating a new COLOR with the 
COLOR PANEL. Likewise, you can STROKE the OBJECT in any way that 
seems right.
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The SHIFT KEY with the PEN TOOL: horizontal, vertical, and 45° lines 
We introduced the use of the SHIFT KEY as the CONSTRAINT KEY when we 
discussed the RECTANGLE and the ELLIPSE TOOLS and when SCALING and 
ROTATING the BOUNDING BOX of OBJECTS. With the SHIFT KEY we “drew” 
SQUARES and CIRCLES with the RECTANGLE and the ELLIPSE TOOLS, without 

it RECTANGLES and ELLIPSES. 
With the SELECTION TOOL and 
the SHIFT KEY, we could create 
PROPORTIONAL SCALES when 
CLICKING and DRAGGING the 
BOUNDING BOX of OBJECTS 
and 45° INCREMENTS when 
CLICKING and ROTATING.
The SHIFT KEY is a CONSTRAINT 
KEY for the PEN TOOL as well: it 
CONSTRAINS any line created by 
the  PEN TOOL to HORIZONTAL 
[Figure  4-a:  7a], VERTICAL 
[Figure 4-a:  7b], or to a 45° 
DIAGONAL [Figure  4-a:  7c]. 
Using these CONSTRAINED 

PEN TOOL PATHS, we can now “draw” accurate geometric forms including 
rectangles, squares, right triangles, and parallelograms, as long as we can 
make sure that we can accurately position our PEN TOOL CURSOR. 
To accomplish this, we need to make a digression and take a look at the 
VIEW MENU.

First digression about using the View Menu: Preview and Outline
The VIEW MENU [Figure  4-a:  8] contains a number of tools that help 

you work in Illustrator. All these tools affect the way you see 
the art work you are creating on-screen. Many of them work as 
TOGGLES, a principal we discussed in Chapter 1 when we loked at 
Keyboard Shortcuts for the FILL and STROKE ICONS (Sec1:15). A 
TOGGLE is a SWITCH that changes between two (the most usual) 
or more states. The first OPTION on the VIEW MENU TOGGLES 
between the PREVIEW and OUTLINE MODE. 

We have been working in PREVIEW MODE from the beginning. It is the 
DEFAULT VIEW MODE when Illustrator opens. In PREVIEW, you see the art 
work you create with all the FILLS, STROKES, and other EFFECTS (which 
we haven’t studied yet) applied and visible [Figure 4-a: 9]. Underneath 
these visible effects are the basic POSTSCRIPT CODE OBJECTS to which 
these effects are applied. To see these OBJECTS, we need to look at our art 
in OUTLINE MODE [Figure 4-a: 10]. OUTLINE MODE is very useful when we 
need to make sure that two OBJECTS are perfectly aligned or absolutely 
congruent. It is also used to find the points on CIRCLES, ELLIPSES, and 
other CURVES where the CURVE changes direction relative to the horizontal 
and vertical axes of the art work; i.e., from left to right as it moves up or 
down, or from up to down as the CURVE moves left to right or vice versa. 
In fact we will be using this OUTLINE MODE technique in the later part of 
this chapter when we edited CURVED OBJECTS with the PEN TOOL.
To TOGGLE from PREVIEW to OUTLINE, Go: View > Outline, or TYPE: COMMAND 
(Mac) or CONTROL (PC) and the letter ”y”. When the VIEW MODE is PREVIEW, 
only the OUTLINE option is available [Figure 4-a: 11]. To TOGGLE back to 
PREVIEW from OUTLINE, Go: View > Preview [Figure 4-a: 12]. In OUTLINE, 
only PREVIEW is available, but the Keyboard Shortcut remains the same.
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Second digression about using the View Menu:  
Sizing the Art Work Window
In the first chapter, we discussed the ZOOM TOOL; how to access it 
from the keyboard and how to use it to navigate in and out of your 
art work. The VIEW MENU gives us four specific options for sizing the 
ART WORK WINDOW: ZOOM IN, ZOOM OUT, FIT IN WINDOW, ACTUAL SIZE 
[Figure 4-a: 13a, b, c, & d].
All four of these VIEW options have Keyboard Shortcuts which you 
should learn and use. Mousing up to the menu bar and then mousing 
down to frequently used sub-menus is inefficient, time consuming, and 
leaves you prey to carpal tunnel syndrome.
ZOOMING IN and ZOOMING OUT gives you menu commands and 
KEYBOARD SHORTCUTS that you can use in place of the MAGNIFYING 
GLASS TOOL. Each time you access the ZOOM IN or ZOOM OUT command 
is like CLICKING the MAGNIFYING GLASS TOOL once. Note that there 
are symbols and letters on the right edge of the expanded menu. These 
show the KEYBOARD SHORTCUTS for each of the menu commands. To 
ZOOM IN, TYPE: COMMAND (Mac) or CONTROL (PC) and the mathematical 
symbol ”-” (minus). To ZOOM OUT, TYPE: COMMAND (Mac) or CONTROL 
(PC) and the mathematical symbol ”+” (plus). Note that the MENU lists 
the plus, an upper case symbol for ZOOM IN and the minus or dash, a 
lower case symbol, for ZOOM OUT. It does not matter whether or not you 
use the SHIFT KEY to ZOOM IN. Each tap of the “equals/plus” key, with 
or without the SHIFT KEY, will ZOOM you IN. When you are ZOOMING OUT 
it does matter. To ZOOM OUT, do not use the SHIFT KEY, or nothing will 
happen. Yes, this is inconsistent, but remember that Oscar Wilde said, 

“Consistency is the hobgoblin of small minds.” It actually makes these two 
KEYBOARD SHORTCUTS a little easier to remember.

The FIT IN WINDOW [Figure 4-a: 13c] command and its KEYBOARD 
SHORTCUT,  COMMAND (Mac) or CONTROL (PC) and the number ”0” 
(zero), does exactly that, fits the ART BOARD, and only the ART 
BOARD, proportionally into the currently open Illustrator WINDOW 
[Figure  4-a:  14-the arrows 
point at the corners of a 3.5” 
X 3.5” ART BOARD]. 
When you SELECT the FIT IN 
WINDOW [Figure  4-a:  13d] 
command and its KEYBOARD 
SHORTCUT,  COMMAND (Mac) 
or CONTROL (PC) and the 
number ”1”, Illustrator sizes 
your ART BOARD as close 
to the ACTUAL SIZE in the 
UNITS selected as possible 
[Figure  4-a:  15]. While this 

 Sec4:5

figure 4-a: 13a

figure 4-a: 13b

figure 4-a: 14

figure 4-a: 15

Shift

Control 

Command
OR + +

Control 

Command
OR + –

figure 4-a: 13c figure 4-a: 13d

Control 

Command
OR + 0

Control 

Command
OR + 1



making Illustrator work so you can work in Illustrator

 Introducing the PEN TOOL

will give you a general idea of the size of the art work, it is not always 
accurate. The resolution and pixel density of the screen can make ACTUAL 
SIZE show from 33% smaller to 15% larger.

Third digression about using the View Menu:  
Rulers and Guides
Rulers and Guides are inseparable. You cannot create a GUIDE unless the 
RULERS are visible on the TOP and LEFT EDGES on the Illustrator WINDOW. 
So, what are they?
An Illustrator RULER is very similar, but much more flexible in its way, 
than its counterparts in the real world. Not only can you set Illustrator’s 
RULERS to show units in Points, Picas, Inches, Millimeters, Centimeters, 
and Pixels when you CREATE A NEW DOCUMENT [Figure 4-a: 16], you can 
access and RESET the units ON-THE-FLY just by RIGHT CLICKING on either 
of the on-screen RULERS with a TWO BUTTON MOUSE, or CONTROL (Mac 
only) CLICKING on a ONE BUTTON MOUSE [Figure  4-a:  17]. Just move 
your MOUSE to the type of UNIT you prefer, release it, and the RULER will 
RESET. Naturally, as you ZOOM IN and ZOOM OUT, the RULER will ZOOM 
along with you.
To use RULERS on screen, Go: VIEW > SHOW RULERS or TYPE: COMMAND 

(Mac) or CONTROL (PC) and the letter ”r” [Figure 4-a: 18]. SHOW RULERS 
is also a TOGGLE. Once RULERS are showing, the same command and 
KEYBOARD SHORTCUT becomes HIDE RULERS. 
What is a GUIDE? It is a “non-printing” line or shape that helps you 
organize you ART WORK. In Illustrator you can use the PREFERENCES: 
GUIDES settings to make your GUIDES appear either as LINES or DOTS 
(more on this later in the course). 
Once you have the RULERS visible, you need to choose the SHOW 
GUIDES command or TYPE: COMMAND (Mac) or CONTROL (PC) and the 
punctuation mark ”;” (semi-colon) [Figure 4-a: 19]. Now, you can CREATE 
GUIDES. Like SHOW RULERS, SHOW GUIDES is a TOGGLE. Once you have 
selected SHOW GUIDES, the Menu command changes to HIDE GUIDES, 
but the KEYBOARD SHORTCUT remains the same [Figure 4-a: 20]. 
GUIDES can also be LOCKED or UNLOCKED, using the second command 
TOGGLE on the GUIDES FLY-OUT SUB-MENU or the SHORTCUT:  
COMMAND/OPTION (Mac) or CONTROL/ALT (PC) and the punctuation mark 
”;” (semi-colon) [Figure 4-a: 21]. Unlike the SHOW/HIDE GUIDES TOGGLE, 
the LOCK GUIDES TOGGLE is plain when the GUIDES are UNLOCKED and 
shows a CHECK MARK when they are LOCKED [Figure 4-a: 22]. 
With SHOW GUIDES chosen, move you CURSOR onto either the 

HORIZONTAL RULER at the top of 
your screen or the VERTICAL RULER 
at the left side of your screen. No 
matter what TOOL you are using, 
the CURSOR will change to the 
black SELECTION ARROW as soon as 
it is over the RULER. As you CLICK 
and DRAG Down from the top RULER, 
you will create a HORIZONTAL GUIDE 
[Figure 4-a: 23-next page]. Likewise, 
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CLICKING and DRAGGING to the right from the VERTICAL RULER will 
create a VERTICAL GUIDE [Figure 4-a: 24]. In both the examples above, 
the GUIDES PREFERENCES are set to “dots.” 
Now that we have looked at creating guides, let’s get back to the PEN TOOL.

Using the PEN TOOL with Constraints and Guides
When we left the PEN TOOL, we were talking about using the SHIFT KEY 
to CONSTRAIN the PATH created between our CLICKS to the HORIZONTAL, 
VERTICAL, or a 45° DIAGONAL. Now, let’s 
create a CLOSED RECTANGULAR PATH 
with only HORIZONTAL and VERTICAL 
PATHS. And, we will create a GUIDE so 
that our last PATH connects absolutely, 
and as a VERTICAL to our first PATH. 
Here’s how:
Working Exercise: Constrained Paths using 
Guides
 1. Create a NEW DOCUMENT that is 

6” X 6” and name it “pentool-
exercise1”.

 2. Use one of the techniques 
above to “SHOW RULERS.”

 3. Use one of the techniques 

above to “SHOW GUIDES.”
 4. Pull a VERTICAL GUIDE into the ART BOARD, leaving it close to 

the left edge of the document [Figure 4-a: 25].
 5. Select the PEN TOOL. 
 6. Near the TOP of the document (in other words, inside the ART 

BOARD) and absolutely in line with the GUIDE, CLICK with the 
PEN TOOL to begin a PATH. Hold down the SHIFT KEY, move the 
CURSOR near the right edge of the ART BOARD, and CLICK again 
[Figure 4-a: 26a].

 
7. 

 Sec4:7

figure 4-a: 23 figure 4-a: 24

 figure 4-a: 25

figure 4-a: 26a figure 4-a: 26b    

ShiftShift



making Illustrator work so you can work in Illustrator

 Introducing the PEN TOOL

Without releasing the SHIFT KEY, move the CURSOR down on the 
ART BOARD and CLICK again [Figure 4-a: 26b - previous page].

 8. Again, without releasing the SHIFT KEY, move the CURSOR until it 
is below the first point you CLICKED and absolutely on top of the 
GUIDE you pulled out. CLICK again [Figure 4-a: 26c]. 

 9. Finally, and again, without releasing the SHIFT KEY, move the CURSOR 
until it is on top of the first point you CLICKED and absolutely on 
top of the GUIDE you pulled out. A small “rounded” square will 
appear at the lower right side of the PEN CURSOR, signifying that 
you are ready to “CLOSE” the PATH. CLICK to create the CLOSED 
PATH [Figure 4-a: 26d]. 

The RECTANGLE you have just created is identical to a RECTANGLE of the same 
dimensions create with the RECTANGLE TOOL. If you knew the dimensions you 
needed before you started, you could have pulled GUIDES out to each of those 
positions, then simply CLICKED with the PEN TOOL to create the RECTANGLE. 
Of course, you could have used the RECTANGLE TOOL as well.
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HSB Color
In Chapter 2, we covered the basics of 
creating and saving colors in Illustrator: 
the FILL and STROKE ICONS, the COLOR 
PANEL, the SWATCHES PANEL, naming 
colors, etc. We also touched on  the uses 
of and the differences between CMYK and 
RGB. In this Chapter, we introduce a new 
COLOR SYSTEM: HSB. HSB stands for HUE, 

SATURATION, and BRIGHTNESS or, 
in more common language, the 

”base” color, the intensity 
of that color from pure 
color to colorless, pure 
gray, and the lightness 
or darkness of the color 
from black to white. 
HSB is another way of 

analyzing RGB color. 
Using the HSB system in 

Illustrator’s COLOR PANEL 

provides a very simple 
way to create a 
spectrum of pure color 
[Figure  5-a:  1]. You 
need only to move “H” 
SLIDER TRIANGLE in 
60° increments across 
the HUE SPECTRUM 
[Figure 4-a: 2a through 

2g], to make the full circle around the HSB color wheel, returning the 
to HSB red at the start [Figure 5-a: 3].
You can see that the HSB color wheel is an RGB color wheel because it 
is an ADDITIVE COLOR color wheel. The three dominant colors are the 
ADDITIVE PRIMARIES; RED, GREEN, and BLUE. The colors between them 
are lighter since they combine “two colors of light.”
 
Using HSB Color to create a HYBRID COLOR WHEEL
When creating all six of these colors (number 7 is identical to number 1), 
we did not touch the “S” or “B” sliders. If we wanted to use HSB color 
to create an RGB version of the more typical color wheel based on 
the  “reflected” color primaries RED, YELLOW, and BLUE, we need to 

make some adjustments to our color’s 
position on the “H” slider, as well 
as some changes to the “B” slider. 

We should try to keep the “S” slider at 
full strength so that this “hybrid” color 
wheel remains as brilliant as possible.
Just a reminder about COLOR MODES; to 
work in HSB (or RGB), make sure you 
set the Color Mode to RGB when you 
create a new document [Figure 5-a: 4] 
or Go: Object > Document Color Mode > 
RGB [Figure  5-a:  5] to reset the Color 
Mode if you are in CMYK. HSB and ERGB 

colors lose all their brilliance 
in CMYK Mode.

 Advanced BLENDS and the Color Wheel Project
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To create our Six Color “HYBRID” 
SPECTRUM, DRAG the COLOR PANEL and 
the SWATCHES PANEL out of the ICON 
DOCK and onto your ART BOARD. Go to 
the COLOR PANEL “FLY-OUT” MENU and 
SELECT HSB [Figure 5-a: 6].
Now, SELECT all the swatches in the 
SWATCHES PANEL, except the NONE (red 
slash) and REGISTRATION (cross-hairs in 
a circle) SWATCHES, and DELETE them 
[Figure 5-a: 7]. 

Go to the COLOR PANEL a make sure that the “H” slider is and the “S” 
slider are both set to zero. Drag the “B” slider to 100. This makes HSB 
WHITE. CLICK and DRAG the WHITE FILL ICON from the COLOR PANEL to 
the SWATCH PANEL [Figure 5-a: 8a]. Move the “B” slider to zero to make 
HSB BLACK. CLICK and DRAG the BLACK FILL ICON from the COLOR PANEL 

to the SWATCH PANEL [Figure 5-a: 8b].
Finally, set the “H” slider at zero, the “S” 
slider at 100 and the “B: slider at 100. This 
makes pure HSB RED. CLICK and DRAG the 
BLACK FILL ICON from the COLOR PANEL 
to the SWATCH PANEL [Figure 5-a: 9a].
Repeat this process to make the other 
five colors using these values: Orange 
— H=36, S=100, B=100; Yellow — H=60, 
S=100, B=100; Green — H=128, S=100, 

B=83; Blue — H=240, S=100, B=100; 
H=36, S=100, B=100; Violet — H=292, 
S=100, B=80 [Figure 5-a: 9b, c, d, e, f]. 
As you make each color, CLICK and DRAG 
its FILL ICON from the COLOR PANEL 
to the SWATCH PANEL. You now have 
a SWATCH LIBRARY of “Reflective 
Primaries” created in HSB Mode as 
well as a “pure” HSB White and Black. 
Together, they constitute the “HYBRID” 
Color Wheel shown in Figure 5-a: 10.             

Save your SWATCHES as a 
SWATCH LIBRARY
In the previous section of the 
book, you learned how to SAVE 
a set of SYMBOLS as a SYMBOL 
LIBRARY. You can SAVE a set of SWATCHES as a 
LIBRARY as well. CLICK on either the SWATCHES 
ICON at the lower left of the SWATCHES PANEL 
or the “FLY-OUT” at the upper right. SELECT 
the “Save Swatch Library as AI…” at the top 
of the ICON POP-DOWN or at the bottom of the 
“FLY-OUT” POP-DOWN [Figure 5-a:  11]. This will 
open the “Save Swatches as Library” DIALOG BOX 
[Figure  5-a:  12- next page]. Name the LIBRARY 
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and SAVE it to the “default” 
SWATCHES Folder in the Adobe 
Illustrator  Program Folder, or 
use the Dialog Box navigation 
to find another folder to keep 
it in. Now, we’ve finished 
the preliminaries. Let’s start 
on the the SPECTRUM COLOR 
WHEEL.

The COLOR WHEEL PROJECT: Creating a SPECTRUM COLOR WHEEL
In this project, you will use some ADVANCED BLENDING SKILLS to create 
one or more of a number of COLOR WHEELS [Figure 5-a: 12]. In the 
examples, the two upper wheels are easily created with the POLAR GRID 
TOOL and the LIVE PAINT BUCKET, once you have created the HSB colors. 

The two lower examples 
require a bit more — alright, 
a lot more preparation 
and work. Let’s take the 
example at the lower right 
first. To create this kind of 
circular spectrum requires 
some fancy blend work. We 
already have the six HSB 
spectrum colors. Now let’s 
figure out how to get them 
to wrap around a circle. 
Step 1:
First, let us consider what 
we have learned about 
BLENDS. We can BLEND 
between two or more 
things, but the SPINE 
created by the BLEND 
COMMAND is always a 
straight line between any 

two BLEND elements. We have used the PEN TOOL on the SPINE to 
bend it and curve it. But we still have a BLEND that goes from the 
first element to the last element. No matter whether it is curved or 
straight, simple or complex, the SPINE has a beginning and an end; it 
is LINEAR. 
So how do we convert a LINEAR object into a CIRCULAR (no beginning 
or end) OBJECT? We cannot actually do it. So, we must fake it. How?
Remember that we are always working on LAYERS or SUB LAYERS. In 
any group of OBJECTS, some are above others. What if we take a line 
and bend it into a circle, so that its end point sits directly on top of its 
starting point. It isn’t a circle, but it looks exactly like one. 
If we have our BLEND follow this “circular” path and end at the same 
point we start from, ending with the same color we start with, we 
should end up with a “circular” BLEND. That is how we will proceed.

Creating the SEVEN BLEND COMPONENTS
Seven? Isn’t it a six color wheel? Yes, but remember, we start and end 
with the same color, but on a new element, so we need seven component 
shapes. If we work with tall, skinny rectangles, we will end up with 
a pretty good, smoothly 
blended spectrum [Figure 
5-a: 13]. But if you look 
in the center, you can see 
how the top RED rectangle 
shows. We can do better. 
If we use a tall, skinny 
TRIANGLE, the center 
should be just as smooth 
as the outside. That is how 
we will proceed. 
First, create a tall skinny 
rectangle [Figure 5-a:  14 
-next page] about as tall 
as you wish the radius 
of the color wheel to 
be. Using the DIRECT 
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SELECTION TOOL, carefully SELECT only the PATH between the top two 
ANCHOR POINTS [Figure 5-a: 15] then press the DELETE KEY. Again using 
the DIRECT SELECTION TOOL, CLICK and DRAG a MARQUEE around only the 
top two ANCHOR POINTS [Figure 5-a: 16]. Now, GO: Object > Path > Average 
[Figure 5-a: 17] and open the AVERAGE DIALOG BOX [Figure 5-a: 18]. 
Make sure “BOTH” is selected then CLICK “OK.” The TWO ANCHOR POINTS 
are now exactly on top of one another.
Next, GO: Object > Path > Join [Figure 5-a: 19] and open the AVERAGE 
DIALOG BOX [Figure 5-a: 20]. Make sure “CORNER” is selected then CLICK 
“OK.” The TWO ANCHOR POINTS are now mad into ONE and the SHAPE is 
CLOSED. 
We will use the BLEND COMMAND to create our SEVEN TRIANGLES. Make a 
DRAG COPY (using the Option or Alt Key as you CLICK and DRAG) of the 
first TRIANGLE as in Figure 5-a: 21. SELECT both tall, skinny TRIANGLES  
[Figure 5-a: 22] then GO: Object > Blend > Blend Options [Figure 5-a: 23] 
to open the BLEND OPTIONS DIALOG BOX [Figure 5-a: 24]. Select SPECIFIED 
STEPS from the SPACING POP-DOWN. Enter “5” in the text field. In a 
STEPPED BLEND, you enter the intermediate steps only, the components 

you are blending are not included. So, five steps plus the beginning 
and end will give us seven steps. Select the “Align to Path” ICON, the 
Orientation CON on the right, then CLICK “OK.” Finally, GO: Object 
> Blend > Make [Figure  5-a:  25], to create the SEVEN STEP BLEND 
[Figure 5-a: 26- next page]. 
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GO: Object > Blend > Expand 
[Figure 5-a: 27], to convert the LIVE BLEND into seven, separate 
but GROUPED Illustrator OBJECTS [Figure 5-a: 28].  
GO: Object > Ungroup  [Figure 5-a: 29], so you can SELECT each 
TRIANGLE separately.
DESELECT all the TRIANGLES, then SELECT the second TRIANGLE from 
the LEFT. CLICK on the HSB “ORANGE” SWATCH on the SWATCHES 
PANEL [Figure 5-a: 30].
Repeat this process, SELECTING the next TRIANGLE in the sequence 

and FILLING it with the next color in the sequence in the SWATCHES 
PANEL until you have the seven color, spectrum sequence from RED to RED 
[Figure 5-a: 31].

DESELECT all seven TRIANGLES and GO: Object > Blend > Blend Options. 
Set the POP-DOWN to SMOOTH 
COLOR. Make sure the Align to 
Path Orientation ICON is SELECTED, 
then CLICK “OK” [Figure 5-a: 32].
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Finally, GO: Object > Blend > Make [Figure 5-a: 33]. You will create a 
linear, SPECTRUM BLEND from Red to Red [Figure 5-a: 34].
If your BLEND looks like Figure 35, or in some other way does not create a 
smooth Blend, go back two steps. Make sure that NONE of the TRIANGLES 
are SELECTED before you GO: Object > Blend > Blend Options and set the 
Spacing POP-DOWN to “Smooth.” Now create the BLEND and it will work.

Creating the Circular SPINE
At the beginning of the Chapter when we discussed making a CIRCULAR 

PATH, we talked about “bending” a LINEAR PATH. But that is 
not what we will do here. Instead, we will “CUT” a CIRCLULAR 
CLOSED PATH created with the ELLIPSE TOOL and the SHIFT KEY 
to make a CIRCULAR, LINEAR PATH. Here’s how:
First, let’s introduce a new TOOL. In the last ICON GROUP on the 

TOOL BAR, just above 
the FILL and STROKE 
ICONS, you will fine 
the SCISSORS TOOL. Its 
KEYBOARD SHORT-CUT, 
Command (Mac) or 
Control (PC) plus “c” 
(for CUT), gives it away  
[Figure  5-a:  36]. 
Its CURSOR is the 
CROSS-HAIRS that 
many other tools 
use. When you place 
the SCISSORS TOOL 
CROSS-HAIRS on a 
PATH and CLICK, you 
“CUT” that PATH or 

in two. If you 
carefully place 
the SCISSORS 
TOOL on an 
ANCHOR POINT 

and CLICK, you will “CUT” the PATH at the ANCHOR POINT, creating a PATH 
that begins and ends at the same place, but is not a CLOSED PATH.
SELECT the ELLIPSE TOOL and, HOLDING DOWN the SHIFT KEY, create a 
CIRCLE just a tiny bit taller than the SPECTRUM BLEND [Figure 5-a: 37].
SELECT the SCISSORS TOOL
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SELECT both the BLEND 
and the “CUT” CIRCLE. 
If you use the DIRECT 
SELECTION TOOL make 
sure that you DRAG a 
MARQUEE completely 
around both items. 
Then, GO: Object > Blend 
> Blend Options to make 
sure that the “Align to 
Path” ICON (the one on 
the right) is SELECTED. 
CLICK “OK” and GO: 
Object > Blend > Replace 

Spine [Figure 5-a: 40]. When you CLICK “OK,” the seven RIANGLES in the 
BLEND will wrap around the open circle [Figure 5-a: 41].
If you get Figure 42 instead, undo your steps until you are back to the 
BLEND and the “CUT” CIRCLE. GO: Object > Blend > Blend Options to 
make sure again that the “Align to Path” ICON is SELECTED.  Repeat 
the steps foir Figure 45 and 41.
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